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ABSCHNITT 1 Übersicht
Der DFR22 Audioprozessor mit Rückkopplungsreduzier-Stufe ist ein digitaler Audioprozessor mit 2 Eingängen und 2
Ausgängen. Er ist ideal für Anwendungen in installierten Beschallungsanlagen, wie z. B. in Kirchen, Theatern und Kon-
ferenzräumen, geeignet. Der DFR22 ist auch ein leistungsfähiges Hilfsmittel für Anwendungen mit Live-Musik. Mit Hilfe
der grafischen Drag&Drop-Benutzeroberfläche des DFR22 können Prozessoren an beliebiger Stelle im Signalweg
platziert werden. Der 2x2-Matrixmischer ermöglicht es, einen oder beide Eingänge auf einen oder beide Ausgänge zu
legen, wobei zusätzliche Regler für Pegel und Polarität zur Verfügung stehen.

Hinweise zu dieser Anleitung

Die Software-Oberfläche des DFR22 ist so intuitiv und benutzerfreundlich, dass Sie dieses Dokument u. U. gar nicht 
mehr lesen wollen, sondern gleich mit der Programmierung des Geräts beginnen möchten. Vorher sollten Sie aber 
unbedingt diese Übersicht betrachten und dann den Abschnitt Einrichtung auf Seite 12 aufmerksam lesen. Antworten 
auf Fragen zur Software finden Sie in den folgenden Abschnitten dieser Anleitung.

Aufbau dieser Anleitung

• Übersicht ...............................................Stellt die wesentlichen Merkmale des Audioprozessors vor und 
erläutert die Betriebsmodi der Oberfläche und des Hauptfensters.

• Einrichtung  . . . . . . . . . . . . . . . . . . . . . .Beschreibt die grundlegenden Schritte in der Software, um den 
Audioprozessor für eine Installation einzurichten.

• Erstellen einer Voreinstellung . . . . . . .Behandelt die Elemente einer Signalflusskonfiguration des 
DFR22 wie die Verstärkungsstruktur des Geräts, die Signalführung von Eingängen zu Ausgängen, Hin-
zufügen von Prozessoren in den Signalweg und das Arbeiten damit im Hauptfenster.

• Voreinstellung- und GeräteverwaltungErläutert die Speicherung einer Voreinstellung im Computer, die 
Speicherung im DRF22 und die Datensicherung vom Gerät zum Computer. Es beschreibt außerdem die 
Funktionen des Menüs [Device] (Gerät).

• Prozessorfunktionen  . . . . . . . . . . . . . .Beschreibt die Funktionen, die in vielen Signalprozessor-Mod-
ulen vorkommen, wie Fader, Momentaufnahmen von Parameter-Einstellungen sowie Speichern und 
Abrufen von Einstellungen in den bzw. aus dem Computer.

• Feste Prozessoren  . . . . . . . . . . . . . . . Erläutert die Funktionen der Ein- und Ausgangsverstärkungs-
blöcke und des Matrixmischers.

• Modulare Prozessoren . . . . . . . . . . . . .Erklärt die jeweiligen Funktionen der einzelnen Drag&Drop-Proz-
essoren.

• Steuerpins . . . . . . . . . . . . . . . . . . . . . . .Beschreibt die interne Architektur der externen Gerätesteuerfunk-
tion des Audioprozessors und erläutert die Konfiguration der Steuerpins des DFR22 mit der Software, 
nachdem die externe Hardware angeschlossen wurde.

• Sicherheit ..............................................Behandelt die Sicherheitsfunktionen des Audioprozessors, die 
den Benutzerzugang zu den Geräteeinstellungen und zu den Bedienelementen auf der Frontplatte ein-
schränken.

Hinweise zum Schriftsatz
• Text in [eckigen Klammern] . . . . . . . . .  kennzeichnet wörtlichen Text aus der Software-Oberfläche wie 

z. B. Bezeichnungen von Steuerelementen, Schaltflächen oder Menübefehle.

• Tastaturtasten . . . . . . . . . . . . . . . . . . . .wie Umschalttaste, Strg und Esc sind fett dargestellt. Wenn 
Tastenkombinationen oder Tastenkombinationen in Verbindung mit der Maustaste betätigt werden müs-
sen, wird das Pluszeichen folgendermaßen verwendet: Strg + Klicken.
© 2003 Shure Incorporated DFR22-Software-Bedienungsanleitung 5



Funktionen des Audioprozessors
Funktionen des Audioprozessors

Der DFR22 ist ein digitaler Audioprozessor mit 2 Eingängen und 2 Ausgängen sowie einer Software-Oberfläche und 
einfachen Bedienelementen an der Gerätevorderseite. Er gestattet die Speicherung von 16 Voreinstellungen. Er bietet 
24-Bit-Umwandlung, Sampling mit 48 kHz und einen minimalen Dynamikbereich von 100 dB.

Software-Oberfläche mit Drag & Drop
Die Computerschnittstelle zum Audioprozessor ahmt die funktionalen Blockdiagramme nach, die im Soundsys-
tem-Design verwendet werden. Dadurch lässt sich die Software sehr leicht erlernen, weil die Benutzerober-
fläche für Tontechniker sofort vertraut erscheint. Voreinstellungen können ausschließlich durch Klicken, Ziehen
und Ablegen mit der Maus erstellt und bearbeitet werden. Der Signalweg kann durch beliebige Kombinationen
von Drag&Drop-Signalprozessoren konfiguriert werden.

Modulare Signalprozessoren
Jedes Signalprozessormodul ist in einem Grafikblock eingeschlossen, der mit der Maus bearbeitet werden
kann. Nach der Platzierung im Signalflussdiagramm kann auf die Prozessoreinstellungen zugegriffen werden,
indem auf den betreffenden Block doppelgeklickt wird, um das Parameterfenster einzublenden. Einstellungen
können im Computer gespeichert und von dort abgerufen sowie zwischen ähnlichen Modulen kopiert werden.
Prozessor-Einstellungen lassen sich außerdem über die Verknüpfungsfunktion miteinander synchronisieren.
Der DFR22 Audioprozessor enthält folgende Signalprozessormodule:

Externe Gerätesteuerung
Nach der Installation und Programmierung über die Software-Oberfläche lässt sich der DFR22 per Computer
oder über Steuergeräte von Crestron und AMX steuern. Außerdem können die Steuerpins an der Geräterück-
seite mit externer Hardware verbunden werden, sodass der DFR22 auf das Schließen von Kontakten sowie
auf Potentiometer und Schalter reagiert.

Sicherheit
Die Sicherheitsfunktion verhindert, dass andere Personen nach der Installation am Gerät “spielen” und dabei
Einstellungen verändern. Der Benutzerzugriff lässt sich vollständig beschränken, sodass der Benutzer keine
Einstellungen verändern und keine Bedienelemente der Frontplatte benutzen kann. Dann ist es nur möglich,
die Einstellungen der jeweiligen Voreinstellung auf der Software-Oberfläche zu sehen. Außerdem kann die
Endbenutzer-Kontrolle konfiguriert werden, sodass Zugang zu bestimmten Einstellungen möglich ist, zu
anderen aber nicht.

Mindesterfordernisse für die Software des DFR22 

Für einen einwandfreien Betrieb erfordert die Software Version 3 des DFR22 einen PC mit der folgenden Ausstattung:

• 20 MB verfügbarer Festplatten-Speicherplatz
• CD-ROM-Laufwerk
• VGA-Monitor mit 640 x 480/256 Farben oder höherer Auflösung
• Maus oder anderes Zeigegerät

• Leistungsstarke digitale Rückkopplung-
sreduzierer von Shure, in Mono- und Stereo-
Prozessoren

• Automatische Verstärkungsregelung
• Kombinierende und nichtkombinierende 

grafische Equalizer mit 10 und 30 Bändern
• Parametrische Equalizer mit 3 bis 10 Bändern 

und Filter mit steilflankiger und Kuhschwanz-
Charakteristik

• 2-Wege-Frequenzweichen und -Verteiler
• Subwoofer
• Gate/Abwärts-Expander
• Mono- und Stereo-Kompressoren/Limiter mit 

Soft-Knee-Option
• Ducker
• Peak-Stop-Limiter
© 2003 Shure Incorporated DFR22-Software-Bedienungsanleitung 6



Betriebsmodi der Benutzerschnittstelle
Die CPU-Taktrate und der erforderliche Speicher sind abhängig von der Windows-Version und der Anzahl der im 
Hintergrund ausgeführten Anwendungen. Der gleichzeitige Betrieb der DFR22 Software mit anderen Programmen wie 
SIA-Smaart® oder Gold Line TEF™ erfordert einen schnelleren Prozessor und mehr RAM-Speicher. Die nachstehende 
Tabelle enthält die Mindestanforderungen zur Ausführung der DFR22 Software, wenn keine anderen Anwendungen 
einschließlich Virenschutz-, Firewall-, Instant-Messaging- und E-Mail-Anwendungen ausgeführt werden.

Betriebsmodi der Benutzerschnittstelle

Die Benutzerschnittstelle verfügt über zwei hauptsächliche Betriebsmodi: Design-Modus und Live-Modus. Dadurch 
besteht die Möglichkeit, unabhängig davon, ob das Gerät am Computer angeschlossen ist, Konfigurationen für den 
DFR22 zu erstellen. Bestimmte Funktionen sind nur in einem Modus verfügbar und werden an entsprechender Stelle in 
der Anleitung erläutert.

Design-Modus
Beim Starten wird die Anwendung immer im Design-Modus geöffnet. In diesem Modus werden die Voreinstel-
lungen erstellt, die später im DFR22 gespeichert werden. In diesem Modus ist es nicht erforderlich, dass der
Computer am Gerät angeschlossen ist. Die erstellten Voreinstellungen können im Computer gespeichert wer-
den und lassen sich später wieder öffnen und über die RS-232-Verbindung zum Gerät übertragen. Dadurch
können Voreinstellungen an anderen Orten als unmittelbar an der Anlage erstellt werden.

Live-Modus
In diesem Modus können Echtzeit-Einstellungen an den Hardware-Voreinstellungen vorgenommen werden,
während der Computer am DFR22 angeschlossen ist. Auf diese Weise können die Änderungen der Signalver-
arbeitung beim Ändern von Einstellungen sofort gehört werden, um die Voreinstellungen vor Ort “maß-
zuschneidern”. Alle Bedienvorgänge im Live-Modus werden direkt in die jeweils geöffnete Voreinstellung
geschrieben.

Vorschau-Modus
Beim Arbeiten im Live-Modus mit einem Gerät, das mehrere Voreinstellungen enthält, können diese einzeln
zur Veränderung in Echtzeit abgerufen werden. Wenn eine Voreinstellung gewählt wird, die in das Signalfluss-
diagramm geladen werden soll, schaltet das Fenster in den Vorschau-Modus, damit die Wahl bestätigt werden
kann, bevor die Voreinstellung als nächste Live-Voreinstellung zugewiesen wird. Die Schnittstelle kehrt zum
Live-Modus zurück, wenn die Voreinstellung geladen oder der Vorgang abgebrochen wird.

Windows-Version CPU-Taktrate RAM
98, Zweite Ausgabe Pentium 166 MHz 48 MB
NT Pentium 233 MHz 64 MB
ME Pentium 300 MHz 64 MB
2000 Professional Pentium 300 MHz 96 MB
XP Professional, Home Pentium 300 MHz 128 MB
© 2003 Shure Incorporated DFR22-Software-Bedienungsanleitung 7



Übersicht
Hauptfenster

Dieses Fenster (vgl. Abbildung 1-1 unten) ist der hauptsächliche Arbeitsplatz in der Software-Oberfläche. Das Fenster 
kann proportional vergrößert oder maximiert werden, sodass es den gesamten Bildschirm ausfüllt. Durch Schließen 
dieses Fensters wird die Anwendung beendet.

1. Titelleiste: Im Live-Modus werden gerätespezifische 
Informationen angezeigt. Detaillierte Beschreibung siehe 
Abschnitt unten.

2. Hauptmenü: Gestattet den Zugriff auf Menübefehle, die 
für das betreffende Gerät und Signalflussdiagramm spezi-
fisch sind.

3. Steuerleiste: Zeigt Steuerelemente an, die für das betref-
fende Gerät und Signalflussdiagramm spezifisch sind. 

Weitere Informationen siehe Abschnitt auf der folgenden 
Seite.

4. Signalflussdiagramm: Bereich zum Erstellen von Vore-
instellungen. Weitere Informationen siehe Abschnitt auf der 
folgenden Seite.

5. Statusleiste: Zeigt Steuerelemente und Anzeigen für das 
Signalflussdiagramm an. Weitere Informationen siehe 
Abschnitt Seite 11.

Titelleiste
Die Informationen in der Titelleiste dieses Fensters ändern sich entsprechend des Betriebsmodus. Im Design-
Modus enthält die Titelleiste “DFR22: Offline” und zeigt die Standard-Sicherheitsstufe an. Im Live-Modus wer-
den Informationen über das angeschlossene Gerät angezeigt (siehe Abbildung 1-2 unten).

1. Geräte-Kennnummer: Die Geräte-Kennnummer wird 
mit den DIP-Schaltern an der Geräterückseite eingestellt. 
Anweisungen hierzu siehe Installation Guide (Installation-
sanleitung).

2. Gerätename: Zum Benennen des Geräts im Live-Modus 
aus dem Hauptmenü [Devices>Name Device] 

(Geräte>Gerät benennen) wählen. Weitere Informationen 
siehe Einrichtung, Schritt 5, auf Seite 13.

3. Sicherheitsstufe: Zeigt im Live-Modus die derzeitige 
Sicherheitsstufe für das Gerät an. Weitere Informationen 
siehe Abschnitt Sicherheit auf Seite 99.

ABBILDUNG 1-1: Hauptfenster

1

2

3

4

5

ABBILDUNG 1-2: Titelleiste

1 2 3
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Hauptfenster
Steuerleiste
Die Darstellung und Funktion dieses Fensterabschnitts ändert sich je nach ausgewähltem Betriebsmodus
(siehe Abbildung unten).

1. Schaltfläche [Live Mode] (Live-Modus): Durch 
Klicken auf diese Schaltfläche wird in den Live-Modus 
geschaltet, in dem jede im Gerät gespeicherte Voreinstel-
lung als Vorschau angezeigt und bearbeitet werden kann. 
Um in diesen Modus schalten zu können, muss der Com-
puter am DFR22 angeschlossen sein.

2. Schaltfläche [Design Mode] (Design-Modus): 
Durch Klicken auf diese Schaltfläche wird in den Design-
Modus geschaltet. Die Voreinstellung, mit der im Live-
Modus gearbeitet wurde, bleibt im Signalflussdiagramm 
geladen.

3. Informationsfeld: Hier werden Informationen über die 
Voreinstellung angezeigt, die gegenwärtig auf dem Bild-
schirm geladen ist, wie Name, Datum der letzten Spe-
icherung und Beschreibung. 

4. Schaltfläche [Store Preset] (Voreinstellung spe-
ichern): Durch Klicken wird die aktuelle Voreinstellung im 
DFR22 gespeichert.

5. Schaltfläche [Recall Preset] (Voreinstellung 
abrufen): Durch Klicken wird eine Voreinstellung aus dem 

DFR22 in das Signalflussdiagramm zur Bearbeitung im 
Design-Modus geladen.

6. Schaltfläche [Save As] (Speichern unter): Durch 
Klicken wird die aktuelle Voreinstellung im Computer 
gespeichert.

7. Schaltfläche [Open] (Öffnen): Durch Klicken wird eine 
Voreinstellung-Datei aus dem Computer in das Signalfluss-
diagramm geladen.

8. Voreinstellung-Auswahl: Durch Klicken auf dieses 
Dropdown-Menü wird aus der Liste der Voreinstellungen, 
die im Gerät gespeichert sind, eine Auswahl getroffen.

9. LED-Pegelanzeigen: Diese LED-Pegelanzeigen zeigen 
die Audiopegel im Gerät an. Sie lassen sich ein- und auss-
chalten, indem darauf geklickt oder indem [View>Enable I/
O Meters] (Ansicht>E/A-Pegelanzeigen aktivieren) im 
Hauptmenü gewählt wird.

10. Schaltfläche [Load] (Laden): Durch Klicken wird die in 
der Vorschau angezeigte Voreinstellung in das Signalfluss-
diagramm geladen.

11. Schaltfläche [Cancel] (Abbrechen): Durch Klicken 
wird zur vorigen Voreinstellung gewechselt.

Signalflussdiagramm
Mit dem Signalflussdiagramm wird grafisch dargestellt, wie Audiosignale durch die Verstärkungsstruktur des
Audioprozessors und durch die auf den Eingangs- und Ausgangskanalstreifen platzierten Prozessorblöcke
geführt werden. In jeder im Signalflussdiagramm erstellten Voreinstellung werden die erstellte Konfiguration
der Prozessorblöcke und die Signalführungs-Verbindungen gespeichert. Voreinstellungen können im Live-
Modus oder Design-Modus erstellt und entweder im Gerät oder auf dem PC gespeichert werden. Die im Live-
Modus in das Signalflussdiagramm geladene Voreinstellung ist die aktive Voreinstellung. Zum Auswählen
einer anderen Voreinstellung als aktive Voreinstellung das Dropdown-Menü zur Voreinstellung-Auswahl im
Informationsfeld (Nr. 8 oben) verwenden.

1 2 3 4 5 6 7

9 10

11

Design-Modus:

Live-Modus:

Vorschau-
Modus:

8

ABBILDUNG 1-3, Steuerleiste
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Hauptfenster
Modusanzeige
Hier wird der jeweilige Modus des Signalflussdiagramms angezeigt, wie nachstehend abgebildet.

Eingangs- und Ausgangskanalstreifen
Bei diesen Streifen handelt es sich um eine grafische Darstellung der Ein- und Ausgangskanäle des
DFR22. Sie enthalten die Verstärkungs- und Mischblöcke, die die Verstärkungsstruktur des Geräts bilden
(siehe Erklärung im Abschnitt Verstärkungsstruktur auf Seite 17). Sie enthalten auch die Steckplätze, in
denen die Prozessorblöcke durch Drag&Drop aus der “Prozessor-Toolbox” platziert werden (siehe
Seite 11).

1. Eingangsverstärkungsblock: Dies ist die 
Anfangsstufe der Verstärkungsstruktur des Audioproz-
essors. Durch Doppelklicken auf diesen Block wird das 
Fenster “Input Gain” (Eingangsverstärkung) eingeblendet, 
das Skalierungs-Optionen von -10 dBV/+4 dBu, Kanal-
Stummschaltung, Polaritätsregelung und einen +10/-
unendlich dB-Fader für jeden Eingangskanal aufweist. 
Außerdem werden hier die Namen für die Eingangskanäle 
eingegeben.

2. Eingangskanal-Kennzeichnung: Hier wird die Kanal-
Kennzeichnung angezeigt, die im Fenster “Input Gain” 
(Eingangsverstärkung) eingegeben wird.

3. Prozessor-Steckplatz: Diese Steckplätze fungieren als 
Container für die modularen Prozessorblöcke. Diese kön-
nen folgendermaßen bestückt werden: durch Drag&Drop 
aus der “Prozessor-Toolbox”, durch Wählen des Befehls 
[Processor>Add] (Prozessor>Hinzufügen) aus dem Haupt-
menü oder durch Klicken mit der rechten Maustaste und 
Wählen des Befehls [Add Processor] (Prozessor hinzufü-
gen) aus dem Kontextmenü.

4. Mischpunkte:Durch Klicken auf diese Punkte werden 
Signale zwischen Eingangsstreifen und Ausgangsstreifen 
geführt. Zwischen den verbundenen Punkten werden Lin-
ien angezeigt, die den Signalfluss darstellen. Jeder Einga-
ngsstreifen kann mit einem oder beiden Ausgangsstreifen 
verbunden sein.

5. Kanalnummern: Diese Nummern entsprechen jeweils 
einem der Ein- und Ausgangskanäle.

6. Eingangswähler: Durch Klicken auf diese nummerierten 
Eingangswähler am Mischpunkt jedes Ausgangsstreifens 
wird das Signal direkt vom entsprechenden Eingangska-
nal-Mischpunkt abgeleitet.

7. Mischblock: Dies ist die Zwischenstufe der Ver-
stärkungsstruktur des Audioprozessors. Durch Klicken auf 
diesen Block wird das Fenster “Matrix Mixer” (Matrixmis-
cher) eingeblendet, in dem das Signal von jedem der 
beiden Eingangskanalstreifen zu einem oder beiden Aus-
gangskanalstreifen geführt und die Pegel mit den Fadern 
eingestellt werden können. Dieses Fenster verfügt über 
eine separate Registerkarte für jeden Ausgangskanalstre-
ifen, auf der Verstärkungs-, Polaritäts- und Stummschal-
tungs-Steuerelemente für beide Eingangskanäle angezeigt 
werden.

8. Ausgangsverstärkungsblock: Durch Doppelklicken 
auf diesen Block wird das Fenster “Output Gain” (Aus-
gangsverstärkung) eingeblendet, das Skalierungs-Optionen 
von -10 dBV/+4 dBu, Kanal-Stummschaltung, Polar-
itätsregelung, ein -12 dB-Dämpfungsglied, ein 18 dB-Dämp-
fungsglied und einen +10/-unendlich dB-Fader für jeden 
Ausgangskanal aufweist. Dies ist die Endstufe der Ver-
stärkungsstruktur des Audioprozessors. Außerdem werden 
hier die Namen für die Ausgangskanäle eingegeben.

9. Ausgangskanal-Kennzeichnung: Hier wird die 
Kanal-Kennzeichnung angezeigt, die im Fenster “Output 
Gain” (Ausgangsverstärkung) eingegeben wird.

Design-Modus Live-Modus Vorschau-Modus

1

2 3 4 6 7

8

9

5

ABBILDUNG 1-4: Eingangs- und Ausgangskanalstreifen
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Prozessor-Toolbox
Statusleiste
Dies ist der untere Bereich des “Hauptfensters”.

1. Eingänge stumm schalten: Durch Klicken auf dieses 
Steuerelement werden beide Eingangskanäle direkt stum-
mgeschaltet.

2. Ausgänge stumm schalten: Durch Klicken auf dieses 
Steuerelement werden beide Ausgangskanäle direkt stum-
mgeschaltet.

3. DSP-Belegungsanzeige: Hier wird der Prozentanteil 
der Digitalsignalverarbeitungs-Ressourcen (DSP-Ressou-
rcen) des DFR22 angezeigt, der durch die jeweilige Konfig-

uration der Prozessorblöcke, die in das 
Signalflussdiagramm gesetzt wurden, verbraucht wird. Der 
angezeigte grüne Balken verlängert sich, wenn die DSP-
Belegung zunimmt.

4. Verzögerungsspeicher-Anzeige: Hier wird der Pro-
zentanteil des Verzögerungsspeichers angezeigt, der 
durch die Delay-Prozessoren, die in das Signalflussdia-
gramm gesetzt wurden, verbraucht wird. Der angezeigte 
blaue Balken verlängert sich, wenn die Belegung zunimmt.

Prozessor-Toolbox

Die Prozessor-Toolbox wird beim Starten der Anwendung neben dem Hauptfenster eingeblendet (siehe Abb. 1-6). 
Dieses Fenster enthält die Bibliothek der Prozessoren, die in leere Steckplätze des Signalflussdiagramms gezogen 
und dort abgelegt werden können. Seine Größe kann in vertikaler Richtung durch Ziehen des oberen oder unteren 
Rands nach oben oder unten verändert werden. Eine Bildlaufleiste erscheint an der rechten Seite, sodass unabhängig 
von der Höhe des Fensters Zugriff auf jeden Prozessorblock möglich ist.

Ein- und Ausblenden
Die Prozessor-Toolbox wird durch Klicken auf das [X] in der rechten Ecke
der Titelleiste oder durch Wählen der Option [View>Show Processor Tool-
box] (Ansicht >Prozessor-Toolbox anzeigen) aus dem Hauptmenü
geschlossen. Zum erneuten Öffnen der Prozessor-Toolbox [View>Show
Processor Toolbox] erneut wählen. Neben der Menüoption wird ein
Häkchen gesetzt, wenn die Prozessor-Toolbox geöffnet ist. 

Eigenschaften
1. Dropdown-Schaltflächen:Eine Dropdown-Schaltfläche erscheint 

über jeder Prozessor-Kategorie in der Prozessor-Toolbox. Durch 
Klicken auf eine Dropdown-Schaltfläche werden alle Prozessorblöcke 
innerhalb dieser Kategorie angezeigt bzw. verborgen.

2. Prozessorblöcke:Prozessorblöcke sind die grafische Darstellung der 
Prozessormodule. Nachdem sie in das Signalflussdiagramm gesetzt 
wurden, ist Zugriff auf die entsprechenden Einstellungen möglich, 
indem auf den betreffenden Block doppelgeklickt wird, um sein Param-
eterfenster einzublenden. Der Prozentanteil der Digitalsignalverarbeitungsressourcen, die die einzelnen 
Prozessormodule verbrauchen, wird in der Prozessor-Toolbox rechts von den Blöcken angezeigt.

1 2 3 4

ABBILDUNG 1-5: Statusleiste

1

2

ABBILDUNG 1-6: Prozessor-Toolbox
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ABSCHNITT 2 Einrichtung
In diesem Abschnitt werden die grundlegenden Schritte für die vollständige Einrichtung des Audioprozessors erläutert.
Bevor diese Anweisungen ausgeführt werden, sollte der Abschnitt “Übersicht” gelesen werden, der einige grundleg-
ende Merkmale der Software-Schnittstelle beschreibt.

Viele dieser Anweisungen können ausgeführt werden, ohne dass das Gerät angeschlossen ist, indem die Voreinstel-
lungen im Computer gespeichert und später zum Gerät übertragen werden. Um die Möglichkeiten des DFR22 optimal
vorzustellen, wird bei diesen Anweisungen folgendes vorausgesetzt:

• Beim Arbeiten in der Software ist das Gerät angeschlossen.
• Die Installation umfasst die externe Gerätesteuerung.
• Geräte-Sicherheit ist erforderlich.

In den Anweisungen können Schritte vorkommen, die nicht unmittelbar auf die bestehende Installation zutreffen. Wir
empfehlen jedoch, den gesamten Abschnitt “Einrichtung” durchzuarbeiten, um die empfohlenen Arbeitsabläufe für die
Einrichtung des Geräts kennen zu lernen.

Installation der Software

Wenn die Software noch nicht installiert wurde, sind die nachstehenden Anweisungen auszuführen, um die Anwend-
ung von der CD-ROM zu installieren.

So wird die Software von der CD-ROM installiert:
1. Die CD in das CD-ROM-Laufwerk des Computers einlegen.
2. Das Installationsprogramm startet automatisch. Die angezeigten Anweisungen ausführen.

Falls die Installation nicht automatisch beginnt:
1. Auf die Schaltfläche [Start] der Windows Taskleiste klicken und [Ausführen…] aus dem 

Popup-Menü wählen.
2. “D:\setup” eingeben (wobei “D” der CD ROM-Laufwerksbuchstabe ist). Das Installationsprogramm startet 

automatisch. Die angezeigten Anweisungen ausführen.
3. Auf [OK] klicken und die Anweisungen des Installationsprogramms ausführen.

Wenn die Software per Datenübertragung erhalten wurde, die Datei mit der Endung “.exe” im Windows Explorer 
öffnen. Die Anweisungen des Installationsprogramms ausführen.

Herstellung der Datenübertragung zum Gerät

Dieses Verfahren ist auszuführen, wenn der Computer zum ersten Mal an das Gerät angeschlossen wird. Dies ist die 
erste Möglichkeit zur Überprüfung, ob der Computer und der DFR22 einwandfrei miteinander kommunizieren. Weitere 
Informationen zum Anschließen des Computers an das Gerät und zum Einstellen der Geräte-Kennnummer siehe  
Installation Guide (Installationsanleitung).

1. Den Computer an den DFR22 Audioprozessor anschließen
Den COM-Anschluss des Computers mit dem seriellen RS-232-Anschluss
an der Vorder- oder Rückseite des DFR22 verbinden.

2. Die Software-Anwendung starten

3. Den COM-Anschluss wählen
a) Den Befehl [Devices>Select COM Port] (Geräte>COM-Anschluss 

wählen) aus dem Hauptmenü wählen.
b) Das Dialogfeld “COM Port” wird geöffnet (siehe Abb. 2-1).
c) Den COM-Anschluss wählen, an den das RS-232-Kabel angeschlossen ist, und auf [OK] klicken.

ABBILDUNG 2-1: Dialogfeld “COM 
Port” (COM-Anschluss)
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Externe Steuerung konfigurieren
4. Auf die Schaltfläche [Live Mode] (Live-Modus) in der Steuerleiste klicken.

5. Das Gerät benennen
a) Den Befehl [Devices>Name Device] (Geräte>Gerät benennen) aus dem 

Hauptmenü wählen.
b) Das Dialogfeld “Name Device” wird geöffnet (siehe Abb. 2-2).
c) Einen aus bis zu fünfzehn Zeichen bestehenden Gerätenamen einge-

ben und auf [Name] (Benennen) klicken.
d) Der Gerätename erscheint im Live-Modus in der Titelleiste des Haupt-

fensters und wird im Menü [Devices] (Geräte) aufgelistet.

Externe Steuerung konfigurieren

Wenn externe Geräte an den Steuerpins angeschlossen sind, muss der DFR22 zum Erkennen der externen Steuerung 
konfiguriert werden. Diese Konfiguration wird auf Geräteebene gespeichert und sollte eingerichtet werden, bevor Vore-
instellungen erstellt werden. Wenn kein Anschluss an das Gerät besteht, kann eine Konfiguration erstellt und im Com-
puter gespeichert werden, um sie später über die RS-232-Verbindung zum DFR22 zu übertragen. Umfassende 
schrittweise Anweisungen siehe Abschnitt Steuerpins auf Seite 88.

1. In den Design-Modus schalten
Zum Konfigurieren der externen Steuerung muss der Design-Modus aktiviert sein. Im Live-Modus auf die
Schaltfläche [Design Mode] (Design-Modus) in der Steuerleiste des Hauptfensters klicken.

2. Steuerpins konfigurieren
Die Option [Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) im Hauptfenster wählen,
woraufhin das Fenster “Control Pins” (Steuerpins) eingeblendet wird.

a) Im Feld [# Presets] (Anzahl der Voreinstellungen) die Anzahl der Voreinstellungen angeben, die per 
externer Steuerung gewählt werden sollen.

b) Im Feld [Encoding Type] (Codierungstyp) den Codierungstyp wählen, den der DFR22 verwenden muss, 
um die Meldungen der externen Hardware zu erkennen.

c) Bei Bedarf weitere Hardware wie Potentiometer und Schalter angeben, die zur Stummschaltung von 
Kanälen und zur Einstellung der Verstärkung angeschlossen ist.

3. Die Konfiguration im Gerät oder PC speichern
Die Menüoption [Configuration>Store to Device] (Konfiguration>Im Gerät speichern) oder [Configuration>Save
to PC] (Konfiguration>Im PC speichern) wählen.

Hinweis:Standardmäßig können mit der Voreinstellung-Auswahl an der Frontplatte des DFR22 
Voreinstellungen gewählt werden.

Hinweis:Wenn es nach der Konfiguration der Steuerungs-Eingangsanschlüsse erforderlich werden sollte, 
Voreinstellungen vom Computer umzuschalten, müssen die Verbindungen im Fenster “Control Pins” 
vor dem Fortfahren deaktiviert werden. Auf den Pfeil rechts vom Voreinstellung-Steuerblock klicken 
und im Dropdown-Menü die Option [Disable] (Deaktivieren) wählen.

ABBILDUNG 2-2: Dialogfeld “Name 
Device” (Gerät benennen)
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Eine Voreinstellung-Vorlage erstellen
Eine Voreinstellung-Vorlage erstellen

Dieser Vorgang kann im Live-Modus oder Design-Modus ausgeführt werden. Wenn mehrere Voreinstellungen im 
Audioprozessor gespeichert werden sollen, ist eine beträchtliche Zeiteinsparung möglich, indem eine Voreinstellung-
Vorlage erstellt wird, die die Attribute enthält, die gemeinsam für diese Voreinstellungen gelten. Diese Vorlage kann 
dann aus dem Gerät abgerufen oder von einem PC aus geöffnet, nach Erfordernis bearbeitet und dann als neue Vore-
instellung im Gerät gespeichert werden.

1. Eine Voreinstellung-Vorlage wählen
Beim Starten der DFR22 Anwendung befindet sich im Signalflussdiagramm eine leere Voreinstellung. Wenn
eine der anderen vorgegebenen Voreinstellungen als Vorlage verwendet werden soll, die Option [File>New]
(Datei>Neu) und dann [Dual Mono], [Stereo] oder [Dual Mono Split] aus dem Hauptmenü wählen. Es kann
auch in den Live-Modus geschaltet und eine der vorab geladenen Voreinstellungen zur Bearbeitung gewählt
werden. Weitere Informationen siehe Abschnitt Voreinstellungs-Presets auf Seite 28.

2. Ein- und Ausgangskanäle benennen
Auf die Eingangs- und Ausgangs-Verstärkungsblöcke doppelklicken, um die Prozessorparameter-Fenster ein-
zublenden, und die Kanal-Kennzeichnungen unter den Pegelstellern bearbeiten. Weitere Informationen siehe
Abschnitt Ein- und Ausgänge kennzeichnen auf Seite 18.

3. Das Signalflussdiagramm bestücken
Signalprozessorblöcke aus der “Prozessor-Toolbox” ziehen und im Signalflussdiagramm ablegen. Wenn eine
Frequenzweiche verwendet wird, sollte diese als erster Prozessortyp in die Konfiguration gesetzt werden,
gefolgt von Limitern, um Schäden an den Lautsprechern zu vermeiden. Weitere Informationen siehe Abschnitt
Modulare Prozessoren hinzufügen auf Seite 21.

4. Verknüpfte Gruppen erstellen
Die Taste Strg drücken und dabei klicken, um mehrere Prozessoren des gleichen Typs zu wählen, die als
Gruppe gesteuert werden sollen, z. B. als Stereo-Paare, Lautsprechergruppen, Zonen usw. Es ist auch
möglich, Verstärkungsblöcke zu verknüpfen, um den Gesamtpegel des Systems zu steuern. [Processor>Link]
(Prozessor>Verknüpfen) aus dem Hauptmenü wählen. Weitere Informationen siehe Abschnitt
Verknüpfungen auf Seite 24.

5. Dämpfungsglieder an Ausgängen aktivieren
Eventuell ist es notwendig, das 12 dB- oder 18 dB-Dämpfungsglied zu aktivieren, um den Ausgangsbegren-
zungspegel des DFR22 besser an den Eingangsbegrenzungspegel des Geräts anzupassen, das angeschlos-
sen ist. Durch Doppelklicken auf einen Ausgangsverstärkungsblock wird das Fenster “Output Gain”
(Ausgangsverstärkung) eingeblendet. Dann nach Bedarf die Dämpfungsglieder aktivieren.

6. Signale von Eingängen zu Ausgängen führen
Das Signal durch Klicken und Ziehen von Eingangsstreifen-Verbindungspunkten zu Ausgangsstreifen-Verbind-
ungspunkten durch den Matrixmischer führen. Weitere Informationen siehe Abschnitt Signalführung auf
Seite 19.

7. Prozessor-Parameter einstellen
Auf die einzelnen Prozessorblöcke doppelklicken, um ihre Parameter-Fenster einzublenden. Beim Arbeiten im
Design-Modus ohne Verbindung zum Gerät können vorläufige Pegel eingestellt und später, wenn der
Anschluss zum Gerät besteht, überarbeitet werden. Weitere Informationen zum Arbeiten mit Prozessoren
siehe Abschnitt Prozessor-Funktionen auf Seite 34 sowie die Referenzabschnitte für die einzelnen Proz-
essoren.
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Voreinstellungen verwalten
8. Die Voreinstellung den Steuerungsanschlüssen zuordnen
Dieser Schritt ist nur erforderlich, wenn die Verstärkung und/oder die Stummschaltung von Kanälen mit Steuer-
pins gesteuert wird. Die Option [Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) im
Hauptfenster wählen, um das Fenster “Control Pins” (Steuerpins) zu öffnen. [Configuration>Recall From
Device] (Konfiguration>Aus Gerät abrufen) wählen, um das Fenster mit der derzeitigen Pin-Konfiguration zu
bestücken. Die Ein- und Ausgangskanäle werden in einer Spalte unter den einzelnen Verbindungsblöcken auf-
geführt. Die Kontrollkästchen neben den einzelnen Ein- bzw. Ausgangskanälen markieren, denen die
Steuerungsanschlüsse zugeordnet werden sollen. Weitere Informationen siehe Abschnitt ”Processor Mapping”
(Prozessor-Zuordnung) auf Seite 96.

9. Prozessoren für schreibgeschützten Zugriff sperren
Dieser Schritt ist nur erforderlich, wenn die Sicherheit für Endbenutzer definiert werden soll, die von der Soft-
ware aus auf den DFR22 zugreifen. Dieser Sicherheitstyp wird für jeden Prozessor auf Voreinstellung-Ebene
gespeichert. Die Prozessoren wählen, die vor Änderungen durch den Benutzer geschützt werden sollen, und
[Security>Level 2>Lock Selected] (Sicherheit>Stufe 2>Gewählten Prozessor sperren) aus dem Hauptmenü
wählen. Umfassende Erläuterungen und weitere Anweisungen siehe Abschnitt Sicherheit einzelner
Prozessoren auf Seite 102.

10. Voreinstellung benennen
Einmal mit der linken Maustaste irgendwo im Informationsfeld in der
Mitte der Steuerleiste klicken, um das Dialogfeld “Preset Information”
(Voreinstellung-Informationen) einzublenden (siehe Abb. 2-3 rechts)
Einen aus bis zu 15 Zeichen bestehenden Namen für die Voreinstel-
lung und eine Beschreibung eingeben und auf [OK] klicken. Weitere
Informationen siehe Abschnitt Benennen einer Voreinstellung auf
Seite 20.

Voreinstellungen verwalten

1. Die fertiggestellte Voreinstellung im Gerät speichern
Beim Arbeiten im Live-Modus wurde die Voreinstellung bereits im Gerät gespeichert. Wenn im Design-Modus
gearbeitet wird, auf die Schaltfläche [Store Preset] (Voreinstellung speichern) in der Steuerleiste des Hauptfen-
sters klicken. Weitere Informationen siehe Abschnitt Geräte-Voreinstellungen auf Seite 30. Ein Duplizieren
dieser Voreinstellung ist nur im Design-Modus möglich. Einfach weiter auf die Schaltfläche [Store Preset] klicken,
um Duplikate zu erzeugen, bis so viele Voreinstellungen im Gerät gespeichert sind, wie benötigt werden.

2. Nicht mehr benötigte Voreinstellungen aus dem Gerät löschen
Das Gerät wird ab Werk mit drei vorab geladenen Voreinstellungen ausgeliefert. Wenn diese nicht verwendet
werden, empfiehlt es sich, diese aus dem Gerät zu löschen, damit Endbenutzer nicht auf diese zugreifen kön-
nen. (Werden diese später erneut benötigt, können sie mit dem Menü [File>New] (Datei>Neu) erneut geladen
werden.) Anweisungen siehe Abschnitt Eine Voreinstellung löschen auf Seite 31.

3. Externe Steuerung aktivieren
Wenn die Steuerungsanschlüsse vorher deaktiviert wurden, um den Audioprozessor vom Computer aus
steuern zu können, das Fenster “Control Pins” öffnen und die Steuerungsanschlüsse wieder aktivieren, nach-
dem das Erstellen und Bearbeiten der Voreinstellungen beendet ist. Weitere Informationen siehe Abschnitt
WICHTIGER HINWEIS ZUR VOREINSTELLUNG-UMSCHALTUNG: auf Seite 89.

ABBILDUNG 2-3 Dialogfeld “Preset 
Information” (Voreinstellung-Informationen)
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Sicherheit einrichten
Sicherheit einrichten

Dies ist der letzte Schritt bei der Einrichtung des Geräts. Vor dem Fortfahren sollte der Abschnitt Sicherheit auf Seite 99 
gründlich gelesen werden. Die folgenden Anweisungen sind lediglich als Übersicht des Verfahrens anzusehen.

1. Den DFR22 in den Live-Modus schalten
Zum Einstellen der Gerätesicherheit muss der Live-Modus aktiviert sein. Im Design-Modus auf die Schaltfläche
[Live Mode] in der Steuerleiste des Hauptfensters klicken.

2. Die Sperrung der Bedienelemente auf der Frontplatte aktivieren
Die Option [Security>Front Panel Lockout] (Sicherheit>Sperrung der Bedienelemente auf der Frontplatte) im
Hauptmenü wählen, woraufhin das Dialogfeld “Front Panel Lockout” (Sperrung der Bedienelemente auf der
Frontplatte) eingeblendet wird. Die Kontrollkästchen neben den einzelnen Funktionen der Frontplatte marki-
eren, deren Zugriff für Endbenutzer gesperrt werden soll. Diese Funktion der Software kann zum selektiven
Sperren von Bedienelementen der Frontplatte verwendet werden. Um alle Bedienelemente der Frontplatte
zu sperren, kann auch der fünfte DIP-Schalter auf der Rückseite des Gerätes in die untere Stellung
geschaltet werden.

3. Kennwort einstellen
Die Option [Security>Set Password] (Sicherheit>Kennwort einstellen) im Hauptmenü wählen, woraufhin das
Dialogfeld “Create Password” (Kennwort erstellen) eingeblendet wird. Ein Kennwort eingeben, die Taste Tab
drücken und dann das Kennwort zur Bestätigung erneut eingeben. Auf [OK] klicken.

4. Benutzer-Zugangsstufe einstellen
Die Option [Security>Set Level] (Sicherheit>Stufe einstellen) im Hauptmenü wählen, woraufhin das Dialogfeld
“Set Security” (Sicherheit einstellen) eingeblendet wird. Die gewünschte Benutzer-Zugangsstufe wählen. Auf
[OK] klicken.
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ABSCHNITT 3 Erstellen einer Voreinstellung
Eine Voreinstellung ist eine bestimmte Kombination von Signalführungs-Verbindungen, der Auswahl und Anordnung
von modularen Prozessoren und Prozessor-Einstellungen. Eine Konfiguration wird im Signalflussdiagramm des Haupt-
fensters erstellt und entweder als Voreinstellung im Gerät oder als Datei im Computer gespeichert, die später an das
Gerät gesendet werden kann.

Signalfluss-Konfiguration

Um Audio-Informationen durch das Gerät zu leiten, müssen Signale durch Verbinden von Mischpunkten von den 
Eingängen zu den Ausgängen geführt werden. In diesem Abschnitt werden die Grundlagen des Signalfluss-Designs in 
der Benutzeroberfläche des DFR22 erläutert.

Verstärkungsstruktur
Der DFR22 Audioprozessor bietet Pegelregelung an drei Stufen des Signalflusses: Eingangsverstärkung,
Matrixmischer und Ausgangsverstärkung. Es ist wichtig, diese Verstärkungsstruktur zu verstehen, bevor Sig-
nale durch das Gerät geleitet werden, um Schäden durch übermäßige Verstärkungspegel an den hinter dem
Audioprozessor angeschlossenen Geräten zu vermeiden. Die folgende Abbildung zeigt eine Übersicht der
Verstärkungsstruktur des DFR22.

1) Eingangsverstärkung
Durch Doppelklicken auf einen Eingangsblock wird das Fenster “Input Gain processor” (Eingangsver-
stärkungs-Prozessor) eingeblendet, in dem Steller für beide Kanäle angezeigt werden. Es bietet Bedi-
enelemente für Eingangsempfindlichkeit, Verstärkung und Polarität für jeden Kanal und gestattet die
Zuweisung von benutzerdefinierten Namen für die Eingangskanalstreifen.

Hier befindet sich der Eingangspunkt eines Signals in das Signalflussdiagramm. Hinter dem Eingangsver-
stärkungs-Prozessor wird das Signal der Reihe nach durch die Prozessor-Steckplätze in seinem Eingang-
skanalstreifen geführt. Am Ende des Kanalstreifens erreicht das Signal einen Mischpunkt, von dem es zu
einem oder beiden Ausgängen durch den Matrixmischer geführt werden kann. 

2) Matrixmischer
Nachdem ein Signal zum Mischpunkt eines Ausgangskanalstreifens geführt wurde, tritt es in die Matrix-
mischer-Stufe der Verstärkungsstruktur ein. Durch Doppelklicken auf einen Mischblock wird das Fenster
“Matrix Mixer” (Matrixmischer) eingeblendet, das für jeden Ausgangskanalstreifen einen Fensterabschnitt
enthält. Wenn die Frequenzweiche bzw. der Verteiler in beiden Ausgangskanälen platziert wird, werden
die Mischpultbereiche der beiden Kanäle zu einem Bereich zusammengefasst. Dieses Fenster dient zum
Einstellen der Polarität und des relativen Pegels des Eingangs / der Eingänge, der / die zum gewählten
Ausgangskanal geführt wird / werden.

Hinter dem Matrixmischer wird das Signal der Reihe nach durch die Prozessor-Steckplätze des zugewie-
senen Ausgangsstreifens geführt. Am Ende des Kanalstreifens erreicht das Signal den Ausgangsver-
stärkungsblock.

Hinweis: Signalpegel, die die Eingangsschwelle des Audioprozessors überschreiten, müssen extern eingestellt 
werden, um eine Übersteuerung der A/D-Wandler zu vermeiden. 

1 2 3
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ABBILDUNG 3-1: Verstärkungsstrukturdiagramm
© 2003 Shure Incorporated DFR22-Software-Bedienungsanleitung 17



Signalfluss-Konfiguration
3) Ausgangsverstärkung
Dies ist die Endstufe der Pegelregelung im Audioprozessor. Durch Doppelklicken auf einen Ausgangsver-
stärkungsblock wird das Fenster “Output Gain processor” (Ausgangsverstärkungs-Prozessor) eingeblen-
det. Es bietet Bedienelemente für Ausgangsempfindlichkeit, Verstärkung und Polarität sowie ein optionales
12 dB- und 18 dB-Dämpfungsglied für jeden Kanal. In diesem Fenster ist es außerdem möglich, den Aus-
gangskanalstreifen benutzerdefinierte Namen zuzuweisen. Hinter dem Ausgangsverstärkungs-Prozessor
wird das Signal durch den Digital-Analog-Wandler und dann durch die analogen Dämpfungsglieder (falls
diese aktviert sind) zum Audio-Ausgang geführt.

4) Signalführungs-Verbindung
Diese kann im Signalflussdiagramm durch Klicken und Ziehen zwischen Mischpunkten, durch Klicken auf
einen Eingangswähler unmittelbar links vom Mischblock oder durch Öffnen des Fensters “Matrix Mixer”
(Matrixmischer) und Auswählen des Eingangs erstellt werden. Weitere Informationen siehe Abschnitt
Signalführung auf Seite 19.

Kanäle stumm schalten
Es gibt verschiedene Möglichkeiten zum Stummschalten der Ein- und Ausgangskanäle des Audioprozessors.
Stummgeschaltete Kanäle werden im Signalflussdiagramm gekennzeichnet, wie in der nachstehenden Tabelle
dargestellt.

Alle Ein- oder Ausgänge stumm schalten
• Auf das Steuerelement “Mute All Inputs” (Alle Eingänge stumm schalten) oder “Mute All Outputs” (Alle 

Ausgänge stumm schalten) auf der Statusleiste im Hauptfenster klicken.

• Die Menüoption [Processor>Mute All Inputs] (Prozessor>Alle Eingänge stumm schalten) bzw. [Proces-
sor>Mute All Outputs] (Prozessor>Alle Ausgänge stumm schalten) wählen.

• Das Gerät ausschalten, um automatisch alle Ausgänge stumm zu schalten.

Einzelne Kanäle stumm schalten
1. Das Fenster “Input Gain”, “Matrix Mixer” oder “Output Gain” durch Doppelklicken auf den entsprech-

enden Prozessorblock einblenden.
2. Auf die Stummschaltungs-Schaltfläche für den entsprechenden Kanal klicken.
3. Der Block wird durch ein rotes “M” gekennzeichnet, um darauf hinzuweisen, dass er stummgeschaltet ist.

Ein- und Ausgänge kennzeichnen
Beim Erstellen einer neuen Voreinstellung sind Ein- und Ausgänge unbenannt, sie können aber im Fenster
“Input Gain” und/oder “Output Gain” leicht mit Namen versehen werden. Kanal-Kennzeichnungen werden
zusammen mit der Voreinstellung gespeichert, sodass Ein- und Ausgänge für jede Voreinstellung mit
benutzerdefinierten Namen versehen werden können.

Verstärkungsblock Eingänge zum 
Matrixmischer

Frequenzweichen-
Ausgangskanäle

Ein- und Ausgangskanäle 
stummgeschaltet
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So wird eine Kanal-Kennzeichnung geändert:
1. Auf den Verstärkungsblock des Kanals doppelklicken.
2. Im Prozessor-Fenster das Namensfeld des Kanals suchen.
3. Klicken und den Mauszeiger über den Text ziehen, um ihn zu markieren.
4. Einen neuen Namen mit bis zu fünfzehn Zeichen eingeben.
5. Die Änderung wird wirksam, indem auf ein anderes Steuerelement geklickt oder das Fenster geschlossen wird.

Signalführung
Der DFR22 gestattet es, das Signal von jedem der beiden Eingänge zu einem oder zu beiden Ausgängen zu
führen. Damit Signale von den Eingangskanalstreifen zu den Ausgangskanalstreifen gelangen, müssen sie
durch den Matrixmischer geführt werden. Zum Verbinden der Eingänge mit den Ausgängen sind die nachste-
hend beschriebenen Methoden verfügbar.

Verbindungen im Signalflussdiagramm herstellen
Für einfache System-Konfigurationen lassen sich Eingänge am besten mit Ausgängen verbinden, indem
die Maus im Signalflussdiagramm eingesetzt wird.

Auf Mischpunkte klicken:
1. Auf einen Eingangsmischpunkt klicken.
2. Der Cursor ändert sich, was bedeutet, dass 

jetzt eine Ausgangsverbindung bestimmt 
werden muss:

3. Auf einen Ausgangsmischpunkt klicken.

Klicken und zwischen Mischpunkten ziehen:
1. Auf einen Eingangsmischpunkt klicken und von dort zu einem Ausgangsmischpunkt ziehen. 
2. Entlang des Signalwegs erscheint eine Verbindungslinie. Sie wird grün, wenn die Verbindung zulässig ist.
3. Die Maustaste loslassen, um die Verbindung herzustellen.

Auf den Eingangswähler klicken:
1. Auf den nummerierten Eingangswähler eines Ausgangskanals für den zugehöri-

gen Eingangskanal klicken.
2. Eine Verbindungslinie erscheint im Signalflussdiagramm zwischen den Mis-

chpunkten und der nummerierte Eingangswähler wird markiert.

Verbindungen im Fenster “Matrix Mixer” (Matrixmischer) herstellen
Für komplexere Konfigurationen mit vielen sich kreuzenden Verbindungslinien bietet das Fenster “Matrix
Mixer” eine einfachere Methode zum Verbinden von Eingängen mit Ausgängen.

So werden Verbindungen im Matrixmischer erstellt:
1. Auf den Mischblock für den Ausgang doppelklicken, mit dem die Verbindung hergestellt werden soll.
2. Das Fenster “Matrix Mixer” wird eingeblendet.
3. Auf der linken Seite des Fensters auf die Eingangs-Schaltfläche für jeden Eingangskanal klicken, der 

mit dem ausgewählten Ausgang verbunden werden soll. Die Eingangs-Schaltfläche wird grün dargest-
ellt, wenn eine Verbindung erstellt wurde.

4. Eine Verbindungslinie erscheint im Signalflussdiagramm zwischen den Mischpunkten, und der num-
merierte Eingangswähler wird für jede aktive Verbindung markiert. 

Tipp! Nach dem Klicken auf einen Eingangsmischpunkt kann die Verbindung mit der Taste  Esc 
aufgehoben werden, bevor auf einen Ausgangsmischpunkt geklickt wird.
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Verbindungen löschen
• Auf eine Verbindungslinie klicken und die Taste Entf drücken. 
• Auf den Eingangswähler der entsprechenden Verbindung klicken. Dadurch wird die Verbindung aus-

geschaltet.
• Auf eine Verbindungslinie klicken und das durch Klicken mit der rechten Maustaste eingeblendete 

Kontextmenü verwenden.
• Zum Wählen mehrerer Verbindungen beim Klicken auf die Verbindungen die Taste Strg gedrückt 

halten, dann die Taste Entf drücken.

Benennen einer Voreinstellung
Da bis zu 16 verschiedene Voreinstellungen im DFR22 gespeichert werden können, ist es hilfreich, wenn sie
mit Namen und kurzen Beschreibungen versehen werden. Diese Angaben werden im Informationsfeld in der
Mitte der Steuerleiste des Hauptfensters angezeigt (siehe Abb. 3-2 unten).

Der hier eingegebene Name wird beim Speichern der Konfiguration im Gerät der Voreinstellung und beim Spe-
ichern im PC auch der Datei zugewiesen. Die Beschreibung wird außerdem in allen Dialogfeldern angezeigt, in
denen Voreinstellungen aufgelistet werden. Diese Angaben können jederzeit im Live-Modus oder Design-
Modus geändert werden.

So wird eine Voreinstellung benannt:
1. Einmal mit der linken Maustaste irgendwo im Informationsfeld 

klicken.
2. Das Dialogfeld “Preset Information” wird eingeblendet.
3. Einen Namen mit bis zu 15 Zeichen und eine Beschreibung mit 

maximal 80 Zeichen eingeben.
4. Auf [OK] klicken.
5. Das Informationsfeld wird mit diesen Angaben aktualisiert.

Prozessor-Konfiguration

Das Arbeiten mit Prozessoren kann auf zwei Ebenen erfolgen: auf der Konfigurationsebene im Signalflussdiagramm 
und im individuellen Parameterfenster jedes einzelnen Prozessors, das durch Doppelklicken auf den Prozessorblock 
aufgerufen wird. Dieser Abschnitt behandelt das Arbeiten mit Prozessoren im Signalflussdiagramm und erläutert die 
Unterschiede zwischen den zwei Hauptkategorien von Prozessoren.

Prozessortypen
Im Signalflussdiagramm wird mit zwei Haupttypen von Prozessoren gearbeitet: feste und modulare. Der wes-
entliche Unterschied zwischen diesen beiden Typen besteht darin, dass feste Prozessoren Bestandteile der
Verstärkungsstruktur des DFR22 sind und daher in jeder Signalfluss-Konfiguration vorkommen. Modulare
Prozessoren sind die Prozessorblöcke, die in der “Prozessor-Toolbox” aufgeführt werden und die ausgewählt
und je nach den spezifischen Systemanforderungen platziert werden können.

Feste Prozessoren
Die Verstärkungs- und Mischblöcke werden als feste Prozessoren bezeichnet, weil ihre Positionen auf den
Kanalstreifen permanent sind. Sie können nicht gelöscht, versetzt, kopiert oder eingefügt werden. Sie kön-
nen jedoch verknüpft werden und ihre Einstellungen lassen sich speichern und abrufen.

ABBILDUNG 3-2: Informationsfeld

ABBILDUNG 3-3: Dialogfeld “Preset 
Information” (Voreinstellung-Informationen)
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Modulare Prozessoren
Diese Prozessorblöcke werden als modular bezeichnet, weil sie in jeden leeren Steckplatz (außer Fre-
quenzweichen, Verteiler, Subwoofer und Ducker) gesetzt und nach Wunsch versetzt, kopiert, eingefügt
und gelöscht werden können. Jeder Prozessorblock im Signalflussdiagramm arbeitet unabhängig. Wenn
das Parameterfenster eines modularen Prozessors geöffnet wird, werden nur die Einstellungen für diesen
Block geändert, außer unter den nachstehenden Bedingungen:

• Der Block bildet die Hälfte eines Stereopaares.
• Der Block gehört zu einer verknüpften Gruppe.

Modulare Prozessoren hinzufügen
Jeder Kanalstreifen weist eine Reihe von leeren Steckplätzen auf, die jeden der modularen Prozessorblöcke
aufnehmen können. Mit Ausnahme von Frequenzweichen, Subwoofern, Verteilern und Duckern bestehen
keine Einschränkungen dafür, wo Prozessoren im Signalflussdiagramm angeordnet werden oder wie oft ein
bestimmter Prozessor im gleichen Kanalstreifen eingesetzt wird. Leere Steckplätze zwischen Prozessoren
haben keine Auswirkungen auf den Signalfluss, sodass die Blöcke in den Kanalstreifen nicht unmittelbar nebe-
neinander liegen müssen.

Wenn Prozessorblöcke anfänglich dem Signalflussdiagramm hinzugefügt werden, weisen sie die Werksvorein-
stellungen auf. Die Einstellungen jedes einzelnen Prozessors können im zugehörigen Parameterfenster indivi-
duell geändert werden. Die Blöcke behalten ihre Einstellungen bei, wenn sie in einen anderen Steckplatz
kopiert oder verschoben werden.

Prozessorblöcke können mit der “Prozessor-Toolbox” oder durch Menübefehle dem Signalflussdiagramm hin-
zugefügt werden. Diese Methoden werden nachstehend beschrieben.

Verwendung der “Prozessor-Toolbox”
Ein Prozessorblock kann mit der Maus aus der “Prozessor-Toolbox” genommen werden. Der Mauszeiger
ändert sich, um darauf hinzuweisen, dass der Block durch die nächste Mausaktion in das Signalflussdia-
gramm gesetzt wird. Das Aussehen des Cursors ist von seiner Position abhängig, wie in der nachste-
henden Tabelle dargestellt.

So wird ein Prozessorblock aus der “Prozessor-Toolbox” hinzugefügt:
1. In der “Prozessor-Toolbox” mit der Maus auf einen Prozessorblock zeigen und klicken.
2. Die Maustaste gedrückt halten und den Block auf das Signaldiagramm ziehen.
3. Die Maustaste loslassen, um den Block an der jeweiligen Cursorposition anzuordnen.

- ODER -

1. In der “Prozessor-Toolbox” mit der Maus auf einen Prozessorblock zeigen und klicken.
2. Auf den vorgesehenen leeren Steckplatz im Signalflussdiagramm klicken.

Verwendung eines Menübefehls
Es ist möglich, dem Signalflussdiagramm Prozessoren hinzuzufügen, ohne die “Prozessor-Toolbox” zu
öffnen, indem das Hauptmenü oder das über Klicken mit der rechten Maustaste zugängliche Kontextmenü
verwendet wird, wie nachstehend beschrieben.

Position, an der der 
Prozessor angeordnet 
werden kann

Unzulässige Position für 
diesen Prozessor

Tipp! Wenn ein Prozessorblock doch nicht in das Signalflussdiagramm gesetzt werden soll, nachdem in 
der “Prozessor-Toolbox” darauf geklickt wurde, kann der Vorgang durch Drücken der Taste Esc 
abgebrochen werden.
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So wird ein Prozessorblock über das Menü hinzugefügt:
1. Durch Klicken einen leeren Steckplatz wählen.
2. Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden, und daraus einen Prozessor 

wählen.
- ODER -
Die Option [Processor>Add] (Prozessor>Hinzufügen) in der Hauptmenüleiste verwenden.

Ein weiterer Vorteil in der Verwendung eines Menübefehls zum Positionieren von Prozessorblöcken
besteht darin, dass der gleiche Prozessortyp mit nur einem Menübefehl in mehrere Steckplätze gesetzt
werden kann.

So werden mehrere Prozessorblöcke hinzugefügt:
1. Die Taste Strg drücken und dabei klicken, um mehrere leere Steckplätze zu wählen.
2. Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden, und daraus einen Prozessor 

wählen.
- ODER -
Die Option [Processor>Add] (Prozessor>Hinzufügen) in der Hauptmenüleiste verwenden.

3. Alle gewählten Steckplätze werden mit dem Prozessor bestückt.

Stereo-Prozessoren
Stereo-Prozessoren werden auf ähnliche Wiese wie die anderen modularen Prozessorblöcke in das Sig-
nalflussdiagramm gesetzt. Jeder der Stereokanäle erscheint jedoch als ein separater Block. Durch Dop-
pelklicken auf einen der Blöcke wird das Parameterfenster für beide Kanäle eingeblendet.

Jeder der folgenden Prozessoren fungiert als Stereopaar:

So wird ein Stereo-Prozessorblock aus der “Prozessor-Toolbox” hinzugefügt:
1. In der “Prozessor-Toolbox” mit der Maus auf einen Stereo-Prozessorblock klicken.

Wenn ein Stereo-Prozessor aus der “Prozessor-Toolbox” gewählt wird, sieht der Cursor etwas anders
aus als bei anderen Prozessoren, wie in der folgenden Tabelle dargestellt.

2. Den ersten Kanal des Stereopaars mit einer der folgenden Methoden hinzufügen:
a) Die linke Maustaste klicken und halten, um einen Prozessorblock aus der “Prozessor-Toolbox” 

zum Signalflussdiagramm zu ziehen.
b)  Die Maustaste loslassen, um den ersten Prozessorkanal an der jeweiligen Cursorposition 

anzuordnen.
- ODER -

a) In der “Prozessor-Toolbox” mit der Maus einmal auf einen Prozessorblock klicken.
b) Erneut auf den vorgesehenen leeren Steckplatz im Signalflussdiagramm klicken.

Blockname Beschreibung
ST DFR 5 Stereo 5-Band DFR
ST DFR 10 Stereo 10-Band DFR
ST DFR 16 Stereo 16-Band DFR
ST COMP Stereo-Kompressor
Sft ST COMP Stereo Soft-Knee-Kompressor
ST LIM Stereo-Limiter
Sft ST LIM Stereo Soft-Knee-Limiter

Position, an der der erste Kanal des 
Stereo-Prozessors angeordnet werden 
kann

Position, an der der zweite Kanal des 
Stereo-Prozessors angeordnet werden 
kann
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3. Der Cursor ändert sich, um darauf hinzuweisen, dass der zweite Kanal des Prozessors positioniert 
werden muss.

4. Auf den vorgesehenen Steckplatz klicken, um den zweiten Stereokanal hinzuzufügen. 

So wird ein Stereo-Prozessor über das Menü hinzugefügt:
1. Die Taste Strg gedrückt halten und durch Klicken leere Steckplätze in zwei verschiedenen Kanälen 

wählen.
2. Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden, und beide Kanäle des Ste-

reopaars positionieren.
- ODER -
Die Option [Processor>Add] (Prozessor>Hinzufügen) in der Hauptmenüleiste verwenden.

Prozessoren ersetzen
Nur jeweils ein Prozessorblock kann einen gegebenen Steckplatz belegen. Um einen vorhandenen Proz-
essor durch einen anderen zu ersetzen, muss zuerst der vorhandene aus dem Steckplatz gelöscht und
dann der neue Prozessor mit einer der oben beschriebenen Methoden hinzugefügt werden.

Frequenzweiche, Verteiler und Subwoofer
Da es sich bei Frequenzweiche, Verteiler und Subwoofer um Ausgangsprozessoren handelt, können sie
nur in Ausgangskanalstreifen positioniert werden. Wie andere Prozessorblöcke können sie Ausgangsstre-
ifen hinzugefügt werden, dabei muss jedoch folgendes berücksichtigt werden:

• Die Frequenzweiche erstreckt sich nach unten über beide Ausgänge. Daher muss sie in Kanal 1 
platziert werden.

• Der Mischpunkt verschwindet aus dem zweiten Kanal, nachdem die Frequenzweiche darüber 
platziert wurde.

• Die Prozessor-Steckplätze verschwinden links vom Frequenzweichenblock aus dem zweiten 
Kanal.

• Der Verteiler wirkt sich auf das Signaldiagramm wie oben für die Frequenzweiche beschrieben 
aus.

Ducker
Der Ducker sollte nur auf dem Eingangskanalstreifen abgelegt werden, der das Durchsagesignal trägt. Die
Platzierung eines Duckers auf einem Ausgangsstreifen ist nicht gestattet.

Kopieren und Einfügen
Die herkömmlichen Befehle für Kopieren, Ausschneiden und Einfügen funktionieren nur bei den modularen
Prozessorblöcken. Damit bieten sie eine praktische Möglichkeit zum Duplizieren von Prozessorblöcken mit-
samt ihren Einstellungen in andere Kanäle.

So wird ein Prozessorblock kopiert und eingefügt:
1. Mit der Maus auf einen Prozessorblock zeigen und klicken, um diesen auszuwählen.
2. Den Kopierbefehl mit einer der folgenden Methoden wählen:

• Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden.
• [Edit>Copy] (Bearbeiten>Kopieren) aus dem Hauptmenü wählen.
• Strg + C auf der Tastatur betätigen.

3. Durch Zeigen und Klicken mit der Maus einen leeren Steckplatz wählen.
4. Den Einfügebefehl mit dem Hauptmenü, dem Kontextmenü oder durch Drücken von Strg + V wählen.

Hinweis: Wenn die Konfiguration eine Frequenzweiche oder einen Verteiler erfordert, sollten diese dem 
Signalflussdiagramm hinzugefügt werden, bevor Mischpunkte verbunden und andere Proz-
essoren den Ausgangskanalstreifen hinzugefügt werden.

Hinweis: Dieses Befehle funktionieren nicht bei Mehrfachwahl.
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Prozessoren aus Steckplätzen löschen
Modulare Prozessorblöcke lassen sich auf einfache Weise aus einer Konfiguration entfernen, ohne andere
Bereiche des Signalflusses zu beeinträchtigen. 

So wird ein Prozessorblock gelöscht:
1. Mit der Maus auf einen Prozessorblock zeigen und klicken, um diesen auszuwählen.
2. Den Löschbefehl mit einer der folgenden Methoden wählen:

• Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden.
• [Edit>Delete] (Bearbeiten>Löschen) aus dem Hauptmenü wählen.
• Die Taste Entf drücken.

Verknüpfungen
Mehrere Prozessorblöcke des gleichen Typs können miteinander verknüpft werden, um sie gemeinsam zu
steuern. Änderungen, die im Prozessorparameter-Fenster eines beliebigen Blocks einer Verknüpfungsgruppe
vorgenommen werden, ändern gleichzeitig die Einstellungen jedes anderen Blocks in dieser Gruppe. Es gibt
jedoch einige Aktionen, die auch in verknüpften Blöcken unabhängig funktionieren:

• Löschen, Kopieren, Ausschneiden und Einfügen
• Verschieben eines Blocks zu einem anderen Steckplatz oder Kanalstreifen
• Benennen des Prozessorparameter-Fensters

Feste Prozessoren in der gleichen Stufe der Verstärkungsstruktur lassen sich auch zu einer Gruppe zusam-
menfassen, wodurch die Pegelsteller der gruppierten Kanäle synchronisiert werden. Beispielsweise können
zwei Eingangskanal-Verstärkungsblöcke zu einer Gruppe zusammengefasst werden, um sie als Stereopaar zu
steuern. Es ist auch möglich, beide Ausgangs-Verstärkungsblöcke zu verknüpfen, um die Pegel der Ausgang-
skanäle zusammen von einem Steller zu steuern.

Eine verknüpfte Gruppe erstellen
Beim Erstellen einer Verknüpfungsgruppe werden alle Prozessoren in der Gruppe auf die gleichen Einstel-
lungen synchronisiert. Wurden vor dem Erstellen der verknüpften Gruppe bereits Einstellungen für einen
der Prozessoren spezifiziert, kann dieser Prozessor beim Verknüpfen als Quelle vorgegeben werden,
sodass diese Einstellungen auf die anderen Prozessorblöcke “vererbt” werden. Sollen dagegen frühere
Prozessor-Einstellungen wegfallen, können die Werksvoreinstellungen als anfängliche Quelle gewählt
werden. Nach dem Erstellen der Verknüpfungsgruppe wirken sich Änderungen der Einstellungen in einem
der verknüpften Blöcke auf alle anderen Blöcke der gleichen Gruppe aus.

So wird eine verknüpfte Gruppe erstellt:
1. Die Taste Strg drücken und dabei klicken, um mehrere Proz-

essorblöcke auszuwählen.
2. [Processor >Link>New Link Group] (Proz-

essor>Verknüpfen>Neue Verknüpfungsgruppe) aus dem 
Hauptmenü oder [Link>New Link Group] (Verknüpfen>Neue 
Verknüpfungsgruppe) aus dem durch Klicken mit der rechten 
Maustaste eingeblendeten Kontextmenü wählen.

3. Das Dialogfeld “Create Link Group” (Verknüpfungsgruppe 
erstellen) wird eingeblendet (siehe Abb. 3-4 rechts).

4. Einen aus zwei Zeichen bestehenden Namen für die 
Verknüpfungsgruppe eingeben.

5. Eine Quelle für die anfänglichen Einstellung der Verknüp-
fungsgruppe wählen.

6. Auf [OK] klicken, um die Einstellungen zu bestätigen.

Hinweis: Nur Prozessoren des exakt gleichen Typs können miteinander verknüpft werden.

ABBILDUNG 3-4: Dialogfeld “Create Link 
Group” (Verknüpfungsgruppe erstellen)
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Der aus zwei Zeichen bestehende Name der Verknüpfungsgruppe erscheint sowohl im Prozessorblock im
Signalflussdiagramm als auch in der Verknüpfungsanzeige unten rechts im Prozessorparameter-Fenster,
wie in der nachstehenden Tabelle dargestellt.

Zu einer Verknüpfungsgruppe hinzufügen
Prozessorblöcke können einer bestehenden Verknüpfungsgruppe hinzugefügt werden, wenn sie von
genau dem gleichen Typ und mit keiner anderen Gruppe verknüpft sind. Jeder Prozessor, der einer
Verknüpfungsgruppe hinzugefügt wird, erhält die jeweiligen Einstellungen der Gruppe.

So werden Blöcke einer bestehenden Verknüpfungsgruppe 
hinzugefügt:
1. Durch Klicken einen Prozessorblock wählen oder mit Strg + 

Klicken mehrere Blöcke wählen.
2. [Processor >Link>Add To] (Prozessor>Verknüpfen>Hinzufü-

gen) aus dem Hauptmenü oder [Link>Add To] 
(Verknüpfen>Hinzufügen) aus dem durch Klicken mit der 
rechten Maustaste eingeblendeten Kontextmenü wählen.

3. Das Dialogfeld “Add to Link group” (Zur Verknüpfungsgruppe 
hinzufügen) wird eingeblendet (siehe Abb. 3-5). Dort werden 
nur die Verknüpfungsgruppen aufgelistet, die gleiche Proz-
essoren wie der gewählte Block enthalten.

4. Eine Verknüpfungsgruppe wählen.
5. Auf [OK] klicken.

Verknüpfung von Prozessorblöcken aufheben
Prozessorblöcke können ohne Auswirkungen auf andere verknüpfte Blöcke aus einer Verknüpfungs-
gruppe entfernt werden. Es ist auch möglich, eine Verknüpfungsgruppe aufzulösen, indem die Verknüp-
fung aller Blöcke in der Gruppe aufgehoben wird. 

So werden Blöcke aus einer bestehenden Verknüpfungsgruppe entfernt:
1. Durch Klicken einen Prozessorblock wählen oder mit Strg + Klicken mehrere Blöcke wählen.
2. [Processor >Link>Unlink] (Prozessor>Verknüpfen>Verknüpfung aufheben) aus dem Hauptmenü oder 

[Link>Unlink Selected] (Verknüpfen>Verknüpfung ausgewählter Prozessorblöcke aufheben) aus dem 
durch Klicken mit der rechten Maustaste eingeblendeten Kontextmenü wählen.

Umgehen
Jeder modulare Prozessorblock kann im Hauptfenster umgangen werden. Dadurch ist es möglich, den Signal-
weg zu überprüfen, während ein Prozessor vorübergehend deaktiviert wird. Umgangene Blöcke werden im
Signalflussdiagramm durch ein gelbes Zeichen markiert (siehe Abb. 3-6).

Prozessorparameter-Fenster Signalflussdiagramm

Hinweis: Prozessoren können jeweils nur zu einer Verknüpfungs-
gruppe gehören.

Hinweis: Eine Verknüpfungsgruppe muss mindestens zwei Prozessorblöcke enthalten. Wenn alle Blöcke 
bis auf einen aus einer Verknüpfungsgruppe entfernt werden, wird die Gruppe gelöscht.

ABBILDUNG 3-5: Dialogfeld 
“Add to Link Group”

(Zur Verknüpfungsgruppe hinzufügen)
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Prozessor-Konfiguration
So wird die Umgehung ein- und ausgeschaltet:
1. Durch Klicken einen Prozessorblock wählen oder mit Strg + Klicken mehrere 

Blöcke wählen.
2. Die Umgehung mit einer der folgenden Methoden aktivieren:

• Strg + B auf der Tastatur betätigen.
• [Processor>Bypass Selected] (Prozessor>Ausgewählte umgehen) aus 

dem Hauptmenü wählen.
• [Bypass Selected] (Ausgewählte umgehen) aus dem durch Klicken mit der rechten Maustaste einge-

blendeten Kontextmenü wählen.

DSP-Ressourcen verwalten
Obwohl der DFR22 über ausreichend Verarbeitungsleistung für viele Anwendungen verfügt, ist es möglich, das
Signalflussdiagramm mit mehr Prozessorblöcken zu bestücken, als die DSP-Ressourcen (Digital Signal Pro-
cessing) des Geräts handhaben können. In diesem Abschnitt wird in allgemeiner Weise erläutert, wie der
Audioprozessor die Signalverarbeitungserfordernisse einer Konfiguration verwaltet. Außerdem enthält er
Ratschläge, wie die DSP-Ressourcen optimal ausgenutzt werden können.

Ressourcenzuweisung
Indem ein Prozessorblock auf einen Kanalstreifen gesetzt wird, werden ihm die DSP-Ressourcen zugewie-
sen, die er benötigt, um mit maximaler Kapazität zu arbeiten. Aus diesem Grund werden so viele Aus-
führungen der gleichen Prozessorblocktypen bereitgestellt, damit nur der Umfang an Verarbeitung gewählt
werden kann, der für ein gegebenes Modul benötigt wird. Beim Erstellen einer einfachen Konfiguration ist
es nicht bedeutsam, wie viel DSP-Kapazität verbraucht wird. Wenn die Konfiguration jedoch komplizierter
wird, ist es wichtig, solche Prozessorblöcke zu verwenden, die nur die minimalen Verarbeitungsressou-
rcen, die für die jeweilige Aufgabe benötigt werden, in Anspruch nehmen.

Wenn beispielsweise ein parametrischer Equalizer mit zehn Bändern auf einen Kanalstreifen gesetzt wird,
wird dadurch die Verarbeitungsleistung zugewiesen, die von allen zehn Filtern benötigt wird, auch wenn
tatsächlich nur vier davon eingesetzt werden. In diesem Fall wäre der PEQ5 die optimale Wahl.

Verzögerungsspeicher
Der DFR22 verfügt über einen Zwischenspeicher für bis zu 10 Sekunden Verzögerungszeit, die unter jeder
beliebigen Kombination von Verzögerungsprozessoren aufgeteilt werden kann. Wie bei den DSP-Ressou-
rcen wird der Verzögerungsspeicher den Prozessorblöcken gemäß der maximalen Verzögerungszeit, die
im Blocknamen angegeben ist, zugewiesen. 

Wenn zum Beispiel eine Verzögerung von 45 ms benötigt wird, ist keine 2-Sekunden-Verzögerung
erforderlich, weil die 150-ms-Verzögerung vollkommen ausreicht. Auch wenn beide Prozessoren auf den
gleichen Verzögerungswert eingestellt werden, belegt der DLY 2s-Block volle zwei Sekunden im
Verzögerungsspeicher.

DSP-Belegungsanzeigen
Diese Anzeigen in der Statuszeile unten im Hauptfenster geben an, wie viel DSP-Ressourcen und
Verzögerungsspeicher von der jeweiligen Konfiguration verbraucht wird. Mit den Informationen über die
freien DSP-Ressourcen und den freien Verzögerungsspeicher kann die Auswahl der Prozessoren effizient
erfolgen. Wenn ein Prozessorblock dem Signalflussdiagramm hinzugefügt oder daraus entfernt wird,
berechnet die DSP-Anzeige sofort die Systemressourcen, die von der neuen Prozessorkonfiguration ver-
braucht werden, und zeigt diese an.

Hinweis: Der Verzögerungsspeicher ist nicht mit den DSP-Ressourcen zu verwechseln. Jede 
Verzögerung verbraucht die gleiche DSP-Kapazität unabhängig von der Länge ihrer maximalen 
Verzögerungszeit.

ABBILDUNG 3-6: 
Umgangener Prozessorblock
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Prozessor-Konfiguration
Ratschläge zur DSP-Optimierung
Wenn beim Versuch, einen Prozessor hinzuzufügen, die in
Abb. 3-7 dargestellte Meldung angezeigt wird, muss die Konfigu-
ration optimiert werden, um DSP-Ressourcen freizugeben und
den Prozessor anschließend hinzuzufügen. Die folgenden
Ratschläge helfen bei der Optimierung der DSP-Ressourcen:

• DFR durch parametrische EQ ersetzen, nachdem Rückkop-
plungen aus dem System entfernt wurden.

Wenn beispielsweise in einer Konfiguration mehrere DFR in
mehreren Eingängen für eine bessere Verstärkungsleistung
vor dem Rückkopplungseinsatz benötigt werden, könnte
anfänglich in jedem Eingang ein DFR verwendet werden, um
Rückkopplungen zu vermeiden. Nach dem Anwenden der Fil-
ter die DFR-Filter kopieren und in einen PEQ einfügen, dann den DRF löschen. Dieser Schritt kann für
den anderen Eingang wiederholt werden; dann nur die DFR übrig lassen, die für die automatische
Erkennung von Rückkopplungen erforderlich sind, nachdem das System konfiguriert wurde. Weitere
Informationen zum Kopieren und Einfügen von Filtern von und in Prozessoren siehe Abschnitt
Kopieren und Einfügen auf Seite 71.

• Mehrere Equalizer im gleichen Signalweg nach Möglichkeit zu einem Modul zusammenfassen.

Zum Beispiel verbrauchen zwei PEQ3 mehr DSP-Ressourcen als ein PEQ7. Außerdem sind alle PEQ
auch mit Filtern mit steilflankigen und Kuhschwanz-Charakteristika verfügbar, um die DSP-Ressou-
rcen zu schonen. Wenn die zusätzlichen Flankenoptionen des CUT/SHELF-Prozessors nicht erforder-
lich sind, müssen Filter mit steilflankiger und Kuhschwanz-Charakteristik nicht in einem separaten
Modul im gleichen Signalweg eingefügt werden.

• Mehrere Verzögerungen im gleichen Signalweg nach Möglichkeit zu einem Modul zusammenfassen. 
Durch Verwendung von zwei DLY5ms-Blöcken zur Erzielung einer Verzögerung von 7 ms werden 
doppelt so viele DSP-Ressourcen verbraucht wie mit einem einzelnen DLY150ms-Block, doch mit der 
ersten Option wird Verzögerungsspeicher eingespart.

• Prozessoren von nicht benutzten Kanälen entfernen.
• Den Verteiler benutzen, um identische Signalverarbeitung in mehreren Ausgangskanälen zusammen-

zufassen.
• Einen PEQ10 anstelle eines GEQ30 benutzen. In den meisten Fällen werden nicht alle dreißig Filter 

des GEQ30 verwendet, und der PEQ10 verbraucht weniger als die halbe DSP-Kapazität.

ABBILDUNG 3-7: DSP-Ressourcen 
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Voreinstellungs-Presets
Voreinstellungs-Presets

Zur einfachen Einrichtung grundlegender Konfigurationen ist der DFR22 werkseitig mit drei voreingestellten Presets 
geladen. Diese Voreinstellungen werden auch im Untermenü [File>New] (Datei>Neu) aufgeführt, sodass diese als Vor-
lage für die Erstellung einer neuen Voreinstellung verwendet werden können.

Preset 1 – [Dual Mono]
Bei dieser Konfiguration wird Eingang 1 zu Ausgang 1 und Eingang 2 zu Ausgang 2 geführt. Jeder Einga-
ngsstreifen ist mit folgenden Prozessoren bestückt:

• DFR16 - den Bedienelementen auf der Frontplatte zugewiesen
• PEQ10+CS
• GEQ30
• LIM

Außerdem verfügt jeder Ausgangsstreifen über eine 2-Sekunden-Verzögerung, die als Voreinstellung auf 0 ms
eingestellt ist. 

Preset 2 – [Stereo]
Bei dieser Konfiguration wird Eingang 1 zu Ausgang 1 und Eingang 2 zu Ausgang 2 geführt. Die Ein- und Aus-
gangskanäle sind miteinander verknüpft, sodass die Verstärkung beider Kanäle simultan sowohl auf der Einga-
ngs- als auch auf der Ausgangsstufe der Verstärkungsstruktur gesteuert werden kann.

Die Eingangsstreifen sind mit folgenden Prozessoren bestückt:

• Stereo DFR16 - den Bedienelementen auf der Frontplatte zugewiesen
• PEQ10+CS, miteinander verknüpft
• GEQ30, miteinander verknüpft
• Stereo-Limiter

Außerdem verfügt jeder Ausgangsstreifen über verknüpfte 2-Sekunden-Verzögerungen, die als Voreinstellung
auf 0 ms eingestellt sind.

Preset 3 – [Dual Mono Split]
Bei dieser Konfiguration sind Eingang 1 und Eingang 2 zu Ausgang 1 und Ausgang 2 geführt. Der Einga-
ngsstreifen ist mit folgenden Prozessoren bestückt:

• DFR16 - den Bedienelementen auf der Frontplatte zugewiesen
• PEQ10+CS
• GEQ30
• LIM

Außerdem verfügt jeder Ausgangsstreifen über eine 2-Sekunden-Verzögerung, die als Voreinstellung auf 0 ms
eingestellt ist.

Hinweis: Es empfiehlt sich, die Voreinstellung-Auswahl an der Frontplatte zu sperren oder nicht ver-
wendete Voreinstellungs-Presets im Gerät zu löschen, damit Endbenutzer nicht verse-
hentlich auf diese zugreifen.
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ABSCHNITT 4 Voreinstellung- und Geräteverwaltung
Nach der Erstellung einer Voreinstellung im Design-Modus kann diese entweder im Computer oder im Gerät gespe-
ichert werden, je nachdem ob der DFR22 angeschlossen ist oder nicht. Im DFR22 ist immer nur eine einzige Vorein-
stellung aktiv. Dabei handelt es sich um die aktuelle Voreinstellung. Im Live-Modus ist die derzeit angezeigte bzw.
bearbeitete Voreinstellung die aktuelle Voreinstellung. Sie kann jederzeit durch Klicken auf die Schaltfläche [Save As]
(Speichern unter) in der Steuerleiste des Hauptfensters im PC gespeichert werden.

Voreinstellung-Dateien

Mit der DFR22 Software kann eine ganze Bibliothek von Voreinstellungen erstellt werden, ohne dass das Gerät ange-
schlossen ist. Auf dem PC gespeicherte Voreinstellungen können später abgerufen, überarbeitet und dann an das 
Gerät gesendet werden. Voreinstellungen werden mit der Dateinamenerweiterung “.d22” gespeichert.

Speichern einer neuen Voreinstellung im Computer
Wenn das Gerät nicht angeschlossen ist, wird jede neue Voreinstellung im Computer gespeichert.

So wird eine neue Voreinstellung im Computer gespeichert:
1. Im Hauptfenster [File>Save As] (Datei>Speichern unter) im Hauptmenü wählen oder auf die Schaltfläche 

[Save As] (Speichern unter) in der Steuerleiste klicken.
2. Das Dialogfeld “Save As” (Speichern unter) wird eingeblendet.
3. Zum Laufwerk und Verzeichnis für die neue Datei gehen.
4. Einen Dateinamen und auf Wunsch eine Beschreibung eingeben.
5. Auf [Save] (Speichern) klicken.

Voreinstellung-Dateien überarbeiten
Wenn in einer bestehenden Voreinstellung Änderungen vorgenommen werden, können diese unter einem
anderen Dateinamen oder durch Überschreiben der vorherigen Version im PC gespeichert werden.

So wird eine im Computer gespeicherte Voreinstellung überarbeitet:
1. Im Hauptfenster [File>Open File] (Datei>Datei öffnen) im Hauptmenü wählen oder auf die Schaltfläche 

[Open] (Öffnen) in der Steuerleiste klicken.
2. Das Dialogfeld “Open” (Öffnen) wird eingeblendet.
3. Zum Laufwerk und Verzeichnis der Voreinstellung-Datei gehen, die geöffnet werden soll.
4. Auf die Datei klicken, um sie zu wählen, und dann auf die Schaltfläche [Open] klicken.
5. Die gewünschten Änderungen vornehmen.
6. [File>Save As] im Hauptmenü wählen oder auf die Schaltfläche [Save As] in der Steuerleiste klicken.
7. Das Dialogfeld “Save As” (Speichern unter) wird eingeblendet.
8. Auf den ursprünglichen Dateinamen klicken, um ihn zu wählen, und dann auf [Save] (Speichern) klicken.
9. Ein eingeblendetes Dialogfeld fordert zur Bestätigung auf, dass die vorherige Voreinstellung-Datei über-

schrieben werden soll.
10. Auf [Yes] (Ja) klicken, um die Datei zu überschreiben.

Hinweis: Die ersten 15 Zeichen des Dateinamen und die ersten 80 Zeichen der Beschrei-
bung werden im Informationsfeld in der Steuerleiste angezeigt.
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Geräte-Voreinstellungen
Geräte-Voreinstellungen

Der DFR22 kann 16 Voreinstellungen im Gerätespeicher speichern. Im Gerät gespeicherte Voreinstellungen können 
umbenannt, gelöscht oder zusammen gesichert werden.

Eine Voreinstellung im Gerät speichern
Wenn der Anschluss zum Gerät besteht, können im Design-Modus neue Voreinstellungen im Gerät gespe-
ichert oder vorhandene Voreinstellung-Dateien geöffnet und im Gerät gespeichert werden.

So wird eine Voreinstellung im Gerät gespeichert:
1. Im Hauptfenster [File>Store As Preset] (Datei>Als Vorein-

stellung speichern) im Hauptmenü wählen oder auf die 
Schaltfläche [Store Preset] (Voreinstellung speichern) in 
der Steuerleiste klicken.

2. Wenn das Dialogfeld “Select Devices” (siehe Abb. 4-1) 
angezeigt wird, ein Gerät aus der Liste wählen und auf 
[Connect] (Verbinden) klicken.

3. Das Dialogfeld “Store Preset” (Voreinstellung speichern) 
wird eingeblendet (siehe Abb. 4-2).

4. Einen Voreinstellung-Namen mit bis zu fünfzehn Zeichen 
eingeben.

5. Eine Voreinstellung-Nummer eingeben oder die Vorein-
stellung verwenden.

6. Eine Beschreibung eingeben, falls gewünscht, um den Inhalt der Voreinstellung bei anschließenden Ein-
stellungen besser identifizieren zu können.

7. Auf [Store] (Speichern) klicken.

ABBILDUNG 4-1: Dialogfeld “Select 
Devices” (Geräte wählen)

ABBILDUNG 4-2: Dialogfeld “Store Preset”
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Geräte-Voreinstellungen
Eine Voreinstellung umbenennen
Nachdem eine Voreinstellung im Gerät gespeichert wurde, können ihr Name und ihre Beschreibung im Live-
Modus geändert werden. Im Design-Modus kann auch der Name einer im PC gespeicherten Voreinstellung
geändert werden.

So wird eine im Gerät gespeicherte Voreinstellung umbenannt:
1. Auf die Schaltfläche [Live Mode] in der Steuerleiste klicken.
2. Die Voreinstellung, die umbenannt werden soll, aus dem Pulldown-Menü 

im Informationsfeld in der Steuerleiste wählen.
3. Das Hauptfenster schaltet in den Vorschau-Modus für die gewählte 

Voreinstellung.
4. Auf die Schaltfläche [Load] (Laden) in der Steuerleiste klicken, um die 

Voreinstellung zu öffnen.
5. Einmal irgendwo im Informationsfeld klicken.
6. Das Dialogfeld “Preset Information” wird eingeblendet (siehe Abb. 4-3).
7. Den neuen Namen und/oder die neue Beschreibung eingeben.
8. Auf [OK] klicken.

So wird eine im PC gespeicherte Voreinstellung umbenannt:
1. In den Design-Modus schalten.
2. Die Voreinstellung-Datei öffnen.
3. Einmal irgendwo im Informationsfeld klicken.
4. Das Dialogfeld “Preset Information” wird eingeblendet (siehe oben).
5. Den neuen Namen und/oder die neue Beschreibung eingeben.
6. Auf [OK] klicken.
7. Die Voreinstellung erneut im PC speichern.

Eine Voreinstellung löschen
Die jeweils geöffnete Voreinstellung kann nicht
gelöscht werden. Um diese Voreinstellung zu
löschen, muss vorher eine andere Voreinstellung
geöffnet werden.

So wird eine Voreinstellung gelöscht:
1. Auf die Schaltfläche [Design Mode] in der 

Steuerleiste klicken.
2. [File>Delete Preset] (Datei>Voreinstellung 

löschen) wählen.
3. Wenn das Dialogfeld “Select Devices” (Geräte 

wählen) angezeigt wird, ein Gerät aus der Liste 
wählen und auf [Connect] (Verbinden) klicken.

4. Das Dialogfeld “Select Preset to delete” wird 
eingeblendet (siehe Abb. 4-4).

5. Die Voreinstellung wählen, die gelöscht werden 
soll, oder mit Umschalttaste +Klicken mehrere 
Voreinstellungen wählen.

6. Auf [Delete] (Löschen) klicken.

ABBILDUNG 4-3: Dialogfeld 
“Preset Information” 

(Voreinstellung-Informationen)

ABBILDUNG 4-4: Dialogfeld “Select Preset to delete” 
(Zu löschende Voreinstellung wählen)
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Datensicherung
Datensicherung

Alle im Gerät gespeicherten Voreinstellungen und Einstellungen können in einer einzelnen Archivierungsdatei 
gesichert und später wiederhergestellt werden. Wiederherstellung ist nur im Design-Modus möglich.

So werden alle Voreinstellungen im Gerät gesichert:
1. Den Befehl [File>Backup Device] (Datei>Geräte-Daten-

sicherung) aus dem Hauptmenü wählen.

2. Wenn das Dialogfeld “Select Devices” angezeigt wird, 
ein Gerät aus der Liste wählen und auf [Connect] 
klicken.

3. Das Dialogfeld “Save As Backup” (Als Datensicherung 
speichern ) wird eingeblendet (siehe Abb. 4-5 rechts).

4. Auf [Backup Entire Device] (Gesamtes Gerät sichern) 
klicken.

5. Das Dialogfeld “Save Backup As” wird eingeblendet 
(siehe Abb. 4-6 unten rechts).

6. Zum gewünschten Verzeichnis gehen und einen Datein-
amen eingeben.

7. Auf [Save] (Speichern) klicken.

So werden bestimmte Voreinstellungen gesichert:
1. Die obigen Schritte 1 bis 3 ausführen.

2. Durch Klicken eine Voreinstellung aus der Liste wählen. 
Bei gedrückter Umschalttaste bzw. bei gedrückter 
Taste Strg klicken, um mehrere Voreinstellungen aus-
zuwählen.

3. Auf die Schaltfläche [Backup Selected Presets] (Aus-
gewählte Voreinstellungen sichern) klicken.

4. Das Dialogfeld “Save As” (Speichern unter) wird einge-
blendet.

5. Zum gewünschten Verzeichnis gehen, einen Dateina-
men eingeben und auf [Save] (Speichern) klicken.

6. Schritte 4 und 5 für jede Voreinstellung ausführen, die 
zur Sicherung ausgewählt wurde.

So werden gesicherte Daten im Gerät wiederhergestellt:

1. Auf die Schaltfläche [Design Mode] in der Steuerleiste 
klicken.

2. Den Befehl [File>Restore Device] (Datei>Gerät wieder-
herstellen) aus dem Hauptmenü wählen.

3. Das Dialogfeld “Open Backup” (Datensicherung öffnen) 
ähnlich dem Dialogfeld “Save Backup As” wird einge-
blendet (siehe Abb. 4-6).

4. Zum entsprechenden Verzeichnis gehen und die rich-
tige Sicherungsdatei aus der Liste wählen.

5. Auf [Open] (Öffnen) klicken.

6. Wenn das Dialogfeld “Select Devices” angezeigt wird, ein Gerät aus der Liste wählen und auf [Connect] klicken.

7. Die gesicherten Daten werden zum Gerät übertragen.

ABBILDUNG 4-5: Dialogfeld “Save As Backup” 
(Als Datensicherung speichern)

ABBILDUNG 4-6: Dialogfeld “Save Backup As” 
(Datensicherung speichern unter)
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Menü Device (Gerät)
Menü Device (Gerät)

Shure Link Application List (Liste der Shure Link-Anwendungen)
Hier wird die gesamte auf dem Computer installierte Shure Link-Software aufgeführt. Um zu einer anderen
Anwendung zu wechseln, diese einfach aus dem Menü wählen. Die entsprechende Anwendung wird im
Design-Modus gestartet.

Global Preset Mode (Globaler Voreinstellung-Modus)
Wenn der globale Voreinstellung-Modus auf allen Shure Link-Geräten im Netzwerk aktiviert ist, führt eine Vor-
einstellung-Änderung auf einem Gerät dazu, dass die Voreinstellungen auf allen Geräten geändert werden.
Neben dieser Menüoption wird ein Häkchen gesetzt, wenn sie für den DFR22 aktiviert wurde.

Control Pin Configuration (Steuerpin-Konfiguration)
Mit dieser Menüoption können die Steuerpins zur Steuerung externer Hardwaregeräte konfiguriert werden. Mit
ihr wird das Fenster “Control Pins” (Steuerpins) eingeblendet. Dieses wird detailliert im Kapitel erläutert, das
auf Seite 88 beginnt.

Select COM Port (COM-Anschluss wählen)
Mit dieser Menüoption wird der COM-Anschluss angegeben, an dem der
DFR22 bzw. das Shure Link-Netzwerk angeschlossen ist. Mit ihr wird das
Dialogfeld “COM Port” (COM-Anschluss wählen) eingeblendet, in dem alle
COM-Anschlüsse des Computers aufgeführt werden.

So wird der COM-Anschluss gewählt:
1. Den Befehl [Devices>Select COM Port] (Geräte>COM-Anschluss 

wählen) aus dem Hauptmenü wählen.
2. Das Dialogfeld “COM Port” wird geöffnet (siehe Abb. 4-7).
3. Den COM-Anschluss wählen, an den das RS-232-Kabel angeschlossen 

ist, und auf [OK] klicken.

Name Device (Gerät benennen)
Mit dieser Menüoption kann der DFR22 mit einem eindeutigen Namen
versehen werden, damit dieser in der Geräteliste näher beschrieben wird.

So wird das Gerät benannt:
1. Den Befehl [Devices>Name Device] (Geräte>Gerät benennen) aus dem 

Hauptmenü wählen.
2. Das Dialogfeld “Name Device” wird geöffnet (siehe Abb. 4-8).
3. Einen aus bis zu fünfzehn Zeichen bestehenden Gerätenamen einge-

ben und auf [Name] (Benennen) klicken.
4. Der Gerätename erscheint im Live-Modus in der Titelleiste des Hauptfensters und wird im Menü [Devices] 

(Geräte) aufgelistet.

Device List (Geräteliste)
Im Live-Modus werden auf dieser Liste alle Shure Link-Geräte angeführt, die am Netzwerk angeschlossen
sind. Ein Gerät wählen, um direkt auf dieses zuzugreifen und die entsprechende Steuersoftware im Live-
Modus zu starten.

ABBILDUNG 4-7: Dialogfeld “COM 
Port” (COM-Anschluss)

ABBILDUNG 4-8: Dialogfeld “Name 
Device” (Gerät benennen)
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ABSCHNITT 5 Prozessor-Funktionen
In diesem Abschnitt werden Softwarefunktionen beschrieben, die in vielen der Prozessorparameter-Fenster enthalten sind.
Funktionen einzelner Prozessoren siehe Abschnitt Feste Prozessoren auf Seite 41 und Abschnitt Modulare
Prozessoren auf Seite 47.

Fader

Fader sind in vielen Prozessor-Fenstern enthalten (siehe Beispiel in Abb. 5-1 unten rechts). Fader gestatten die Ver-
stärkungseinstellung durch eine Auf- oder Abwärtsbewegung der Maus in der gleichen Weise, wie Fader an einem 
wirklichen Mischer betätigt werden. Es ist auch möglich, den Pegel nummerisch anzugeben, indem ein Wert in das 
Feld eingegeben wird. Zuerst den Fader wählen und dann den Pegel mit einer der nachstehend beschriebenen Meth-
oden einstellen.

Wählen
Ein Fader wird gewählt, indem der Mauscursor über den Faderknopf gebracht und darauf mit der linken
Maustaste geklickt oder indem im Wertefeld unter dem Faderstreifen geklickt wird. Der Faderknopf wird mark-
iert, um darauf hinzuweisen, dass er gewählt wurde. Wenn das Fenster mehrere Fader enthält, kann mit der
Taste Tab von links nach rechts und mit Umschalttaste + Tab in entgegengesetzter Richtung zwischen ihnen
gewechselt werden.

Pegel einstellen

So wird der Pegel mit der Maus eingestellt:

• Auf den Faderknopf klicken und die Maustaste gedrückt 
halten, um ihn nach oben oder unten zu ziehen.

• Auf den Faderstreifen an dem Pegel klicken, der eingestellt 
werden soll.

• Mit der rechten Maustaste auf den Faderknopf klicken, um 
den Pegel auf 0 dB einzustellen.

So wird der Pegel mit einzelnen Tasten eingestellt:
1. Den Fader wählen, der eingestellt werden soll.
2. Den Wert mit einer der folgenden Tasten einstellen.

Wertefeld
Im Wertefeld kann der Wert auf Zehntel Dezibel angegeben werden. Zu allen Fadern gehört ein Wertefeld.
In den meisten Prozessor-Fenstern sind die Wertefelder direkt unter den Fadern angeordnet. Die beiden
Ausnahmen sind die GEQ10- und GEQ30-Fenster, die nur ein Verstärkungswert-Feld für die gesamte
Fadergruppe aufweisen. In diesen Fenstern zuerst den Knopf wählen, der eingestellt werden soll, und
dann einen Wert in das Feld eingeben.

Faderknopf gewählt

Faderknopf nicht gewählt

Taste Ergebnis
Nach-Oben-Taste Erhöhung um 0,5 dB

Nach-Unten-Taste Absenkung um 0,5 dB

Bild-Auf-Taste Erhöhung um 3 dB

Bild-Ab-Taste Absenkung um 3 dB

Leertaste Stellt die Verstärkung auf 0 dB ein

1

2

3

4

1. Faderstreifen
2. Faderknopf
3. Wertefeld
4. Drehpfeil-

Schaltflächen

ABBILDUNG 5-1: Standard-Steuerelemente
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Einstellungen speichern und abrufen
Drehpfeil-Schaltflächen
Neben allen Wertefeldern befinden sich Drehpfeil-Schaltflächen. Damit lassen sich die Einstellungen auf
einfache Weise ändern, ohne dass ein Wert eingegeben werden muss.

So wird der Wert mit den Drehpfeil-Schaltflächen verändert:

• Auf die Aufwärts- oder Abwärts-Drehpfeil-Schaltfläche klicken, um den Pegel um +/-0,5 dB zu ändern.
• Auf eine Drehpfeil-Schaltfläche klicken und die Maustaste gedrückt halten, um den Pegel kontinuierlich 

zu erhöhen bzw. zu verringern. Wird die Schaltfläche länger gehalten, erhöht sich die Geschwindigkeit 
der Änderung.

Einstellungen speichern und abrufen
Die Einstellungen in jedem Prozessorparameter-Fenster können in einer Computerdatei gespeichert und wieder 
abgerufen werden, wenn irgendwann später eine ähnliche Einstellung für den gleichen Prozessortyp benötigt wird. In 
dieser Weise lassen sich benutzerdefinierte oder installationsspezifische Voreinstellungen für häufig verwendete Proz-
essoren erstellen. Wenn viele Einstellungen im PC gespeichert werden sollen, wird empfohlen, ein Verzeichnis auss-
chließlich für Prozessor-Einstellungen oder für eine bestimmte Installation einzurichten.

So werden Prozessor-Einstellungen gespeichert:
1. Auf einen Prozessorblock doppelklicken, um sein Prozessorparameter-Fenster einzublenden.
2. [File>Save Settings] (Datei>Einstellungen speichern) aus dem Menü wählen oder Strg + S auf der Tasta-

tur drücken.
3. Zum gewünschten Verzeichnis gehen und einen Dateinamen eingeben.
4. Auf [Save] (Speichern) klicken.
5. Die Anwendung fügt eine Dateinamenerweiterung entsprechend dem erstellenden Prozessortyp hinzu. Für 

eine vollständige Liste der Dateinamenerweiterungen für Prozessor-Einstellungen siehe Anhang C: 
Dateinamenerweiterungen.

So werden die Prozessor-Einstellungen abgerufen:
1. Auf einen Prozessorblock doppelklicken, um sein Prozessorparameter-Fenster einzublenden.
2. [File>Recall Settings] (Datei>Einstellungen abrufen) aus dem Menü wählen oder Strg + R auf der Tastatur 

drücken.
3. Zum entsprechenden Verzeichnis gehen und die Einstellungsdatei wählen.
4. Auf [Open] (Öffnen) klicken.

Prozessorfenster benennen
Das Parameterfenster jedes modularen Prozessorblocks im Signalflussdiagramm kann mit einem eindeutigen Namen 
versehen werden. Dies ist praktisch, wenn mehrere Fenster gleichzeitig geöffnet sind. Die Standardtitel von Prozessor-
fenstern enthalten den Namen des allgemeinen Prozessortyps, die Kennzeichnung des Kanalstreifens, auf den sie 
gesetzt wurden, die Nummer des Steckplatzes und den Status der Sicherheitssperre.

Um zwischen ähnlichen Prozessoren unterscheiden zu können, kann der Fenstername gemäß den besonderen Funk-
tionen oder Einstellungen des Prozessors angepasst werden. Der neue Fenstername erscheint sowohl in der Titel-
leiste des Prozessorparameter-Fensters als auch in der Windows-Taskleiste, wenn das Parameterfenster minimiert ist.

So wird ein Prozessorparameter-Fenster umbenannt:
1. Auf einen Block doppelklicken, um sein Prozessorparameter-Fenster einzublenden.
2. Die Menüoption [Options>Name] (Optionen>Name) aus dem Menü wählen.
3. Den neuen Namen mit bis zu fünfzehn Zeichen eingeben.
4. Auf [OK] klicken.

Hinweis: Einstellungen können nur für einen Prozessor vom gleichen Typ wie der, von dem die 
Einstellungsdatei erstellt wurde, abgerufen werden.

Hinweis: Hierdurch wird nur der Name des Prozessorparameter-Fensters geändert. Der Titel des 
Prozessorblocks im Signalflussdiagramm ändert sich nicht.
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Momentaufnahmen

Die Funktion Momentaufnahme ist in jedem Prozessorparameter-Fenster verfügbar, das eine Frequenzgang-Kennlinie 
oder Übertragungs-Kennlinie enthält. Damit kann ein Bild der aktuellen Kennlinie erfasst und zur Bezugnahme bei der 
Überarbeitung der Prozessor-Einstellungen angezeigt werden. Der Prozessor behält diese Momentaufnahme, bis eine 
neue im gleichen Prozessor-Fenster gemacht oder die Anwendung beendet wird.

Die nachstehenden Beispiele von Frequenzgang-Kennlinien stammen aus dem Parameterfenster eines parame-
trischen Equalizers mit fünf Bändern und Filtern mit steilflankiger und Kuhschwanz-Charakteristik (PEQ5+CS).

So wird die Momentaufnahme-Funktion verwendet:
1. Auf die Schaltfläche [TAKE] (Aufnehmen) klicken (siehe 

Abb. 5-2). Dadurch wird die Frequenzgang-Kennlinie 
oder Übertragungs-Kennlinie aufgenommen.

2. Auf die Schaltfläche [SHOW] (Anzeigen) 
klicken. Dadurch wird die Momen-
taufnahme hinter der aktuellen Kennlinie 
angezeigt. Die Schaltfläche wird grün 
markiert, wenn die Momentaufnahme 
angezeigt wird.

3. Die Prozessor-Einstellungen ändern. 
Während die Kennlinie verändert wird, kann 
sie mit der Momentaufnahme der vorherigen 
Kennlinie, die im Hintergrund angezeigt 
wird, verglichen werden (siehe Abb. 5-3).

4. Erneut auf die Schaltfläche [SHOW] klicken, um die 
Momentaufnahme aus- und einzublenden (siehe 
Abb. 5-4 rechts).

Hinweis: Wenn die Momentaufnahme angezeigt 
wird, bevor Prozessor-Einstellungen 
geändert wurden, ist sie hinter der aktu-
ellen Kennlinie versteckt. Die Momen-
taufnahme wird sichtbar, sobald die 
Kennlinie durch andere Einstellungen 
verändert wird.

ABBILDUNG 5-2: Erstellen einer Momentaufnahme

ABBILDUNG 5-3: Ändern der Frequenzgang-Kennlinie

ABBILDUNG 5-4: Ausblenden der Momentaufnahme
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Importieren von ASCII-Dateien

Prozessorfenster für Equalizer und das Fenster mit der kombinierten Frequenzgang-Kennlinie können zur Anzeige von 
Daten verwendet werden, die in einer ASCII-Datei enthalten sind (siehe folgende Abbildung eines Fensters mit 
“PEQ10+CS”).

Die ASCII-Dateiimportfunktion kann zur Anzeige von Frequenz/Amplituden-Informationen, die in Smaart oder TEF 
gemessen werden, verwendet werden. Durch Umkehrung der Daten kann die Anzeige als visuelle Hilfe bei der Einstel-
lung der Equalizer-Parameter verwendet werden. Die Anzeige stellt nur die Amplitudenwerte für Frequenzen, die in der 
Datei enthalten sind, dar; sie interpoliert keine Linie zwischen tatsächlich gemessenen Punkten. Folglich kann Leer-
raum in der Anzeige auftreten, insbesondere bei niedrigen Frequenzen.

Die ASCII-Importfunktion ist kompatibel mit Dateien der folgenden Formate:

• Übertragungsfunktionsmessungen in SIA-Smaart® Pro (Versionen 2/x und 3.x) und SIA SmaartLive™.
• TDS-Messungen in allen Versionen von TEF™ TDS-Software für Windows und DOS sowie EFC-Messun-

gen in der Software TEF SLX.

Speichern von Dateien im ASCII-Format

Smaart-Dateien
Zum Exportieren einer Messung mit Hilfe der Smaart-Software wird im Übertragungsfunktions-Modus
gemessen. Aus dem Menü der Smaart-Anwendung [File>ASCII Save] (Datei>ASCII speichern) wählen. 

ABBILDUNG 5-5: ASCII-Dateiimport
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TEF-Dateien
So wird eine Messung mit TEF TDS-Software exportiert:
1. Aus dem Menü der TEF TDS-Anwendung [File>Save] (Datei>speichern) wählen. 
2. Die Dateiinformationen eingeben und auf [Save] (Speichern) klicken.
3. Im Fenster “Save TDS File” (TDS-Datei speichern) “ASCII” als Dateityp wählen.

Bedienelemente und Eigenschaften für den Import

Import
Auf diese Schaltfläche klicken, um ASCII-Dateien entweder aus Smaart oder TEF zu impor-
tieren. Wenn das Fenster “Open File” (Datei öffnen) erscheint, die zu importierende Datei

wählen. Die Daten aus der importierten Datei werden im Frequenzgang-Diagramm angezeigt. Wird eine
TEF TDS- oder eine EFC-Datei importiert, so wird die Durchschnittsamplitude bei 0 dB geplottet und alle
anderen Amplitudenwerte sind entsprechend vorgespannt. Als Voreinstellung sind Smaart-Übertragungs-
funktionsdateien nicht versetzt. Die Amplituden werden um die 0-dB-Achse zentriert, ebenso wie in
Smaart.

Refresh (Aktualisieren)
Auf diese Schaltfläche klicken, um die zuletzt importierte Datei nochmals zu importieren. Wenn
eine neue Messung in Smaart oder TEF gemacht und mit demselben Dateinamen gespeichert

wird, wodurch die vorherige Datei überschrieben wird, auf die Schaltfläche [REFRESH] (Aktualisieren)
klicken, um die neue Messung zu importieren, ohne den Dialog [Open File] (Datei öffnen) aufrufen zu müs-
sen. 

Show (Anzeigen)
Auf diese Schaltfläche klicken, um die importierte Datei anzuzeigen oder zu verbergen. Die
Schaltfläche [SHOW] ist grün, wenn eine Datei angezeigt wird.

Offset
Hierdurch wird der Offset angegeben, um den die Anzeige von den in der ASCII-Datei enthalt-
enen tatsächlichen Amplitudenwerten versetzt ist. Als Voreinstellung wird eine TEF TDS- oder
EFC-Messung um ihre Durchschnittsamplitude versetzt, damit sie um die 0-dB-Achse im Fre-

quenzgang-Diagramm zentriert ist.

Invert (Umkehren)
Auf dieses Kästchen klicken, um die angezeigten Daten um die X-Achse umzukehren. Die
umgekehrte Anzeige kann dann als visuelle Hilfe für die Equalizer-Parameter verwenden wer-

den. [INVERT] ist als Voreinstellung gewählt.

Help (Hilfe)
Auf diese Schaltfläche klicken, um auf die Online-Hilfe für das Importieren von Smaart- und TEF
ASCII-Dateien zuzugreifen.

Hinweis: Die Schaltfläche [REFRESH] ändert die Vorspannung der ursprünglichen Datei NICHT. Wenn sich 
die Durchschnittsamplitude einer TEF TDS- oder einer EFC-Datei ändert, ist die aktualisierte 
Datei immer noch um den ursprünglichen Durchschnittswert vorgespannt. Außerdem wird kein 
Offset, der der Datei mit Hilfe des Textfelds [OFFSET] hinzugefügt wird, geändert, wenn auf 
[REFRESH] geklickt wird.
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Kombiniertes Frequenzgangdiagramm

In diesem Fenster werden die Frequenzgangkennlinien der Prozessoren im gewählten Signalweg zusammengefasst, 
um die gleichmäßige Entzerrung des Raums zu unterstützen. Mit der Menüoption [View>Combined Response Graph] 
(Ansicht> Kombiniertes Frequenzgangdiagramm) aus dem Hauptmenü auf dieses Fenster zugreifen.

Funktionen des Fensters

1) Auswahl der Eingangsstreifen
Hier werden die Eingangsstreifen aufgeführt. Die Bezeichnungen entsprechen denen des Signalflussdia-
gramms. Den Streifen wählen, für den der kombinierte Frequenzgang angezeigt werden soll.

2) Auswahl der Ausgangsstreifen
Hier werden die Ausgangsstreifen aufgeführt. Die Bezeichnungen entsprechen denen des Signalflussdia-
gramms. Wenn ein Eingangsstreifen und ein Ausgangsstreifen gewählt wird, wird der kombinierte Fre-
quenzgang des entsprechenden Signalwegs angezeigt.

3) Prozessor-Auswahl
Als Voreinstellung werden die Frequenzgänge von Equalizern, DFR und Frequenzweichen im Frequen-
zgangdiagramm zusammengefasst. Zu den Equalizern gehören PEQ, GEQ und CUT/SHELF-Proz-
essoren. Zu den Frequenzweichen gehören die 2-Wege-Frequenzweiche und der Subwoofer-Prozessor.
Zu den DFR gehören alle Mono- und Stereo-DFR-Prozessoren.

4) Snapshot (Momentaufnahme)
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-Kennlinie, indem auf
die Schaltfläche [TAKE] (Aufnehmen) geklickt wird. Durch Klicken auf die Schaltfläche [SHOW] (Anzeigen)
wird die Aufnahme dann im Hintergrund für Vergleichszwecke angezeigt. Die Schaltfläche [SHOW] wird

1 2 3

4

5

67

ABBILDUNG 5-6: Fenster “Combined Response Graph” (Kombiniertes Frequenzgangdiagramm)
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Kombiniertes Frequenzgangdiagramm
grün markiert, wenn die Momentaufnahme angezeigt wird. Ausführliche Beschreibungen der Momen-
taufnahme-Funktion siehe Abschnitt Momentaufnahmen auf Seite 36.

5) ASCII-Dateiimport
Diese Funktion ermöglicht das Importieren von Frequenzdaten aus SIA Smaart und Gold Line TEF in das
Frequenzgangdiagramm. Die grafischen Daten im Diagramm können bei der Gestaltung der Frequen-
zgang-Kennlinie jedes der Prozessoren im Signalweg als Referenz verwendet werden. Anweisungen zur
Verwendung der ASCII-Importfunktion siehe Seite 37.

6) Frequenzgangdiagramm
Diese Anzeige wird aktualisiert, wenn Änderungen an den Prozessoreinstellungen und Prozessorposi-
tionen im angegebenen Signalweg vorgenommen werden.

7) Angabe der Polarität
Die angezeigte Polarität bezieht sich auf die Gesamtsumme des Signalwegs. Wenn ein Eingang gewählt
wurde, wird hier die Einstellung im Eingangsverstärkungsblock übernommen. Wenn ein Ausgang gewählt
wurde, zeigt die Anzeige Einstellungen des Matrixmischerblocks, etwaiger Frequenzweichen oder Sub-
woofer-Prozessoren und des Ausgangsverstärkungsblocks an. Wenn ein Eingang und ein Ausgang
gewählt wurde, werden alle Polaritätseinstellungen im Pfad berücksichtigt.
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ABSCHNITT 6 Feste Prozessoren
Diese Prozessoren bilden die drei verschiedenen Stufen der Verstärkungsstruktur des DFR22 (weitere Informationen
zu diesem Thema siehe Seite 17). Sie werden als feste Prozessoren bezeichnet, weil die Verstärkungs- und Misch-
blöcke im Signalflussdiagramm nicht verschoben oder gelöscht werden können.

Eingangsverstärkung

Das Fenster “Input Gain” (Eingangsverstärkung) enthält einzelne Steller für beide Eingangskanäle. Auf den Ver-
stärkungsblock links von einem der beiden Eingangskanalstreifen doppelklicken, um dieses Fenster zu öffnen (siehe 
Abb. 6-1).

1) Skalierung
Diese Schaltflächen dienen zum Skalieren der einzelnen Eingangskanäle zur Anpassung an den Aus-
gangspegel des Geräts vor dem Audioprozessor. Durch Klicken kann zwischen -10 dBV und +4 dBu
gewechselt werden. Die Voreinstellung ist +4 dBu.

+4 dBu gewählt

–10dBV gewählt

1

2

3

4

5

6

ABBILDUNG 6-1: Fenster “Input Gain” 
(Eingangsverstärkung)
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Eingangsverstärkung
2) Signalpolarität
Auf diese Schaltfläche klicken, um die Polarität des Signals, das am Eingangskanalstreifen eintritt,
umzukehren. Die Voreinstellung ist normale Polarität.

3) Pegelsteller
Mit diesen Stellern wird der Signalpegel für jeden Eingangskanal eingestellt. Zuerst den Faderknopf
wählen, dann den Pegel mit der Maus, den Pfeiltasten oder durch Eingabe eines Werts in das Wertefeld
einstellen. Umfassende Anweisungen zur Bedienung siehe Abschnitt Fader auf Seite 34. Der Einstellbere-
ich reicht von +10 dB bis –unendlich dB, und die Voreinstellung ist 0 dB oder Arbeitspegel.

4) Kanalstummschaltung
Auf diese Schaltfläche klicken, um den Kanal stumm zu schalten. Wenn die Stummschaltung aktiv ist, wird
die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv.

5) Kanal-Kennzeichnung
Dieses Textfeld dient zur benutzerdefinierten Einstellung der Eingangskanalstreifen-Kennzeichnung im
Signalflussdiagramm. Die Voreinstellung bei jedem Eingangskanal ist “Untitled In” (Unbenannt Ein).

6) Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Eingangskanals angezeigt. Jede Einstellung, die für einen
verknüpften Kanal geändert wird, wird für den anderen Kanal in der gleichen Verknüpfungsgruppe
geändert. Umfassende Erläuterungen von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Normale Polarität

Umgekehrte Polarität

Hinweis: Die Eingangspegelsteller regeln den Pegel des Signals, nachdem es bereits im Audioproz-
essor digital umgewandelt wurde. Signalpegel, die die Eingangsschwelle des Audioproz-
essors überschreiten, müssen extern eingestellt werden. 

Stummschaltung aktiv

Stummschaltung inaktiv

Kanal verknüpft

Kanal nicht verknüpft
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Matrixmischer
Matrixmischer

Das Fenster “Matrix Mixer” (Matrixmischer) enthält Bedienelemente für Mischpunkt-Verbindungen im Signalflussdia-
gramm, die unter separaten Registerkarten im Fenster für jeden Ausgangsmischpunkt angeordnet sind. Auf einen der 
beiden Mischblöcke doppelklicken, um dieses Fenster einzublenden (siehe Abb. 6-2).

1) Fenster-Registerkarten

2

3

4

5

6
7

1

ABBILDUNG 6-2: Fenster “Matrix Mixer” (Matrixmischer)

Das Fenster wird mit dem Ausgangs-Fensterabschnitt 
für den Mischblock, auf den doppelgeklickt wurde, 
eingeblendet. Auf eine der beiden Registerkarten 
klicken, um auf die Bedienelemente des anderen Aus-
gangsmischpunkts zuzugreifen.

Die Fenster-Registerkarten entsprechen den Aus-
gangsmischpunkten im Signalflussdiagramm. Wenn 
eine Frequenzweiche bzw. ein Verteiler verwendet 
wird, zeigt der Titel der Registerkarte an, dass der 
Prozessor sich über beide Ausgangskanäle erstreckt 
(siehe Abb. 6-3).

ABBILDUNG 6-3: Frequenzweiche im Fenster “Matrix Mixer”
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2) Eingangswähler
Auf diese Schaltfläche klicken, um eine Verbindung für den zugehörigen Eingangskanal-Mischpunkt im
Signalflussdiagramm zu aktivieren. Die Schaltfläche wird grün markiert, wenn eine Verbindung aktiv ist.
Bedienelemente für inaktive Eingänge werden abgeblendet angezeigt. Die Voreinstellung ist inaktiv.

3) Signalpolarität

4) Pegelsteller
Mit diesen Stellern wird der Signalpegel für jeden Kanal eingestellt. Zuerst den Faderknopf wählen, dann
den Pegel mit der Maus, den Pfeiltasten oder durch Eingabe eines Werts in das Wertefeld einstellen.
Umfassende Anweisungen zur Bedienung siehe Abschnitt Fader auf Seite 34. Der Einstellbereich reicht
von +10 dB bis –unendlich dB, und die Voreinstellung ist 0 dB oder Arbeitspegel.

5) Kanalstummschaltung

6) Kanal-Kennzeichnung
Hier wird die Kanal-Kennzeichnung angezeigt, die im Fenster “Input Gain” (Eingangsverstärkung) bzw.
“Output Gain” (Ausgangsverstärkung) eingegeben wird.

7) Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Matrixmischpunkts angezeigt. Wenn Mischblöcke miteinander
verknüpft werden, werden alle Steuerelemente außer dem Eingangswähler für jeden der Mischblöcke
miteinander verknüpft. Umfassende Erläuterungen von Verknüpfung und Verknüpfungsgruppen siehe
Abschnitt Verknüpfungen auf Seite 24.

Verbindung aktiviert

Verbindung inaktiv

Normale Polarität Auf diese Schaltfläche klicken, um die Polarität des Signals umzuke-
hren, das am Matrixmischpunkt eintritt. Die Voreinstellung ist normale 
Polarität.Umgekehrte 

Polarität

Stummschaltung 
aktiv Auf diese Schaltfläche klicken, um den Kanal stumm zu schalten. 

Wenn die Stummschaltung aktiv ist, wird die Schaltfläche rot 
angezeigt. Die Voreinstellung ist inaktiv.Stummschaltung 

inaktiv

Prozessor verknüpft

Prozessor nicht verknüpft
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Ausgangsverstärkung
Das Fenster “Output Gain” (Ausgangsverstärkung) enthält einzelne Steller für beide Ausgangskanäle. Auf den
Verstärkungsblock rechts von einem der beiden Ausgangskanalstreifen doppelklicken, um dieses Fenster zu
öffnen (siehe Abb. 6-4).

1) Skalierung
Diese Schaltflächen dienen zum Skalieren der einzelnen Ausgangskanäle zur Anpassung an den Aus-
gangspegel des Geräts nach dem Audioprozessor. Durch Klicken kann zwischen -10 dBV und +4 dBu
gewechselt werden. Die Voreinstellung ist +4 dBu.

2) Signalpolarität
Auf diese Schaltfläche klicken, um die Polarität des Signals, das am Ausgangskanalstreifen austritt,
umzukehren. Die Voreinstellung ist normale Polarität.

+4 dBu gewählt

–10dBV gewählt

Normale Polarität

Umgekehrte Polarität
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ABBILDUNG 6-4: Fenster “Output Gain” 
(Ausgangsverstärkung)
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3) Pegelsteller
Mit diesen Stellern wird der Signalpegel für jeden Ausgangskanal eingestellt. Zuerst den Faderknopf
wählen, dann den Pegel mit der Maus, den Pfeiltasten oder durch Eingabe eines Werts in das Wertefeld
einstellen. Umfassende Anweisungen zur Bedienung siehe Abschnitt Fader auf Seite 34. Der Einstellbere-
ich reicht von +10 dB bis –unendlich dB, und die Voreinstellung ist 0 dB oder Arbeitspegel.

4) Ausgangs-Dämpfungsglieder
Auf einen dieser Schaltflächen klicken, um den Signalausgang um –12 dB bzw. –18 dB zu dämpfen. Wenn
ein Dämpfungsglied aktiv ist, wird die entsprechende Schaltfläche rot angezeigt. Die Standardeinstellung
dieser Schaltflächen ist inaktiv.

5) Kanalstummschaltung
Auf diese Schaltfläche klicken, um den Kanal stumm zu schalten. Wenn die Stummschaltung aktiv ist, wird
die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv.

6) Kanal-Kennzeichnung
Dieses Textfeld dient zur benutzerdefinierten Einstellung der Ausgangskanalstreifen-Kennzeichnung im
Signalflussdiagramm. Die Voreinstellung bei jedem Ausgangskanal ist “Untitled Out” (Unbenannt Aus).

7) Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Ausgangskanals angezeigt. Jede Einstellung, die für einen
verknüpften Kanal geändert wird, wird für alle Kanäle in der gleichen Verknüpfungsgruppe geändert.
Umfassende Erläuterungen von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

12 dB-Dämpfungsglied aktiv

12 dB-Dämpfungsglied inaktiv

Hinweis: Das –12 dB- und das –18 dB-Dämpfungsglied können nicht beim selben Ausgang gle-
ichzeitig deaktiviert werden.

Stummschaltung aktiv

Stummschaltung inaktiv

Kanal verknüpft

Kanal nicht verknüpft
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ABSCHNITT 7 Modulare Prozessoren
In diesem Abschnitt werden die Funktionen und Bedienelemente der einzelnen Prozessorblockparameter-Fenster bes-
chrieben. In einigen Fällen weisen mehrere Prozessorblöcke fast gleiche Bedienelemente auf, zum Beispiel der
Abwärts-Expander und das Gate. In diesen Fällen werden die Prozessoren als Gruppe mit nur einem Parameterfen-
ster zur Veranschaulichung beschrieben. Bedienelement-Einstellungen, die nur bei einem der Prozessoren in der
Gruppe vorkommen, werden in der Beschreibung solcher Bedienelemente entsprechend angemerkt.

Automatische Verstärkungsregelung (AGC)

Die AGC sorgt für einen gleichbleibenderen Lautstärkepegel, wenn verschiedene Sprecher mit unterschiedlicher 
Lautstärke sprechen. Die Funktion arbeitet wie ein Tontechniker, der einen Fader bedient und so den Pegel des Einga-
ngssignals erhöht, wenn die Lautstärke zu gering ist, bzw. verringert, wenn sie zu hoch ist.

Funktion
Dieser Prozessor kann in Situationen verwendet werden, in denen die Aufrechterhaltung eines konstanten
Lautstärkepegels erwünscht ist, wie zum Beispiel für Podium- und Lesepult-Mikrofone, bei denen sich der
Abstand des Sprechers zum Mikrofon ändert. Die AGC gleicht niedrige Pegel aus, indem er die Verstärkung
langsam erhöht. Wenn der Sprecher lauter in das Mikrofon spricht, verringert die AGC allmählich die Ver-
stärkung. Wenn ein Sprecher die Lautstärke der Stimme jedoch schnell verändert, indem er z. B. schreit, flüs-
tert oder sehr nahe zum Mikrofon geht, werden diese kurzfristigen Spitzenwerte bzw. Tiefstwerte durch den
AGC nicht verändert. Die AGC ändert den Pegel nur, wenn der Eingang aktiv ist. Auf diese Weise werden
unerwünschte Pegeländerungen bei Pausen im Programmmaterial vermieden.

Blockname Beschreibung
AGC Automatische Verstärkungsregelung

1

2

3 4 5

6

78

ABBILDUNG 7-1: AGC-Fenster
© 2003 Shure Incorporated DFR22-Software-Bedienungsanleitung 47



Automatische Verstärkungsregelung (AGC)
Merkmale des Parameterfensters
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente des automatischen Verstärkung-
sregelungsprozessors (siehe Abb. 7-1 oben). 

1) Linie der maximalen Verstärkung
Der größte Betrag, um den die AGC das Signal anhebt, ist +12 dB, wie durch die Linie der maximalen Ver-
stärkung gekennzeichnet. Dadurch werden Probleme durch unerwünschte Störungsmodulationen und
akustische Rückkopplung vermieden, die durch übermäßige Anhebung von niedrigpegeligen Signalen
entstehen können. Die Linie der maximalen Verstärkung erscheint nur in der Übertragungskennlinie, wenn
die Kombination von Schwellwert-, Angelpunkt- und Verhältnis-Einstellungen in der AGC die +12-dB-
Grenze bedrängt.

2) Übertragungskennlinie
Die Übertragungskennlinie zeigt die Einstellungen für den Schwellwert und den Kompressionsgrad als
grafische Elemente an, die mit der Maus positioniert werden können. Die resultierende Übertragung-
skennlinie repräsentiert die Änderung im Signalausgangspegel.

3) Schwellwert-Schieberegler
Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser
Schieberegler am oberen Rand der Übertragungskennlinie kann mit der Maus nach links und rechts gezo-
gen werden, um die Schwellwert-Einstellung zu ändern.

4) Kompressionsgrad-Schieberegler
Die Position des Kompressionsgrad-Schiebereglers entspricht der Einstellung der Kompressionsgrad-
Steuerung. Dieser Schieberegler am rechten Rand der Übertragungskennlinie kann mit der Maus nach
oben und unten gezogen werden, um die Kompressionsgrad-Einstellung zu ändern.

5) Pegelabschwächungsanzeige
Hier wird die gesamte Pegelanhebung oder -abschwächung angezeigt, die im Eingangssignal mit den jew-
eiligen Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menüoption [Options>Gain
Reduction Meter] (Optionen>Pegelabschwächungsanzeige) aus- und eingeschaltet werden. In der Vorein-
stellung ist sie eingeschaltet.

6) Pegelsteller
Mit den Pegelstellern werden die Eingangs- und Ausgangspegel geregelt. Der Bereich der verfügbaren
Verstärkungswerte liegt zwischen –12 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung.
Der Wert kann mit den Methoden verändert werden, die im Abschnitt Fader auf Seite 34 erläutert werden.

7) Angelpunkt-Schieberegler
Die Position des Angelpunkt-Schiebereglers entspricht der Einstellung der Angelpunkt-Steuerung. Dieser
Schieberegler am unteren Rand der Übertragungskennlinie kann mit der Maus nach links und rechts gezo-
gen werden, um die Angelpunkt-Einstellung zu ändern.

8) Übertragungskennlinien-Anzeige
Im Live-Modus stellt die Anzeige die Eingangspegel und relativen Ausgangspegel des Signals dar, sodass
die Auswirkungen des Prozessors auf das jeweilige Programmmaterial ersichtlich sind. Diese Funktion
kann mit der Menüoption [Options>Transfer Curve Meter] (Optionen>Übertragungskennlinien-Anzeige)
aus- und eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet.

Hinweis: Wenn viele Anzeigen in der Audioprozessor-Software aktiv sind, kann die Leistung der Software 
beeinträchtigt sein. Die Übertragungskennlinien-Anzeige oder die Verstärkungsreduzierungs-
Anzeige können einzeln oder beide im Menü [Options] ausgeschaltet werden.
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Automatische Verstärkungsregelung (AGC)
Anzeige Threshold Exceeded (Schwellwert überschritten)

Threshold (Schwellwert)
Hier wird der Pegel angezeigt, den die Signalverstärkung erreichen muss, bevor der Proz-
essor sie erhöht. Signalpegel unterhalb des Schwellwerts werden bei Arbeitspegel durch
den Prozessor geführt. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen, Einge-
ben eines Werts oder Betätigung des Schwellwert-Schiebereglers über der Übertragung-

skennlinie geändert werden. Der verfügbare Wertebereich reicht von –60 dB bis +20 dB in Schritten von
0,5 dB mit einer Voreinstellung von 0 dB.

Ratio (Kompressionsgrad)
Hier wird der Betrag der Verstärkungsreduzierung angezeigt, der am Ausgang des Proz-
essors relativ zum Eingangspegel, der den Angelpunkt überschreitet, erreicht wird. Eine
Einstellung von 4:1 bedeutet zum Beispiel, dass eine Erhöhung von 4 dB im Pegel des Pro-

grammmaterials eine Erhöhung des Ausgangspegels vom Prozessor von 1 dB bewirkt. Der Wert kann
durch Klicken auf die Drehpfeil-Schaltflächen, Eingeben eines Werts oder Betätigung des Kompressions-
grad-Schiebereglers an der rechten Seite der Übertragungskennlinie geändert werden. Der verfügbare
Wertebereich reicht von 1:1 bis 10:1 in Schritten von 1/10 mit einer Voreinstellung von 2:1.

Attack (Ansprechzeit)
Hier wird angegeben, wie lange der Prozessor wartet, bis er auf steigende oder fallende Ein-
gangspegel reagiert, nachdem der Eingangspegel den Schwellwert erreicht hat. Die verfüg-
baren Werte reichen von 0,2 s bis 3 s mit einer Voreinstellung von 2 Sekunden.

Decay (Abklingzeit)
Hier wird angegeben, wie lange der Prozessor wartet, bis er auf den Arbeitspegel zurückke-
hrt, nachdem der Eingangspegel näher zur Angelpunkt-Einstellung angestiegen oder abge-
fallen ist. Der verfügbare Wertebereich erstreckt sich von 0,5 s bis 5 s mit einer

Voreinstellung von 5 Sekunden.

Hinge (Angelpunkt)
Die Angelpunkt-Einstellung ist der angestrebte Ausgangspegel der AGC. Das ist ein
Entscheidungspunkt, der bestimmt, ob der Eingangspegel angehoben oder abgesenkt
wird. Signalpegel unterhalb des Angelpunktes (aber oberhalb des Schwellwerts) werden
angehoben, während Pegel oberhalb des Angelpunktes abgesenkt werden. Der Wert kann

durch Klicken auf die Drehpfeil-Schaltflächen, Eingeben eines Werts oder Betätigung des Angelpunkt-
Schiebereglers unter der Übertragungskennlinie geändert werden. Der verfügbare Wertebereich reicht von
–60dB bis +20 dB in Schritten von 0,5 dB mit einer Voreinstellung von 0 dB.

Default (Voreinstellung)
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen
zurückgesetzt.

Signalpegel hat den Schwellwert überschritten Diese Anzeige leuchtet gelb, wenn das 
Eingangssignal zum Prozessorblock den 
vorgegebenen Schwellwert überschreitet.Signalpegel hat den Schwellwert nicht erreicht
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Automatische Verstärkungsregelung (AGC)
Bypass (Umgehung)
Durch Klicken auf diese Schaltfläche wird ein Signal unverändert belassen. Wenn die Umgehung aktiv ist,
wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv.

Snapshot (Momentaufnahme)
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-Kennlinie,
indem auf die Schaltfläche [TAKE] (Aufnehmen) geklickt wird. Durch Klicken auf die Schaltfläche
[SHOW] (Anzeigen) wird die Aufnahme dann im Hintergrund für Vergleichszwecke angezeigt.
Die Schaltfläche [SHOW] wird grün markiert, wenn die Momentaufnahme angezeigt wird. Aus-
führliche Beschreibungen der Momentaufnahme-Funktion siehe Abschnitt

Momentaufnahmen auf Seite 36.

Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Umgehung aktiv

Umgehung inaktiv

Prozessor verknüpft

Prozessor nicht verknüpft
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Kompressor/Limiter
Kompressor/Limiter

Kompressoren und Limiter reduzieren den Ausgangspegel des Signals relativ zum Eingangspegel, nachdem der Ein-
gangspegel einen bestimmten Schwellwert überschreitet. Der Audioprozessor bietet die folgenden Typen von Kom-
pressoren und Limitern:

Funktion
Der Kompressor dient zum Skalieren des Ausgangs eines Signals, sodass es für Geräte mit einem schmaleren
Dynamikbereich wie Verstärker, Bandgeräte oder Lautsprecher geeignet ist. Der Limiter dient zum Schutz des
Systems vor plötzlichen Lautstärke-Spitzenpegeln, die die Lautsprecher möglicherweise beschädigen könnten.
Durch Verzögerung des Signals um 1 ms hat der Peak-Stop-Limiter eine Ansprechzeit von 0 ms, um noch
mehr Kontrolle über Signalspitzentöne zu erzielen. Der Kompressor und der Limiter funktionieren auf ähnliche
Weise, wobei der Limiter jedoch in der Regel für eine kürzere Ansprechzeit und einen höheren Kompressions-
grad eingestellt ist. 

Blockname Beschreibung
COMP Kompressor
Sft COMP Soft-Knee-Kompressor
LIM Begrenzer
Sft LIM Soft-Knee-Limiter
ST COMP

Wie oben: zur Verwendung für 
zwei Kanäle, die ein Stereopaar 
bilden.

Sft ST COMP
ST LIM

Sft ST LIM

PEAK LIM Peak-Stop-(“Look-Ahead”)-Limiter

1

2 3 4

5

67
ABBILDUNG 7-2: Fenster Sft ST COMP
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Kompressor/Limiter
Die folgenden Arten von Prozessoren sind sowohl in Limitern als auch in Kompressoren verfügbar:

• Soft-Knee - Diese Prozessoren bieten einen graduellen Übergang vom nicht komprimierten zum komprim-
ierten Signal. Sie verbrauchen einen höheren Anteil der DSP-Gesamtkapazität als diejenigen ohne Soft-
Knee-Option.

• Stereo - Diese Prozessoren gestatten die Aufrechterhaltung eines Stereoeindrucks, indem zwei Blöcke 
gesetzt werden, die in zwei verschiedenen Kanälen als ein einzelner Prozessor fungieren. Beide Proz-
essorkanäle reagieren mit der gleichen Pegelabsenkung, wenn der Eingang eines der Kanäle die Schwell-
wert-Einstellung überschreitet. Diese Prozessoren verbrauchen einen höheren Anteil der DSP-
Gesamtkapazität als Mono-Prozessoren.

Merkmale des Parameterfensters
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente von Kompressoren und Limitern,
wobei Sft ST COMP als Beispiel dient (siehe Abb. 7-2 oben). Alle in diesem Abschnitt behandelten Proz-
essoren sind sehr ähnlich in der Verwendung. Unterschiede in ihren Merkmalen und ihrer Funktionalität wer-
den gegebenenfalls erwähnt.

1) Übertragungskennlinie
Die Übertragungskennlinie zeigt die Einstellungen für den Schwellwert und den Kompressionsgrad als
grafische Elemente an, die mit der Maus positioniert werden können. Die resultierende Übertragung-
skennlinie repräsentiert die Änderung im Signalausgangspegel.

2) Schwellwert-Schieberegler
Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser
Schieberegler am oberen Rand der Übertragungskennlinie kann mit der Maus nach links und rechts gezo-
gen werden, um die Schwellwert-Einstellung zu ändern.

3) Kompressionsgrad-Schieberegler
Die Position des Kompressionsgrad-Schiebereglers entspricht der Einstellung der Kompressionsgrad-
Steuerung. Dieser Schieberegler am rechten Rand der Übertragungskennlinie kann mit der Maus nach
oben und unten gezogen werden, um die Kompressionsgrad-Einstellung zu ändern.

4) Pegelabschwächungsanzeige
Hier wird die gesamte Pegelanhebung oder -abschwächung angezeigt, die im Eingangssignal mit den jew-
eiligen Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menüoption [Options>Gain
Reduction Meter] (Optionen>Pegelabschwächungsanzeige) aus- und eingeschaltet werden. In der Vorein-
stellung ist sie eingeschaltet.

5) Pegelsteller
Mit den Pegelstellern werden die Eingangs- und Ausgangspegel geregelt. Der Bereich der verfügbaren
Verstärkungswerte liegt zwischen –12 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung.
Der Wert kann mit den Methoden verändert werden, die im Abschnitt Fader auf Seite 34 erläutert werden.

6) Auswahl für Übertragungskennlinien-Anzeige (nur bei Stereo-Prozessoren)
Mit diesen Schaltflächen können der Kanal bzw. die Kanäle ausgewählt werden, deren Übertragung-
skennlinien angezeigt werden sollen. Die Schaltflächen werden grün angezeigt, wenn die Anzeige für den
entsprechenden Kanal aktiv ist.

7) Übertragungskennlinien-Anzeige
Im Live-Modus stellt die Anzeige die Eingangspegel und relativen Ausgangspegel des Signals dar, sodass
die Auswirkungen des Prozessors auf das jeweilige Programmmaterial ersichtlich sind. Diese Funktion
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Kompressor/Limiter
kann mit der Menüoption [Options>Transfer Curve Meter] (Optionen>Übertragungskennlinien-Anzeige)
aus- und eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet.

Anzeige Threshold Exceeded (Schwellwert überschritten)

Threshold (Schwellwert)
Hier wird der Verstärkungspegel angegeben, den das Signal erreichen muss, bevor der
Prozessor es komprimiert. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen,
Eingeben eines Werts oder Betätigung des Schwellwert-Schiebereglers über der Übertra-
gungskennlinie geändert werden. Der verfügbare Wertebereich reicht von –60dB bis +20

dB in Schritten von 0,5 dB mit einer Voreinstellung von 0 dB.

Ratio (Kompressionsgrad)
Hier wird der Betrag der Verstärkungsreduzierung angegeben, der am Ausgang des Proz-
essors relativ zum Eingangspegel erreicht wird. Eine Einstellung von 4:1 bedeutet zum
Beispiel, dass eine Erhöhung von 4 dB im Pegel des Programmmaterials eine Erhöhung des

Ausgangspegels vom Prozessor von 1 dB bewirkt. Der Wert kann durch Klicken auf die Drehpfeil-Schalt-
flächen, Eingeben eines Werts oder Betätigung des Kompressionsgrad-Schiebereglers an der rechten
Seite der Übertragungskennlinie geändert werden. Der verfügbare Wertebereich reicht von 1:1 bis INF:1 in
Schritten von 1/10 mit einer Voreinstellung von 2:1 für Kompressoren und 10:1 für Limiter. Der Peak-Stop-
Limiter weist einen konstanten Kompressionsgrad von Unendlich zu Eins (INF:1) auf.

Attack (Ansprechzeit)
Hier wird angegeben, wie lange der Prozessor wartet, bis er anfängt, die Verstärkung zu
reduzieren, nachdem der Eingangssignalpegel den Schwellwert überschritten hat. Der ver-
fügbare Wertebereich reicht von 1 ms bis 200 ms mit einer Voreinstellung von 5 ms für Kom-

pressoren und 2 ms für Limiter. Der Peak-Stop-Limiter weist eine konstante Ansprechzeit von 0 ms auf.

Decay (Abklingzeit)
Hier wird angegeben, wie lange der Prozessor wartet, bis er zum Arbeitspegel zurückkehrt,
nachdem der Eingangssignalpegel unter den Schwellwert gefallen ist. Der verfügbare
Wertebereich reicht von 50 ms bis 1000 ms mit einer Voreinstellung von 100 ms für Kom-

pressoren, 50 ms für Limiter und 20 ms für den Peak-Stop-Limiter.

Knee
Bei “Soft-Knee”-Prozessoren zeigt dieses Bedienelement eine Pulldown-Liste an, aus der Soft-Knee- oder
Hard-Knee-Kompression gewählt werden kann. Die Voreinstellung ist “SOFT”. Bei Standard-Kompressoren
und -Limitern ist dieses Bedienelement deaktiviert.

Hinweis: Wenn viele Anzeigen in der Audioprozessor-Software aktiv sind, kann die Leistung der 
DFR22 Software beeinträchtigt sein. Die Übertragungskennlinien-Anzeige oder die Ver-
stärkungsreduzierungs-Anzeige können einzeln oder beide im Menü [Options] ausge-
schaltet werden.

Signalpegel hat den Schwellwert überschritten Diese Anzeige leuchtet gelb, wenn das 
Eingangssignal zum Prozessorblock den 
vorgegebenen Schwellwert überschreitet.Signalpegel hat den Schwellwert nicht erreicht

Soft-Knee-
Prozessor

“SOFT” oder “HARD” aus der Pulldown-Liste 
wählen.

Standard-
Prozessor Das Bedienelement ist deaktiviert.
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Default (Voreinstellung)
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen
zurückgesetzt.

Bypass (Umgehung)

Snapshot (Momentaufnahme)
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-Kennlinie,
indem auf die Schaltfläche [TAKE] (Aufnehmen) geklickt wird. Durch Klicken auf die Schaltfläche
[SHOW] (Anzeigen) wird die Aufnahme dann im Hintergrund für Vergleichszwecke angezeigt.
Die Schaltfläche [SHOW] wird grün markiert, wenn die Momentaufnahme angezeigt wird. Aus-
führliche Beschreibungen der Momentaufnahme-Funktion siehe Abschnitt
Momentaufnahmen auf Seite 36.

Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Soft-Knee-Prozessoren
Die folgenden Beispiele veranschaulichen den Unterschied zwischen Hard-Knee- und Soft-Knee-Kompres-
sion. Alle anderen Einstellungen in diesen Beispielen werden unverändert beibehalten.

Eine Soft-Knee-Einstellung (siehe Abb. 7-3) ist beim
Arbeiten mit hohen Kompressionsgraden praktisch.
Die Soft-Knee-Einstellung erhöht den Kompressions-
grad von 1:1 bei etwa 12 dB unter dem Schwellwert
langsam auf den vorgegebenen Kompressionsgrad
bei etwa 20 dB über dem Schwellwert. Durch die
langsame Erhöhung des Kompressionsgrads ist die
Kompression weniger auffällig als bei der Hard-Knee-
Einstellung.

Die Hard-Knee-Einstellung (siehe Abb. 7-4) aktiviert 
die Kompression unmittelbar mit dem angegebenen 
Kompressionsgrad, sobald der Signalpegel den 
Schwellwert überschreitet. Diese Einstellung ist 
besonders praktisch in einem Limiter, weil dadurch 

Umgehung aktiv Durch Klicken auf diese Schaltfläche wird ein Signal 
unverändert belassen. Wenn die Umgehung aktiv ist, wird die 
Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv.Umgehung inaktiv

Hinweis: Wenn die Umgehung im Peak-Stop-Limiter aktiviert ist, wird die Verzögerung von 1 ms 
nicht umgangen.

Prozessor verknüpft

Prozessor nicht verknüpft

ABBILDUNG 7-3: 
Soft-Knee-Option

ABBILDUNG 7-4: 
Hard-Knee-Option
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Kompressor/Limiter
plötzliche Spitzen daran gehindert werden, den Schwellwert zu überschreiten, ohne dass das Signal unterhalb des 
Schwellwerts geändert wird.

Stereo-Prozessoren
Die Stereo-Prozessoren weisen die gleichen Merkmale und die gleiche Funktionalität wie ihre Mono-Gegen-
stücke auf und umfassen einige zusätzliche Funktionen.

• Änderungen der Einstellungen von einem der beiden Prozessorkanäle werden auch auf den anderen 
Kanal angewandt.

• Beide Prozessorkanäle reagieren mit der gleichen Pegelabsenkung, wenn der Eingang eines der Kanäle 
die Schwellwert-Einstellung überschreitet.

• In den beiden Übertragungskennlinien-Anzeigen wird der Eingangspegel von Kanal A rot und der von 
Kanal B blau angezeigt.

• Anzeigen-Wähler gestatten die Ansicht der Übertragungskennlinien-Anzeige für Kanal A, Kanal B, beide 
Kanäle oder keinen Kanal.

• Die Anzeige “Schwellwert überschritten” ist für Kanal A und Kanal B vorhanden.

Hinweis: Wenn die Situation eine Hard-Knee-Einstellung erfordert, kann DSP-Kapazität 
gespart werden, indem ein Standard-Prozessor anstelle eines Soft-Knee-
Prozessors verwendet wird.
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Frequenzweichen/Verteiler/Subwoofer
Frequenzweichen/Verteiler/Subwoofer

Die Frequenzweiche teilt das Frequenzspektrum des Eingangssignals in mehrere Bänder auf und gibt jedes Band in 
einen separaten Kanal aus. Der Verteiler verteilt das Eingangssignal ohne weitere Verarbeitung über zwei Ausgänge. 
Der Subwoofer ist ein einzelner Tiefpassfilter. Da er voll konfiguriert werden kann, kann er auch als Bandpass- oder 
Hochpassfilter verwendet werden.

Funktion
Eine Frequenzweiche dient dazu, den Frequenzbereich des Eingangssignals mit zwei Filtern zu unterteilen
und dann jedes Frequenzband zu einem separaten Ausgang für verschiedene Lautsprechertypen zu leiten. Ein
Verteiler dient dazu, dasselbe Signal einfach an beide Ausgänge zu verteilen. Der Subwoofer dient dazu, ein
einzelnes Frequenzband zu isolieren, bevor das Signal an einen Ausgang gesendet wird. Frequenzweichen,
Verteiler und Subwoofer sind ausschließlich für die Ausgangsverarbeitung vorgesehen und können nicht in
Eingangskanalstreifen positioniert werden. Weitere Informationen zum Positionieren dieser Prozessoren im
Signalflussdiagramm siehe Abschnitt “Hinzufügen von Prozessoren“: Frequenzweiche, Verteiler und
Subwoofer auf Seite 23.

Merkmale des Parameterfensters
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente von Frequenzweichen und Sub-
woofer, wobei XOVER 2 (siehe Abb. 7-5 oben) als Beispiel dient. Die Merkmale des Subwoofers sind mit Aus-
nahme der Anzahl der Bandpassfilter identisch. Für den Verteiler gibt es kein Parameterfenster, da er keine
Verarbeitung des Signals gestattet, sondern dieses einfach nur verteilt.

Blockname Beschreibung
XOVER 2 2-Wege-Frequenzweiche
SPLIT 2 2-Wege-Verteiler
SUB Subwoofer

1

2

3

4 5 6 7

ABBILDUNG 7-5: Fenster XOVER2 (2-Wege-Frequenzweiche)
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1) Passband-Steuerelemente
Für jeden Ausgangskanal, der den Passbändern zugeordnet ist, gibt es einen Satz von Steuerelementen.

2) Ausgangskanal-Kennzeichnungen
Diese Kennzeichnungen über den Spalten mit den Passband-Bedienelementen haben die gleichen Farben
wie die zugehörigen Bandpasskurven im Frequenzgang-Plotter. Sie geben an, zu welchen Ausgangskanal
jedes Passband geführt ist. 

3) Frequenzgang-Plotter
Dieser Bereich des Fensters stellt die Bandpassfilter und Übergangspunkte, die durch Klicken und Ziehen
mit der Maus verändert werden können, grafisch dar.

4) Passbänder
Jedes Band verfügt über Ziehpunkte an beiden Seiten, die nach links und rechts gezogen werden können,
um die obere und untere Eckfrequenz unabhängig voneinander einzustellen. Außerdem befindet sich ein
Verstärkungs-Ziehpunkt in der Mitte jedes Bands, das nach oben und unten gezogen werden kann, um
den Ausgangspegel des Passbands einzustellen. Wenn ein Ziehpunkt gewählt wird, wird er mit einem far-
bigen Kreis gefüllt, um darauf hinzuweisen, dass er das aktive Steuerelement ist. Die obere und untere Fil-
terflanke werden mit den Passband-Bedienelementen im unteren Abschnitt des Fensters eingestellt.

5) Verstärkungs-Ziehpunkt
Diesen Ziehpunkt nach oben oder unten ziehen, um den Pegel des Passbands einzustellen. Die Position
des Ziehpunkts entspricht der Einstellung des Steuerelements [GAIN] (Verstärkung).

6) Frequenzweichen-Ziehpunkt
Dieser Ziehpunkt gibt die Frequenz des Übergangspunktes zwischen zwei Passbändern an. Er kann nach
links und rechts gezogen werden, um gleichzeitig die Eckfrequenzen der sich schneidenden Filterflanken
einzustellen. Wenn ein Frequenzweichen-Ziehpunkt gewählt wird, wird er grün, um darauf hinzuweisen,
dass er das aktive Steuerelement ist, und die zugehörigen Ecken-Ziehpunkte werden gefüllt, um darauf
hinzuweisen, dass sie gewählt sind. Beim Verschieben des Frequenzweichen-Ziehpunktes behalten die
Ecken-Ziehpunkte ihre Positionen relativ zueinander bei.

7) Ecken-Ziehpunkte
Diese Ziehpunkte nach links bzw. rechts ziehen, um die Eckfrequenzen des Passbands einzustellen. Die
Position dieser Ziehpunkte entspricht der Einstellung der Steuerelemente [LOW CORNER FREQ] (Untere Eck-
frequenz) und [UPPER CORNER FREQ] (Obere Eckfrequenz).

Verstärkungen einstellen und anzeigen/Plot normalisieren
Mit diesen Schaltflächen werden die Passbänder abwechselnd mit
ihren tatsächlichen Verstärkungspegeln und normalisiert angezeigt.
Die Voreinstellung ist [SET AND SHOW GAINS ON PLOT] (Verstärkungen in
Plot einstellen und anzeigen).

Wenn die Verstärkungspegel von Passbändern sich beträchtlich unter-
scheiden, erscheint der Übergangspunkt von seiner tatsächlichen
Position versetzt (siehe Abb. 7-6). Der Anzeigemodus für den normal-
isierten Plot dient dazu, die genaue Position des Übergangspunktes zu
sehen (siehe Abb. 7-7).

Hinweis: Zur Darstellung der Auswirkungen der Frequenzweiche auf den Signalweg [View>Combined Response 
Curve] (Ansicht>Kombinierte Frequenzgang-Kennlinie) aus dem Hauptmenü wählen. Weitere Informa-
tionen siehe Abschnitt Kombiniertes Frequenzgangdiagramm auf Seite 39.

ABBILDUNG 7-6: [SET AND SHOW 
GAINS ON PLOT] (Verstärkungen in Plot 

einstellen und anzeigen)
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Frequenzweichen/Verteiler/Subwoofer
• Auf die Schaltfläche [SET AND SHOW GAINS ON PLOT] (Ver-
stärkungen in Plot einstellen und anzeigen) klicken, um die 
Passband-Verstärkungspegel anzuzeigen und einzustellen. 
Bei dieser Einstellung werden Filterpegel im Frequenzgang-
Plotter berücksichtigt, und die Verstärkungs-Ziehpunkte sind 
auf den Passbändern zu sehen.

• Auf die Schaltfläche [NORMALIZE PLOT] (Plot normalisieren) 
klicken, um die Passbänder bei Arbeitspegel im Frequen-
zgang-Plotter anzuzeigen. Die tatsächlichen Verstärkung-
swerte werden durch diese Einstellung nicht verändert.

Default (Voreinstellung)
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen
zurückgesetzt.

Mute (Stummschaltung)

Polarity (Polarität)

Low Corner Freq (Untere Eckfrequenz)
Hier wird die Frequenzeinstellung der unteren Ecke des Passbands angegeben. Der ver-
fügbare Wertebereich ist abhängig von der Einstellung der oberen Eckfrequenz, da sich
Eckfrequenzen nicht überlappen können. Der Wert kann durch Klicken auf die Drehpfeil-

Schaltflächen, Verwendung der Tastatur-Bedienelemente oder Eingeben eines Werts geändert werden.
Die Voreinstellungen für die Passbänder sind nachstehend aufgeführt.

Low Filter Type/Upper Filter Type (Unterer Filtertyp/oberer Filtertyp)
Hier wird die Flanke der zugehörigen Passbandecke angegeben. Einen Wert aus dem
nachstehenden Pulldown-Menü wählen. Die Voreinstellung ist 24 dB/Okt. Linkwitz-Riley.

Stummschaltung 
aktiv Auf diese Schaltfläche klicken, um den Ausgang des entsprech-

enden Bands stumm zu schalten. Wenn die Stummschaltung aktiv 
ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv.Stummschaltung 

inaktiv

Normale Polarität Auf diese Schaltfläche klicken, um die Polarität des Signals 
aus der Frequenzweiche umzukehren. Die Voreinstellung ist 
normale Polarität.Umgekehrte Polarität

Band 1 OUT (AUS)
Band 2 2,0 kHz

Abkürzung Beschreibung
6 Butt 6 dB/Okt. Butterworth
6 Bessel 6 dB/Okt. Bessel
12 Butt 12 dB/Okt. Butterworth
12 Bess 12 dB/Okt. Bessel
12 L-R 12 dB/Okt. Linkwitz-Riley
18 Butt 18 dB/Okt. Butterworth
18 Bessel 18 dB/Okt. Bessel
24 Butt 24 dB/Okt. Butterworth
24 Bess 24 dB/Okt. Bessel
24 L-R 24 dB/Okt. Linkwitz-Riley

ABBILDUNG 7-7: [NORMALIZE PLOT] (Plot 
normalisieren)
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Upper Corner Freq (Obere Eckfrequenz)
Hier wird die Frequenzeinstellung der oberen Ecke des Passbands angegeben. Der verfüg-
bare Wertebereich ist abhängig von der Einstellung der unteren Eckfrequenz, da sich Eck-
frequenzen nicht überlappen können. Der Wert kann durch Klicken auf die Drehpfeil-

Schaltflächen, Verwendung der Tastatur-Bedienelemente oder Eingeben eines Werts geändert werden.
Die Voreinstellungen für die Passbänder sind nachstehend aufgeführt.

Gain (Verstärkung)
Mit den Pegelstellern werden die Ausgangspegel geregelt. Der Bereich der verfügbaren
Verstärkungswerte liegt zwischen –18 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als
Voreinstellung. Der Wert kann mit den Methoden verändert werden, die im Abschnitt
Fader auf Seite 34 erläutert werden.

Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Tasten der Tastatur
Mit Tasten der Tastatur können Feineinstellungen der Ziehpunkt-Positionen im Frequenzgang-Plotter vor-
genommen werden. Einen Ziehpunkt durch Klicken wählen und dann die folgenden Tasten verwenden.

Band 1 2.0 kHz
Band 2 OUT (AUS)

Prozessor verknüpft

Prozessor nicht verknüpft

Taste Frequenzeinstellung

�
Verringert die Frequenz um einen Bild-
schirm-Bildpunkt

�
Erhöht die Frequenz um einen Bildschirm-
Bildpunkt

Umschalttaste + � Verringert die Frequenz um 1/3 Oktave
Umschalttaste + � Erhöht die Frequenz um 1/3 Oktave

Hinweis: Durch Ändern der Frequenz um einen Bildschirm-Bildpunkt ändert sich der Wert um etwa 
1/100 einer Oktave oder 1 %.

Taste Verstärkungseinstellung
� Erhöht die Verstärkung um 0,5 dB
� Verringert die Verstärkung um 0,5 dB

Umschalttaste + �
oder Bild-Auf-Taste Erhöht die Verstärkung um 3 dB

Umschalttaste + �
oder Bild-Ab-Taste Verringert die Verstärkung um 3 dB

Leertaste oder Klicken
mit der rechten

Maustaste
Stellt die Verstärkung auf 0 dB ein
© 2003 Shure Incorporated DFR22-Software-Bedienungsanleitung 59



Filter mit steilflankiger und Kuhschwanz-Charakteristik
Filter mit steilflankiger und Kuhschwanz-Charakteristik

Die Filter mit steilflankiger und Kuhschwanz-Charakteristik heben die Frequenzcharakteristika eines Systems im 
oberen und unteren Bereich insgesamt an oder senken sie ab und dämpfen das obere und untere Ende des Frequen-
zspektrums.

Funktion
Diesen Prozessor verwenden, wenn ein Filter mit steilflankiger Charakteristik mit Entzerrung über ein breites
Spektrum mit hohem und tiefem Endbereich kombiniert werden soll. Die Hoch- und Niederfrequenz-Filter mit
steilflankiger Charakteristik bieten eine Vielzahl von Flanken-Optionen zwischen –6 dB/Okt. und –24 dB/Okt.
Außerdem ist es möglich, die Eckflanke der Filter mit Kuhschwanz-Charakteristik entweder als 6 dB/Okt. oder
als 12 dB/Okt. vorzugeben.

Merkmale des Parameterfensters
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente des Filters mit steilflankiger/Kuh-
schwanz-Charakteristik (siehe Abb. 7-8 oben).

Blockname Beschreibung

CUT/SHELF
Hoch- und Niederfrequenz-Filter mit steilflankiger 
Charakteristik/Hoch- und Niederfrequenz-Filter mit 
Kuhschwanz-Charakteristik

1

2

3

4

ABBILDUNG 7-8: Fenster CUT/SHELF
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Filter mit steilflankiger und Kuhschwanz-Charakteristik
1) Frequenzgangdiagramm
Diese Kennlinie ist eine grafische Darstellung der kombinierten Ergebnisse der Filter-Ziehpunkte im Fre-
quenzgang-Plotter.

2) Frequenzgang-Plotter
Dieser Bereich des Parameterfensters stellt die Ziehpunkte der Filter mit steilflankiger und mit Kuh-
schwanz-Charakteristik, die durch Klicken und Ziehen mit der Maus verändert werden können, grafisch
dar. Beim ersten Öffnen des Parameterfensters befinden sich die Filter-Ziehpunkte an ihren Systemvorein-
stellpositionen am obersten und untersten Rand des Frequenzspektrums. Durch Klicken auf einen Zieh-
punkt wird seine Frequenzgang-Kennlinie angezeigt und es können Einstellungen vorgenommen werden.

3) Filter mit steilflankiger Charakteristik
Filter mit steilflankiger Charakteristik erscheinen als Ziehpunkte am unteren Rand des Frequenzgang-Plot-
ters, ihre Mittenfrequenzen sind durch gestrichelte senkrechte Linien gekennzeichnet. Ihre Frequenz-Vore-
instellung ist “OUT” (AUS) und ihre Typ-Voreinstellung ist 6 dB/Butterworth.

4) Filter mit Kuhschwanz-Charakteristik
Die Hoch- und Niederfrequenz-Filter mit steilflankiger/Kuhschwanz-Charakteristik erscheinen entlang einer
horizontalen Achse in der Mitte des Frequenzgang-Plotters. Ihre Frequenz-Voreinstellung ist “OUT” (AUS)
und ihre Typ-Voreinstellung ist 6 dB/Okt.

Frequenz
Hier wird die Frequenz des gewählten Filterpunktes angezeigt. Der Wert kann durch
Klicken auf die Drehpfeil-Schaltflächen, Verwendung von Tastaturtasten oder Einge-

ben eines Werts geändert werden. Der Frequenzbereich erstreckt sich von 25 Hz bis 20 kHz mit “OUT” als
Voreinstellung.

Type (Typ)
Hier wird der Flankentyp des gewählten Filters angezeigt. Die im Pulldown-
Menü verfügbaren Werte für Filter mit steilflankiger und Kuhschwanz-Charak-
teristik unterscheiden sich, wie nachstehend angeführt.

* Kennzeichnet die Voreinstellung

Gain (Verstärkung)
Hier wird die aktuelle Verstärkungseinstellung des gewählten Filters mit Kuh-
schwanz-Charakteristik angegeben. Der Bereich der verfügbaren Verstärkungswerte

liegt zwischen –18 dB und +18 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung. Der Wert kann mit
den Methoden verändert werden, die im Abschnitt Fader auf Seite 34 erläutert werden. Beim Arbeiten
mit einem Filter mit steilflankiger Charakteristik ist dieses Steuerelement deaktiviert, dann wird das Wort
“CUT” angezeigt.

Hinweis: Die Kurve enthält nicht die summierten Wirkungen der verschiedenen Prozessorblöcke im Sig-
nalflussdiagramm. Zum Anzeigen einer kombinierten Kurve [View>Combined Response Curve] 
(Ansicht>Kombinierte Frequenzgang-Kennlinie) aus dem Hauptmenü wählen. Weitere Informa-
tionen siehe Abschnitt Kombiniertes Frequenzgangdiagramm auf Seite 39.

Kuhschwanz-Char-
akteristik Steilflankige Charakteristik

6 dB/Oktave*
12 dB/Oktave

6 dB/Okt. Butterworth* 18 dB/Okt. Butterworth
6 dB/Okt. Bessel 18 dB/Okt. Bessel
12 dB/Okt. Butterworth 24 dB/Okt. Butterworth
12 dB/Okt. Bessel 24 dB/Okt. Bessel
12 dB/Okt. Linkwitz-Riley 24 dB/Okt. Linkwitz-Riley
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Clear (Löschen)
Durch Klicken auf diese Schaltfläche werden die Filtereinstellungen auf ihre Voreinstellungen
zurückgesetzt. Dann wird das Dialogfeld “Clear” (Löschen) (Abbildung 7-20 auf Seite 85) einge-

blendet, das die Option bietet, alle oder nur ausgewählte Filtereinstellungen zu löschen.

Bypass (Umgehung)

Snapshot (Momentaufnahme)
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-Kennlinie,
indem auf die Schaltfläche [TAKE] (Aufnehmen) geklickt wird. Durch Klicken auf die Schaltfläche
[SHOW] (Anzeigen) wird die Aufnahme dann im Hintergrund für Vergleichszwecke angezeigt.
Die Schaltfläche [SHOW] wird grün markiert, wenn die Momentaufnahme angezeigt wird. Aus-
führliche Beschreibung der Momentaufnahme-Funktion siehe Abschnitt Momentaufnahmen auf
Seite 36.

Importieren von ASCII-Dateien
Diese Funktion ermöglicht das Importieren von Frequenzdaten aus SIA Smaart und Gold
Line TEF in das Frequenzgangdiagramm. Die grafischen Daten im Diagramm können bei
der Gestaltung der Frequenzgang-Kennlinie des Prozessors als Referenz verwendet wer-
den. Anweisungen zur Verwendung der ASCII-Importfunktion siehe Seite 37.

Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Feinregelung von Parametern
Die Parameter für die gewählten Filter können mit den nachstehend beschriebenen Methoden präzise
eingestellt werden.

• Eingabe von Werten in die Parameterfelder
• Betätigung der Drehpfeil-Tasten (oder des Dropdown-Feldes) neben den Parameterfeldern
• Verwendung der Tastatur-Tasten

Umgehung aktiv Durch Klicken auf diese Schaltfläche wird ein Signal unverändert 
belassen. Wenn die Umgehung aktiv ist, wird die Schaltfläche rot 
angezeigt. Die Voreinstellung ist inaktiv.Umgehung inaktiv

Prozessor verknüpft

Prozessor nicht verknüpft
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Filter mit steilflankiger und Kuhschwanz-Charakteristik
Tasten der Tastatur
Mit den folgenden Tasten der Tastatur können Feineinstellungen für den jeweils gewählten Filter vor-
genommen werden.

Kopieren und Einfügen
Die Einstellungen von Filter-Ziehpunkten können zwischen Prozessorfenstern für Filter mit steilflankiger und
Kuhschwanz-Charakteristik kopiert und eingefügt werden.

So werden Filter kopiert und eingefügt:
1. Durch Klicken einen Filter wählen oder mit einer der nachstehenden Methoden mehrere Filter wählen:

• Strg + Klicken.
• Die Menüoption [Edit>Select All] (Bearbeiten>Alles wählen) verwenden.

2. Die Menüoption [Edit>Copy] (Bearbeiten>Kopieren) verwenden.
3. Das Prozessorfenster des Filters mit steilflankiger/Kuhschwanz-Charakteristik öffnen, in das die Filterein-

stellungen eingefügt werden sollen.
4. Die Menüoption [Edit>Paste] (Bearbeiten>Einfügen) verwenden.

Taste Ergebnis

�
Verringert die Frequenz um einen Bild-
schirm-Bildpunkt

�
Erhöht die Frequenz um einen Bildschirm-
Bildpunkt

� Erhöht die Verstärkung um 0,5 dB
� Verringert die Verstärkung um 0,5 dB

Umschalttaste + � Verringert die Frequenz um 1/3 Oktave
Umschalttaste + � Erhöht die Frequenz um 1/3 Oktave
Umschalttaste + �

oder Bild-Auf-Taste Erhöht die Verstärkung um 3 dB

Umschalttaste + �
oder Bild-Ab-Taste Verringert die Verstärkung um 3 dB

Leertaste oder Klicken mit
der rechten Maustaste Stellt die Verstärkung auf 0 dB ein

Entf Stellt den oder die gewählten Filter auf die 
Voreinstellungen zurück.

Hinweis: Durch Ändern der Frequenz um einen Bildschirm-Bildpunkt ändert sich der Wert um 
etwa 1/100 einer Oktave oder 1 %.

Hinweis: Wenn Filter Bestandteil einer Mehrfach-Auswahl sind, werden sie rosa markiert und 
ihre Parametereinstellungen gesperrt. Um die Wahl einer Mehrfach-Auswahl rück-
gängig zu machen, die Taste Esc drücken oder auf ein beliebiges Steuerelement 
außerhalb des Auswahlbereichs klicken.
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Delay (Verzögerung)

Der Delay-Prozessor speichert das Signal vorübergehend im Verzögerungsspeicher und leitet es dann nach Ablauf der 
vorgegebenen Zeitdauer weiter. Der Audioprozessor bietet die folgenden Delay-Typen:

Funktion
Der Delay dient zum Abgleichen der Sound-Ausgänge von verschiedenen Lautsprechern, sodass sie gle-
ichzeitig im Publikum ankommen. Der Delay kann außerdem eingesetzt werden, um Probleme mit der
Phasenaufhebung zwischen installierten Lautsprechern zu korrigieren. Die Berechnung der Verzögerung
erfolgt mit den Einheiten Zeit, Entfernung und Lufttemperatur. 

Merkmale des Parameterfensters
Dieser Abschnitt erläutert die Funktionen von Delay-Prozessoren, wobei DLY150 als Beispiel dient (siehe
Abb. 7-9). Die Merkmale der anderen Verzögerungsglieder sind mit Ausnahme ihrer maximalen Verzögerung-
szeiten identisch.

Units (Einheiten)
Mit diesem Steuerelement wird angegeben, ob die Parameter in englischen oder
metrischen Einheiten angezeigt werden. Die Voreinstellung ist “Metric”
(metrisch).

Blockname Beschreibung
DLY5ms Maximale Verzögerung von 5 Millisekunden
DLY150ms Maximale Verzögerung von 150 Millisekunden
DLY500ms Maximale Verzögerung von 500 Millisekunden
DLY2s Maximale Verzögerung von 2 Sekunden

Hinweis: Jeder Delay-Prozessorblock verbraucht die maximale Menge des Verzögerungsspeichers, 
der aus dem Blocknamen hervorgeht, unabhängig von der tatsächlichen Verwendung. Um 
die Ressourcen des Audioprozessors zu schonen, sollte der Delay-Prozessor gewählt wer-
den, dessen Maximum der tatsächlich benötigten Verzögerungszeit am nächsten liegt.

ABBILDUNG 7-9: Fenster DLY 150ms
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Time (Zeit)
Mit diesem Steuerelement wird die Verzögerungszeit in Millisekunden angegeben.
Der Wertebereich liegt zwischen 0 ms und der maximalen Verzögerungszeit des
Prozessorblocks, in diesem Fall 150 ms. Die Voreinstellung ist 0 ms.

Distance (Entfernung)
Mit diesem Steuerelement wird die Verzögerung nach der Entfernung
angegeben. Der Wertebereich ist abhängig von der maximalen
Verzögerungszeit, aber die Voreinstellung ist immer Null. Die gewünschte

Maßeinheit mit den Optionsfeldern rechts neben dem Steuerelement wählen. Wenn englische Einheiten
gewählt sind, können Sie zwischen IN (Zoll) und FT (Fuß) wählen. Wenn metrische Einheiten gewählt sind,
wird der Abstand in Metern angegeben.

Lufttemperatur
Dieses Steuerelement ist zu verwenden, wenn die Verzögerung nach der
Entfernung eingestellt wird, da die Schallgeschwindigkeit durch die Lufttem-
peratur beeinflusst wird. Der Wertebereich reicht von –13°F bis 122°F bzw.

–25°C bis 50°C. Wenn englische Einheiten gewählt sind, wird die Lufttemperatur in Fahrenheit angegeben.
Wenn metrische Einheiten gewählt sind, wird die Lufttemperatur in Grad Celsius angegeben. Die Vorein-
stellung ist 69° Fahrenheit bzw. 20° Celsius.

Bypass (Umgehung)

Clear (Löschen)
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen
zurückgesetzt.

Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Umgehung aktiv Durch Klicken auf diese Schaltfläche wird ein Signal unverändert 
belassen. Wenn die Umgehung aktiv ist, wird die Schaltfläche rot 
angezeigt. Die Voreinstellung ist inaktiv.Umgehung inaktiv

Prozessor verknüpft

Prozessor nicht verknüpft
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Digitale Rückkopplungsreduzier-Stufe (DFR)
Digitale Rückkopplungsreduzier-Stufe (DFR)

Die DFR verwendet den patentierten Adaptive-Notch-Filter-Algorithmus von Shure, der zwischen Rückkopplungs- und 
Nicht-Rückkopplungstönen unterscheiden kann. Sie erkennt Rückkopplungen automatisch und setzt bei den Rückkop-
plungsfrequenzen Schmalband-Sperrfilter ein. Keine Beschallungsanlage (Kombination von Mikrofonen, Mischung, 
Signalverarbeitung, Leistungsverstärkern und Lautsprechern) verfügt über einen absolut ebenen Frequenzgang. Wenn 
der Pegel einer Beschallungsanlage gesteigert wird, wird zuerst bei den Frequenzen, bei denen Spitzenwerte 
auftreten, der Schwellwert für Rückkopplungen überschritten. Die DFR dämpft diese Frequenzen, wodurch der Fre-
quenzgang der Beschallungsanlage flacher wird. Auf diese Weise kann die Anlage mit einem höheren Gesamtpegel 
betrieben werden. Der DFR22 Audioprozessor bietet die folgenden DFR-Typen:

Funktion
Die DFR sollte als erster Prozessor in jedem Eingangskanal, der Signale von einem Mikrofon mit Rückkop-
plungsproblemen empfängt, verwendet werden. Wenn die DFR eine Rückkopplung feststellt, wird im Signal-
weg ein flacher, schmalbandiger Filter eingefügt, mit dem der Pegel bei der Rückkopplungsfrequenz gedämpft
wird. Dieser Filter wird aufgrund des schmalen Frequenzbereichs, auf den er sich auswirkt, als Bandsperrfilter
bezeichnet. Durch die Einstellung des Q-Faktors des Filters über das Menü [Options] (Optionen) des DFR-
Prozessors kann die Bandbreite eingestellt werden, bei der neue Filter eingesetzt werden. Weitere Informa-
tionen über die Bandbreite von Bandsperrfiltern siehe Abschnitt Filter mit hohem bzw. niedrigem Q-Faktor auf
Seite 71

Bei den Stereo-DFR-Prozessoren wird für beide Kanäle bei derselben Frequenz und Tiefe ein Bandsperrfilter
eingesetzt, wenn auf einem der Kanäle eine Rückkopplung festgestellt wird. Auf diese Weise wird das Stereo-
bild bewahrt.

Blockname Beschreibung
DFR5 Digitale Rückkopplungsreduzier-Stufe mit 5 Bändern
DFR10 Digitale Rückkopplungsreduzier-Stufe mit 10 Bändern
DFR16 Digitale Rückkopplungsreduzier-Stufe mit 16 Bändern
ST DFR5

Wie oben: zur Verwendung für zwei Kanäle, die 
ein Stereopaar bilden.

ST DFR10

ST DFR16

1

ABBILDUNG 7-10: Fenster DFR10

2
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Digitale Rückkopplungsreduzier-Stufe (DFR)
Merkmale des Parameterfensters
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente der digitalen Rückkopplungsreduz-
ier-Stufe, wobei DFR10 als Beispiel dient (siehe Abb. 7-10). Die Merkmale der anderen DFR sind mit Aus-
nahme der Anzahl der verfügbaren Bandsperrfilter und der Stereo-Funktionalität identisch.

1) Frequenzgangdiagramm
Diese Kennlinie ist eine grafische Darstellung der kombinierten Ergebnisse der aktiven Bandsperrfilter des
Prozessors (gelb markiert).

2) Derzeit gewählter Filter

Diese Linie wird im Frequenzgangdiagramm an der Frequenz des derzeit gewählten Filters angezeigt; 
diese wird zwischen den beiden roten Pfeilen in der Reihe der Rückkopplungsfilter dargestellt.

Frequenz
Hier wird die Frequenz des gewählten Filters angezeigt. Der Wert kann durch Klicken auf
die Drehpfeil-Schaltflächen, Verwendung von Tasten der Tastatur oder Eingeben eines
Werts geändert werden. Der Frequenzbereich erstreckt sich von 25 Hz bis 20 kHz mit
“OUT” als Voreinstellung.

Tiefe
Hier wird die Pegelreduzierung des gewählten Filters angezeigt. Der Bereich der verfüg-
baren Verstärkungswerte liegt zwischen 0 dB und –18 dB in Schritten von 0,5 dB mit
einer Voreinstellung von 0 dB.

Type (Typ)
Hier wird der Bandbreiten-Typ des gewählten Filters angezeigt. “HIGH Q” bzw. “LOW Q”
(hoher bzw. niedriger Q-Faktor) aus dem Pulldown-Menü wählen. ”Die Voreinstellung ist

“HIGH Q”. Weitere Informationen siehe Abschnitt Filter mit hohem bzw. niedrigem Q-Faktor auf Seite 71.

Rückkopplungsfilter
Die Steuerelemente der Rückkopplungsfilter werden als LED-Reihe angezeigt.
Die Anzahl der festen und der dynamischen Filter wird durch Verschieben der
roten Klammern mit der Maus nach links und rechts eingestellt. Aktive Filter wer-
den gelb angezeigt und erscheinen im Frequenzgang-Diagramm. Weitere
Erläuterungen siehe Abschnitt Filterzuweisung auf Seite 70.

Lock (Sperren)
Auf diese Schaltfläche klicken, um den Einsatz neuer Filter und die Vertiefung von bestehenden Filtern zu
verhindern. Mit dieser Option wird die DFR daran gehindert, Filter für Programmmaterial anzuwenden, das
erwünschte Rückkopplungen oder Klänge enthält, die Rückkopplungen sehr ähnlich sind (wie z.B. Gitarre-
neffekte, Synthesizerklänge, Flöten oder Pfeifenorgel). Wenn die Sperrfunktion aktiv ist, wird die Schalt-
fläche rot angezeigt. Die Voreinstellung ist inaktiv.

Hinweis: Die Kurve enthält nicht die summierten Wirkungen der verschiedenen Prozessorblöcke im Sig-
nalflussdiagramm. Zum Anzeigen einer kombinierten Kurve [View>Combined Response Curve] 
(Ansicht>Kombinierte Frequenzgang-Kennlinie) aus dem Hauptmenü wählen. Weitere Informa-
tionen siehe Abschnitt Kombiniertes Frequenzgangdiagramm auf Seite 39.

Sperre aktiv

Sperre inaktiv
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Digitale Rückkopplungsreduzier-Stufe (DFR)
Bypass (Umgehung)
Die DFR-Bandsperrfilterung durch Klicken deaktivieren. Durch die Umgehung wird auch die DFR gesperrt,
wodurch keine neuen Filter eingesetzt werden können. Wenn die Umgehung aktiv ist, wird die Schaltfläche
rot angezeigt. Die Voreinstellung ist inaktiv.

Clear (Löschen)
Auf diese Schaltfläche klicken, um die Filtereinstellungen zu löschen. Dann wird das Dialog-
feld “Clear” (Löschen) (Abbildung 7-20 auf Seite 85) eingeblendet, das die Option bietet, alle
oder nur ausgewählte Filtereinstellungen zu löschen.

Auto Clear (Automatisch löschen)
Auf diese Schaltfläche klicken, um das Dialogfeld “Auto Clear” (Automatisch löschen) einzublenden (siehe
Beschreibung  auf Seite 72). Mit dieser Funktion kann angegeben werden, ob und wann die DFR die
zugeordneten dynamischen Filter löschen und Änderungen der festen Filtertiefe entfernen soll. Die Schalt-
fläche wird grün markiert, wenn die Funktion aktiv ist. Die Voreinstellung ist inaktiv.

Front Panel (Frontplatte)
Mit diesem Steuerelement wird der DFR-Prozessor den LEDs und Bedienelementen auf
der Frontplatte zugeordnet. Wenn eine DFR der Frontplatte zugeordnet ist, sind bei
aktiven Filtern die LEDs in der/den gewählten Reihe(n) beleuchtet und der Prozessor wird

mit den Bedienelementen auf der Frontplatte gesteuert. Beschreibungen der Bedienelemente auf der
Frontplatte siehe Installation Guide (Installationsanleitung). Jeder Reihe der Frontplatte kann nur eine DFR
zugeordnet werden. Die Voreinstellung ist “Unassigned” (Nicht zugeordnet).

Snapshot (Momentaufnahme)
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-Kennlinie,
indem auf die Schaltfläche [TAKE] (Aufnehmen) geklickt wird. Durch Klicken auf die Schaltfläche
[SHOW] (Anzeigen) wird die Aufnahme dann im Hintergrund für Vergleichszwecke angezeigt. Die
Schaltfläche [SHOW] wird grün markiert, wenn die Momentaufnahme angezeigt wird. Ausführli-
che Beschreibung der Momentaufnahme-Funktion siehe Abschnitt Momentaufnahmen auf
Seite 36.

Umgehung aktiv

Umgehung inaktiv

Automatisch löschen aktiv

Automatisch löschen inaktiv

Prozessor Einstellungen

Mono DFR
[Unassigned] 
[Row A] (Reihe A)
[Row B] (Reihe B)

Stereo DFR
[Unassigned] 
[Rows A & B] (Reihen A und B)

Hinweis: Wenn im Signalflussdiagramm ein DRF-Block kopiert und eingefügt wird, der der Frontplatte 
zugeordnet ist, wird der neue, eingefügte Block nicht zugeordnet. Wenn ein DRF-Block, der 
der Frontplatte zugeordnet ist, ausgeschnitten und eingefügt wird, bleibt er zugeordnet.
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Digitale Rückkopplungsreduzier-Stufe (DFR)
Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Grundlegende DFR-Einrichtung
Die DFR gestattet es (wie jeder andere Rückkopplungsreduzier-Prozessor) nicht, die Verstärkung über die
physikalischen Grenzwerte der Beschallungsanlage hinaus zu steigern. Meist wird ein Zustand abnehmenden
Nutzens erreicht, nachdem 4 bis 8 Bandsperrfilter eingestellt wurden. Dies erklärt sich daraus, dass es im
Allgemeinen nur wenige dominante Spitzen im Frequenzgang der Anlage gibt. Meist kann durch Verwendung
der DFR eine Anhebung der Verstärkung vor Rückkopplung von 6 bis 9 dB erwartet werden. Wenn in der
Anlage Rückkopplungen erregt werden und festgestellt wird, dass es bei vielen Frequenzen gleichzeitig zu
einer Rückkopplung kommt, auch wenn der Pegel sehr langsam erhöht wird, ist der Punkt des abnehmenden
Nutzens erreicht. Wenn die Anlage an diesem Punkt eine unzureichende Verstärkung vor Rückkopplung auf-
weist, müssen andere Änderungen an der Beschallungsanlage vorgenommen werden, z. B. eine Änderung der
Position der Mikrofone und/oder Lautsprecher.

Es gibt zwei grundlegende Einrichtungsverfahren für den DFR zum Reduzieren von Rückkopplungen: die Meth-
ode “Erregen von Rückkopplungen” und die Methode “Versicherungspolice”, wie nachstehend beschrieben.

• Methode “Erregen von Rückkopplungen” - Mit dieser Methode wird die DFR als vorbeugendes Mittel 
gegen Rückkopplungen für Eingangskanäle eingesetzt, die nahe dem Rückkopplungspunkt arbeiten und 
eine zusätzliche Stabilitätsspanne erfordern. Dafür wird die Verstärkung des Eingangskanals über die nor-
male Einstellung angehoben, um absichtlich Rückkopplungen des Systems herbeizuführen. Die DFR stellt 
dann die erforderlichen Filter ein. Wenn anschließend die Eingangsverstärkung auf den normalen Pegel 
abgesenkt wird, ist das System stabil und einsatzbereit.

• Methode “Versicherungspolice” - Bei dieser Methode wird die DFR als zusätzliche Versicherung gegen 
unerwarteten Rückkopplungen in einem ansonsten stabilen System eingesetzt. Dafür wird der DFR-Proz-
essor einfach in den Signalweg eingefügt, ohne irgendwelche Einstellungen zu definieren. Dieses Ver-
fahren wird für Anlagen verwendet, die bereits eine hinreichende Verstärkung vor Rückkopplung 
aufweisen, aber Schutz vor gelegentlichen Rückkopplungen benötigen, die aufgrund von ortsveränderli-
chen Mikrofonen oder vom Benutzer verstellbaren Pegelstellern auftreten kann.

So wird die Methode “Erregen von Rückkopplungen” angewandt: 
1. Aktive Filter durch Klicken auf die Schaltfläche [CLEAR] (Löschen) entfernen.
2. Das Dialogfeld “Clear” (Löschen) wird eingeblendet.
3. [Clear All Filters] (Alle Filter löschen) wählen und auf [OK] klicken.
4. Alle Mikrofone hochfahren. 
5. Die Verstärkung der Beschallungsanlage langsam steigern, während die Mikrofone besprochen werden, 

bis es bei der ersten Frequenz zu einer Rückkopplung kommt. Die DFR stellt dann einen Bandsperrfilter 
ein, um die entsprechende Frequenz zu dämpfen. 

6. Nachdem die Anlage die Rückkopplung unterbunden hat, kann damit fortgefahren werden, den Pegel 
weiter zu steigern und den Vorgang für weitere Frequenzen zu wiederholen. Normalerweise kann der 
Pegel bis auf 3 dB bis 9 dB über den Pegel gesteigert werden, bei dem zuerst eine Rückkopplung auftrat.

7. Die zugeschalteten Filter als “fixed” (fest) zuweisen (siehe folgenden Abschnitt über die Filterzuweisung). Die 
restlichen dynamischen Filter kommen während der Verwendung des Systems nach Bedarf zum Einsatz. 

Prozessor verknüpft

Prozessor nicht verknüpft

Hinweis: Die festen Filter können in einen PEQ-Block kopiert werden, um mehr dynamische Filter im DFR-
Fenster zu haben.
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Digitale Rückkopplungsreduzier-Stufe (DFR)
Filterzuweisung
Als Voreinstellung ist die Hälfte der DFR-Prozessorfilter fest und die Hälfte dynamisch zugewiesen. Es kann
jedoch angegeben werden, wie viele aller Bandsperrfilter fest bleiben und wie viele bei Erkennen von Rückko-
pplung dynamisch zugewiesen werden. In Eingangskanälen für stationäre Mikrofone sollte eine größere
Anzahl von festen Filtern verwendet werden. In diesem Fall bestimmt die Raumakustik die dominanten Rück-
kopplungsfrequenzen, die sich nicht merklich verändern. In Eingangskanälen für drahtlose oder Hand-Mikro-
fone sollte eine größere Anzahl von dynamischen Filtern verwendet werden. In dieser Situation verändern sich
die Rückkopplungsfrequenzen drastisch, wenn der Benutzer des Mikrofons sich im Raum oder auf der Bühne
bewegt. Sowohl feste als auch dynamische Filter werden automatisch vertieft, wenn Rückkopplungen festges-
tellt werden.

• Fixed (Fest) - Nachdem die Frequenz eines festen Filters eingestellt wurde, ändert sie sich nur, wenn alle 
Filter manuell gelöscht werden.

• Dynamic (Dynamisch) - Wenn alle Rückkopplungsfilter eingesetzt wurden und neue Rückkopplungsfre-
quenzen erkannt werden, setzt die DFR jeden der dynamischen Filter erneut bei der neu erkannten Fre-
quenz ein. Die Reihenfolge ist dabei vom ältesten zum jüngsten dynamischen Filter.

Das zahlenmäßige Verhältnis der festen zu den dynamischen Filtern
lässt sich mit einer der beiden nachstehend beschriebenen Techni-
ken bestimmen: 

So wird das Dialogfeld “Fixed” (Fest) verwendet:
1. [Options>Fixed filters allocation] (Optionen>Feste Filter 

zuweisen) im Menü des DFR-Fensters wählen.
2. Das Dialogfeld “Fixed” wird eingeblendet 

(siehe Abb. 7-11 rechts).
3. Die Anzahl der festen Filter eingeben, die zugewiesen werden 

sollen. Die Anzahl der dynamischen Filter ändert sich entsprechend.
4. Auf [OK] klicken.

So wird die Filterzuweisung mit der Maus geändert:
1. Den Cursor zwischen den roten Klammern positionieren 

(siehe Abb. 7-12).
2. Der Cursor ändert seine Form zum Symbol für horizontale 

Größenänderung: 
3. Klicken und nach links ziehen, um die Anzahl der dynamischen Filter zu 

erhöhen, oder nach rechts, um die Anzahl der festen Filter zu erhöhen.

Hinweis: Um Filter von der Frontplatte aus zuzuweisen, auf die Schalt-
fläche “Auto Clear” (Automatisch löschen) klicken, um alle derzeit 
aktiven Filter fest und alle derzeit inaktiven Filter dynamisch zu 
machen. Weitere Informationen über die Verwendung der Bedi-
enelemente auf der Frontplatte des DFR22 siehe Installation 
Guide (Installationsanleitung).

ABBILDUNG 7-11: Dialogfeld “Fixed” (Fest)

Cursor hier positionieren ...

...oder hier

ABBILDUNG 7-12: Ändern der 
Filterzuweisung mit der Maus
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Digitale Rückkopplungsreduzier-Stufe (DFR)
Filter mit hohem bzw. niedrigem Q-Faktor
Die DFR bietet zwei Breitenoptionen für Bandsperrfilter (siehe Abb. 7-13 unten). Als Voreinstellung werden die
Filter in der DFR als [HIGH Q]-Filter (mit hohem Q-Faktor) eingesetzt. Je tiefer ein Filter mit hohem Q-Faktor
wird, desto weiter steigt der zugehörige Q-Faktor bis 101 (1/70 einer Oktave).

Es ist auch möglich, Filter als [LOW Q] (mit niedrigem Q-Faktor) einzusetzen.
Filter mit niedrigem Q-Faktor wirken sich auf einen etwas breiteren Frequen-
zbereich aus, indem bei ihnen mit zunehmender Tiefe ein Q-Faktor von
14,42 (1/10 einer Oktave) beibehalten wird.

• Zum Ändern der Einstellungen für einen vorhandenen Filter den Filter 
durch Klicken wählen und dann das Pulldown-Menü [TYPE] (Typ) ver-
wenden.

• Im Menü [Options] wählen, ob alle neu eingesetzten dynamischen Filter 
den hohen oder niedrigen Q-Faktor erhalten sollen.

Filter hinzufügen, ändern und entfernen

So wird ein fester Bandsperrfilter manuell eingesetzt oder geändert:
1. Einen aktiven festen Filter (gelb markiert) durch Klicken wählen oder, um einen neuen Filter zu aktivieren, 

den Filter unmittelbar rechts neben dem letzten aktiven Filter wählen.
2. Die Frequenz, die Tiefe und den Typ nach Erfordernis einstellen.
3. Die Änderungen wirken sich im Frequenzgang-Diagramm aus.

So werden alle aktiven Bandsperrfilter entfernt:
1. Auf die Schaltfläche [CLEAR] (Löschen) klicken.
2. Das Dialogfeld “Clear” (Löschen) wird geöffnet (siehe Abb. 7-14).
3. [Clear All Filters] (Alle Filter löschen) wählen und auf [OK] klicken.
4. Dadurch werden alle Bandsperrfilter entfernt, sodass das Frequen-

zgang-Diagramm linear wird.

- ODER -

1. Die Menüoption [Edit>Select All] (Bearbeiten>Alles wählen) verwenden.
2. Alle eingesetzten Filter werden rosa markiert, um anzuzeigen, dass sie 

gewählt sind.
3. Die Taste Entf drücken.

So werden einzelne Bandsperrfilter entfernt:
1. Auf einen Filter klicken, um ihn zu wählen, oder mit Strg + Klicken mehrere Filter wählen.
2. Die Taste Entf drücken oder auf die Schaltfläche [CLEAR] klicken, um das Dialogfeld “Clear” zu öffnen, und 

die Option [Clear Selected Filter(s)] wählen.

Kopieren und Einfügen
Die Einstellungen für Bandsperrfilter können zwischen DFR-Prozessorfenstern kopiert und eingefügt werden.
Die DFR22 Software bietet außerdem die Möglichkeit, aktive Filter aus dem DFR-Fenster in das Fenster eines
parametrischen Equalizers (PEQ oder PEQ + CS) zu kopieren. Indem feste Filter in ein PEQ-Fenster ver-
schoben werden, können mehr dynamische Filter im DFR-Block zugewiesen werden. Durch Kopieren von Fil-
tern aus der DFR in einen PEQ und anschließendes Löschen des DFR-Blocks kann DSP-Kapazität eingespart
werden.

Hinweis: Nur ein aktiver Filter oder der nächste inaktive Filter von links nach rechts 
kann gewählt werden.

Hinweis: Die Bandbreite von DFR-Filtern, die in einen PEQ-Block kopiert wurden, stimmen u. U. 
nicht genau mit dem ursprünglichen Filter überein, sondern verwenden eine Bandbreite, 
die der des ursprünglichen Filters am nächsten liegt.

Hoher 

Niedrig
ABBILDUNG 7-13: Breitenoptionen für 

Bandsperrfilter

ABBILDUNG 7-14: Dialogfeld “Clear” 
(Löschen)
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Digitale Rückkopplungsreduzier-Stufe (DFR)
So werden Filter kopiert und eingefügt:
1. Durch Klicken einen Filter wählen oder mit einer der nachstehenden Methoden mehrere Filter wählen:

• Bei gedrückter Taste Strg  auf die einzelnen Filter klicken, die gewählt werden sollen.
• Die Menüoption [Edit>Select All] (Bearbeiten>Alles wählen) verwenden.

2. Die Menüoption [Edit>Copy] (Bearbeiten>Kopieren) verwenden.
3. Das DFR- bzw. PEQ-Prozessorfenster öffnen, in das die Filtereinstellungen eingefügt werden sollen. Sich-

erstellen, dass ein Prozessorblock mit genügend Filtern für die soeben kopierten Filter gewählt wurde.
4. Die Menüoption [Edit>Paste] (Bearbeiten>Einfügen) verwenden.

Auto Clear (Automatisch löschen)
Als Voreinstellung speichert der digitale Rückkopplungsunterdrücker (DFR) den Zustand seiner Filter während
einer Voreinstellung-Umschaltung oder eines Ein-/Ausschaltvorgangs. Die DFR kann jedoch so konfiguriert wer-
den, dass dynamische Filter und Änderungen der Tiefe fester Filter automatisch gemäß Parametern entfernt
werden, die im Dialogfeld “Auto Clear” (Automatisch löschen) angegeben werden (siehe Abb. 7-15 unten). Der
Zugriff auf dieses Dialogfeld erfolgt durch Klicken auf die Schaltfläche [AUTO CLEAR] im DFR-Fenster.

Nach dem Aktivieren des Kontrollkästchens [Enable Auto Clear] (Automatisch löschen aktivieren) im Dialogfeld
“Auto Clear” kehren die DFR-Filter bei einer Voreinstellung-Umschaltung oder einem Ein-/Ausschaltvorgang zu
dem Zustand zurück, in dem sie sich bei der Aktivierung der Option “Auto Clear” befanden. Außerdem kann ein
Zeitraum angegeben werden, nach dem alle dynamischen Filter und alle Änderungen der Tiefe fester Filter
entfernt werden.

So wird die Option “Auto Clear” aktiviert:
1. Rückkopplungen im System erregen, wie im Abschnitt Grundleg-

ende DFR-Einrichtung auf Seite 69 beschrieben.
2. Alle aktiven Filter auf [FIXED] setzen, wie im Abschnitt 

Filterzuweisung auf Seite 70 beschrieben.
3. Auf die Schaltfläche [AUTO CLEAR] klicken.
4. Das Dialogfeld “Auto Clear” wird geöffnet (siehe Abb. 7-15).
5. Das Kontrollkästchen [Enable Auto Clear] aktivieren.
6. Wenn alle Filter nach einem bestimmten Zeitraum geändert wer-

den sollen, das Kontrollkästchen [on timeout] (nach Zeitüber-
schreitung) aktivieren und einen Zeitraum von 0,1 bis 99,9 
Stunden angeben. Die Voreinstellung ist 12 Stunden. Jeder Filter 
verfügt über eine eigene Zeiterfassung. Diese beginnt mit dem 
Zeitpunkt, zu dem der Filter eingesetzt oder vertieft wird.

7. Auf [OK] klicken.
8. Die Schaltfläche [AUTO CLEAR] im DFR-Fenster wird grün markiert, wenn die Funktion aktiv ist.

So wird die Option “Auto Clear” deaktiviert:
1. Auf die Schaltfläche [AUTO CLEAR] klicken.
2. Im Dialogfeld “Auto Clear” das Kontrollkästchen [Enable Auto Clear] deaktivieren. Die Steuerelemente für 

die Funktion “Auto Clear” werden abgeblendet dargestellt.
3. Auf [OK] klicken.
4. Die Schaltfläche [AUTO CLEAR] im DFR-Fenster ist abgeblendet und deaktiviert.

Hinweis: Wenn Filter Bestandteil einer Mehrfach-Auswahl sind, werden sie rosa markiert und ihre 
Parametereinstellungen gesperrt. Um die Wahl einer Mehrfach-Auswahl rückgängig zu 
machen, auf ein beliebiges Steuerelement außerhalb des Auswahlbereichs klicken.

Hinweis: Anweisungen zur Einstellung dieser Parameter mit den Bedienelementen auf der Frontplatte 
des DFR22 siehe Installation Guide (Installationsanleitung).

Hinweis: Nach der Ausführung dieser Schritte ist die Funktion “Auto Clear” nur für den derzeitigen DFR-Proz-
essor aktiviert. Wenn bei weiteren DFR-Prozessoren Filteränderungen automatisch gelöscht werden 
sollen, muss die Funktion “Auto Clear” im jeweiligen Parameterfenster aktiviert werden.

ABBILDUNG 7-15: Dialogfeld “Auto Clear”
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Ducker
Ducker

Der Ducker bietet ein einfaches Verfahren zur Verwendung des DFR22 in einem Audiosystem, das Durchsagefunk-
tionen erfordert. Wenn ein Durchsagesignal vorhanden ist, werden andere Signale vom Ducker abgeschwächt bzw. 
“untergetaucht”.

Funktion
Den Ducker auf einem Eingangsstreifen platzieren, um diesen Eingang als Durchsagesignal zu kennzeichnen.
Wenn das Durchsagesignal den angegebenen Schwellwert überschreitet, dämpft der Ducker alle anderen Sig-
nale, die an jedem der Ausgangsmischpunkte vorhanden sind, zu dem es geführt wird. Er dämpft keine Signale
an einem Mischpunkt, mit dem das Durchsagesignal nicht verbunden ist. Das Durchsagesignal kann im Sig-
nalflussdiagramm, im Fenster “Matrix Mixer” (Matrixmischer) oder durch Aktivieren der Kontrollkästchen [Pag-
ing Channel] (Durchsagekanäle) im Fenster “Ducker” zu Ausgabekanälen geführt werden.

Blockname Beschreibung
DUCK Ducker

Hinweis: Der Ducker kann nur auf einem Eingangskanalstreifen abgelegt werden. Es dürfen 
nicht mehrere Ducker auf demselben Kanal platziert werden. Um zu verhindern, 
dass Nebengeräusche auf dem Durchsageeingang hörbar werden, im Signalflussdi-
agramm vor dem Ducker ein Gate platzieren.

1

2

3

4

ABBILDUNG 7-16: Fenster DUCK (Ducker)
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Ducker
Merkmale des Parameterfensters

1) Übertragungskennlinie
Die Übertragungskennlinie zeigt den Schwellwert als grafisches Element an, das mit der Maus positioniert
werden kann.

2) Schwellwert-Schieberegler
Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser
Schieberegler am oberen Rand der Übertragungskennlinie kann mit der Maus nach links und rechts gezo-
gen werden, um die Schwellwert-Einstellung zu ändern.

3) Pegelabschwächungsanzeige
Hier wird die gesamte Pegelanhebung oder -abschwächung angezeigt, die beim bzw. bei den mit dem
Ducker gedämpften Signal(en) mit den derzeitigen Prozessoreinstellungen bewirkt wird. Diese Funktion
kann mit der Menüoption [Options>Gain Reduction Meter] (Optionen>Pegelabschwächungsanzeige) aus-
und eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet.

4) Übertragungskennlinien-Anzeige
Im Live-Modus stellt diese Anzeige den Eingangspegel des Durchsagesignals dar, damit der Schwellwert
über den Umgebungsgeräuschen eingestellt werden kann. Diese Funktion kann mit der Menüoption
[Options>Transfer Curve Meter] (Optionen>Übertragungskennlinien-Anzeige) aus- und eingeschaltet wer-
den. In der Voreinstellung ist sie eingeschaltet.

Anzeige Threshold Exceeded (Schwellwert überschritten)

Threshold (Schwellwert)
Hierdurch wird der Verstärkungspegel geregelt, den das Durchsagesignal erreichen muss,
bevor der Prozessor die vom Ducker bedämpften Signale abschwächt. Der Wert kann durch
Klicken auf die Drehpfeil-Schaltflächen oder Eingeben eines bestimmten Werts zwischen +20

dB und –60 dB geändert werden. Die Voreinstellung ist 0 dB.

Attenuation (Bedämpfung)
Hierdurch wird die Pegelabschwächung geregelt, die auf die vom Ducker bedämpften Signale
angewendet wird, wenn das Durchsagesignal den Schwellwert überschreitet. Dieser Wert
kann durch Klicken auf die Drehpfeil-Schaltflächen oder Eingeben eines bestimmten Werts

zwischen –1 dB und –INF (unendlich) geändert werden. Die Voreinstellung ist –40 dB.

Attack (Ansprechzeit)
Hierdurch wird die Zeit geregelt, die der Prozessor benötigt, um den Verstärkungspegel der
vom Ducker bedämpften Signale völlig abzuschwächen, nachdem das Durchsagesignal den
Schwellwert überschreitet. Die Ansprechzeit kann durch Klicken auf die Drehpfeil-Schalt-

flächen oder Eingeben eines bestimmten Werts geändert werden. Der Bereich verfügbarer Werte erstreckt
sich von 1 bis 5000 ms.

Hinweis: Wenn viele Anzeigen in der Audioprozessor-Software aktiv sind, kann die Leistung der 
DFR22 Software beeinträchtigt sein. Die Übertragungskennlinien-Anzeige oder die Ver-
stärkungsreduzierungs-Anzeige können einzeln oder beide im Menü [Options] ausge-
schaltet werden.

Signalpegel hat den Schwellwert überschritten Diese Anzeige leuchtet gelb, wenn das 
Eingangssignal zum Prozessorblock den 
vorgegebenen Schwellwert überschreitet.Signalpegel hat den Schwellwert nicht erreicht
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Ducker
Hold (Halten)
Hierdurch wird die Zeit geregelt, während der der Prozessor die vom Ducker bedämpften Sig-
nale weiterhin abschwächt, nachdem das Durchsagesignal wieder unter den Schwellwert
abgefallen ist. Dieser Wert kann durch Klicken auf die Drehpfeil-Schaltflächen oder Eingeben

eines bestimmten Werts geändert werden. Der Bereich verfügbarer Werte erstreckt sich von 1 ms bis
10.000 ms.

Release (Freigabe)
Hierdurch wird die Zeit geregelt, die der Prozessor benötigt, um den vorherigen Pegel der vom
Ducker bedämpften Signale wiederherzustellen, nachdem die Haltezeit verstrichen ist. Dieser
Wert kann durch Klicken auf die Drehpfeil-Schaltflächen oder Eingeben eines bestimmten

Werts geändert werden. Der Bereich verfügbarer Werte erstreckt sich von 1 ms bis 10.000 ms.

Default (Voreinstellung)
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen
zurückgesetzt.

Bypass (Umgehung)

Paging Channels (Durchsagekanäle)

Markieren Sie das Kästchen neben jedem Ausgang, zu dem das 
Durchsagesignal geführt werden soll. Dies entspricht der Verwendung des 

Signalflussdiagramms oder des Matrixmischers zur Führung des Signals von dem betreffenden Eingang 
zu den Ausgängen. Etwaige andere Signale, die zu dem (den) gewählten Ausgangsmischpunkt(en) 
geführt werden, werden vom Durchsagesignal gedämpft.

Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Umgehung aktiv Durch Klicken auf diese Schaltfläche wird ein Signal 
unverändert belassen. Wenn die Umgehung aktiv ist, wird die 
Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv.Umgehung inaktiv

Prozessor verknüpft

Prozessor nicht verknüpft
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Gate/Abwärts-Expander
Gate/Abwärts-Expander

Gates und Abwärts-Expander reduzieren den Ausgangspegel des Signals relativ zum Eingangspegel, nachdem der 
Eingangspegel unter einen vorgegebenen Schwellwert abfällt.

Funktion
Diese Prozessoren dienen zum Reduzieren oder Beseitigen von unerwünschten Hintergrundgeräuschen. Das
Gate schaltet das Eingangssignal stumm, wenn es unter einen vorgegebenen Schwellwert abfällt. Der
Abwärts-Expander verringert die Verstärkung langsam, nachdem das Eingangssignal unter den vorgegebenen
Schwellwert abgefallen ist, und bewirkt damit eine unauffälligere Pegelreduzierung als das Gate. Das Gate ist
ideal, wenn niedrigpegelige Geräusche beseitigt werden müssen, die sonst vom Programmmaterial ablenken
würden. Der Abwärts-Expander bietet sich in Situationen an, um das Hintergrundgeräusch etwas zu
reduzieren, in denen eine vollständige Beseitigung des Signals als Unterbrechung des Programms auffallen
würde.

Merkmale des Parameterfensters
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente des Abwärts-Expanders und Gates,
wobei der DOWN EXP als Beispiel dient (siehe Abb. 7-17). Diese beiden Prozessoren sind sich sehr ähnlich in
der Verwendung. Unterschiede in ihren Merkmalen und ihrer Funktionalität werden gegebenenfalls erwähnt.

Blockname Beschreibung
DOWN EXP Abwärts-Expander
GATE Gate

1

2 3

4

56
ABBILDUNG 7-17: DOWN EXP-Fenster
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Gate/Abwärts-Expander
1) Übertragungskennlinie
Die Übertragungskennlinie zeigt die Einstellungen für den Schwellwert und den Kompressionsgrad als
grafische Elemente an, die mit der Maus positioniert werden können. Die resultierende Übertragung-
skennlinie repräsentiert die Änderung im Signalausgangspegel.

2) Schwellwert-Schieberegler
Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser
Schieberegler am oberen Rand der Übertragungskennlinie kann mit der Maus nach links und rechts gezo-
gen werden, um die Schwellwert-Einstellung zu ändern.

3) Pegelabschwächungsanzeige
Hier wird die gesamte Pegelanhebung oder -abschwächung angezeigt, die im Eingangssignal mit den jew-
eiligen Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menüoption [Options>Gain
Reduction Meter] (Optionen>Pegelabschwächungsanzeige) aus- und eingeschaltet werden. In der Vorein-
stellung ist sie eingeschaltet.

4) Pegelsteller
Mit den Pegelstellern werden die Eingangs- und Ausgangspegel geregelt. Der Bereich der verfügbaren
Verstärkungswerte liegt zwischen –12 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung.
Der Wert kann mit den Methoden verändert werden, die im Abschnitt Fader auf Seite 34 erläutert werden.

5) Übertragungskennlinien-Anzeige
Im Live-Modus stellt die Anzeige die Eingangspegel und relativen Ausgangspegel des Signals dar, sodass
die Auswirkungen des Prozessors auf das jeweilige Programmmaterial ersichtlich sind. Diese Funktion
kann mit der Menüoption [Options>Transfer Curve Meter] (Optionen>Übertragungskennlinien-Anzeige)
aus- und eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet.

6) Kompressionsgrad-Schieberegler
Die Position des Kompressionsgrad-Schiebereglers entspricht der Einstellung der Kompressionsgrad-
Steuerung. Zum Ändern der Kompressionsgrad-Einstellung diesen Schieberegler am unteren Rand der
Übertragungskennlinie mit der Maus nach links und rechts ziehen.

Anzeige Threshold Exceeded (Schwellwert überschritten)

Threshold (Schwellwert)
Hier wird der Pegel angezeigt, unter den die Eingangssignalverstärkung fallen muss, bevor
der Prozessor sie verringert. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen,
Eingeben eines Werts oder Betätigung des Schwellwert-Schiebereglers am oberen Rand
der Übertragungskennlinie geändert werden. Der verfügbare Wertebereich reicht von –80,0
dB bis 0 dB in Schritten von 0,5 dB mit einer Voreinstellung von –65,0 dB für das Gate und

–40,0 dB für den Abwärts-Expander.

Hinweis: Wenn viele Anzeigen in der Audioprozessor-Software aktiv sind, kann die Leistung der 
DFR22 Software beeinträchtigt sein. Die Übertragungskennlinien-Anzeige oder die Ver-
stärkungsreduzierungs-Anzeige können einzeln oder beide im Menü [Options] ausge-
schaltet werden.

Signalpegel hat den Schwellwert überschritten Diese Anzeige leuchtet gelb, wenn das 
Eingangssignal zum Prozessorblock den 
vorgegebenen Schwellwert überschreitet.Signalpegel hat den Schwellwert nicht erreicht
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Gate/Abwärts-Expander
Ratio (Kompressionsgrad)
Hier wird der Betrag der Verstärkungsreduzierung am Ausgang des Prozessors relativ zum
Eingangspegel angegeben. Ein Verhältnis von 4:1 bedeutet z. B., dass eine Verringerung
von 1 dB im Pegel des Programmmaterials eine Verringerung des Prozessorausgangspe-

gels von 4 dB bewirkt. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen, Eingeben eines Werts
oder Betätigung des Kompressionsgrad-Schiebereglers am unteren Rand der Übertragungskennlinie
geändert werden. Der verfügbare Wertebereich reicht von 1:1 bis INF:1 in Schritten von 1/10 mit einer Vor-
einstellung von INF:1 für das Gate und 4:1 für den Abwärts-Expander.

Attack (Ansprechzeit)
Hier wird angegeben, wie lange der Prozessor wartet, bis er zum Arbeitspegel zurückkehrt,
nachdem der Eingangssignalpegel den Schwellwert überschritten hat. Die verfügbaren
Werte reichen von 1 ms bis 200 ms mit einer Voreinstellung von 2 ms für das Gate und 20

ms für den Abwärts-Expander.

Decay (Abklingzeit)
Hier wird angegeben, wie lange der Prozessor benötigt, um die vorgegebene Pegelreduz-
ierung zu erreichen. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen oder
Eingeben eines Werts geändert werden. Der verfügbare Wertebereich reicht von 50 ms bis

1000 s mit einer Voreinstellung von 100 ms für das Gate und 50 ms für den Abwärts-Expander.

Hold (Halten)
Hier wird angegeben, wie lange der Prozessor wartet, bis er anfängt den Pegel zu verrin-
gern, nachdem der Eingangssignalpegel unter den Schwellwert gefallen ist. Der Wert kann
durch Klicken auf die Drehpfeil-Schaltflächen oder Eingeben eines Werts geändert werden.

Der verfügbare Wertebereich erstreckt sich von 0 ms bis 500 ms mit einer Voreinstellung von 0 ms.

Default (Voreinstellung)
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen
zurückgesetzt.

Bypass (Umgehung)

Snapshot (Momentaufnahme)
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-Kennlinie,
indem auf die Schaltfläche [TAKE] (Aufnehmen) geklickt wird. Durch Klicken auf die Schaltfläche
[SHOW] (Anzeigen) wird die Aufnahme dann im Hintergrund für Vergleichszwecke angezeigt.
Die Schaltfläche [SHOW] wird grün markiert, wenn die Momentaufnahme angezeigt wird. Aus-
führliche Beschreibung der Momentaufnahme-Funktion siehe Abschnitt Momentaufnahmen auf
Seite 36.

Umgehung aktiv Durch Klicken auf diese Schaltfläche wird ein Signal 
unverändert belassen. Wenn die Umgehung aktiv ist, wird die 
Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv.Umgehung inaktiv
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Grafischer Equalizer
Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Grafischer Equalizer

Grafische Equalizer verfügen über einen festen Satz von Breitband-Filtern mit konstantem Q-Faktor, die über das Fre-
quenzspektrum verteilt sind und jeweils individuelle Regler für Anhebung/Absenkung aufweisen. Der Audioprozessor 
bietet die folgenden Typen von grafischen Equalizern:

Funktion
Dieser Prozessor dient für praktische Breitband-Entzerrung in Räumen. Die Gesamt-Bandbreite und die Band-
breite der einzelnen Filter ist vom Typ des gewählten grafischen Equalizers abhängig. Der GEQ10 verfügt über
zehn 1-Oktave-Filter zwischen 31,5 Hz und 16 kHz, während der GEQ30 dreißig 1/3-Oktave-Filter zwischen 25
Hz und 20 kHz aufweist. Der GEQ10 wird in Abb. 7-18 oben dargestellt.

Prozessor verknüpft

Prozessor nicht verknüpft

Blockname Beschreibung
GEQ10 Grafischer Equalizer mit 10 Bändern
GEQ30 Grafischer Equalizer mit 30 Bändern

1

2

ABBILDUNG 7-18: GEQ10-Fenster
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Grafischer Equalizer
Merkmale des Parameterfensters
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente der grafischen Equalizer, wobei
GEQ10 als Beispiel dient. Der GEQ30 ist mit Ausnahme der Anzahl der Bänder und des Gesamt-Frequen-
zbereichs identisch. 

1) Frequenzband-Fader
Die Frequenzbereich-Fader werden eingestellt, indem der Knopf mit der Maus nach oben und unten gezo-
gen oder indem am gewünschten Pegel auf die Skala geklickt wird. Jedes Frequenzband kann zwischen –
18 dB und +12 dB in Schritten von 0,5 dB abgesenkt oder angehoben werden. Weitere Informationen zum
Einstellen der Fader siehe Abschnitt Fader auf Seite 34.

2) Frequenzgangdiagramm
Diese Kennlinie ist eine grafische Darstellung der Ergebnisse der Frequenzband-Einstellungen und des
gewählten Typs des Filter-Q-Faktors.

Frequenz
Hier wird das Frequenzband angegeben, das eingestellt wird. Durch Klicken auf die
Drehpfeil-Tasten kann ein anderes Frequenzband gewählt werden. Die Voreinstellung
ist das unterste Frequenzband.

Gain (Verstärkung)
Hier wird die aktuelle Verstärkungseinstellung des gewählten Frequenzbands angege-
ben. Der Bereich der verfügbaren Verstärkungswerte liegt zwischen –18 dB und +12
dB in Schritten von 0,5 dB mit einer Voreinstellung von 0 dB. Der Wert kann mit den
Methoden verändert werden, die im Abschnitt Fader auf Seite 34 erläutert werden. 

Typ des Filter-Q-Faktors
Hier wird der Typ des Filter-Q-Faktors angegeben, der für alle Frequenzbänder
eingestellt ist. Der Wert wird über die Dropdown-Liste geändert. Die Voreinstel-

lung ist “COMBINING”(Kombinierend).

Bypass (Umgehung)

Linear
Auf diese Schaltfläche klicken, um die Verstärkung aller Frequenzbänder auf null zu stellen.

Hinweis: Die Kurve enthält nicht die summierten Wirkungen der verschiedenen Prozessorblöcke im Sig-
nalflussdiagramm. Zum Anzeigen einer kombinierten Kurve [View>Combined Response 
Curve] (Ansicht>Kombinierte Frequenzgang-Kennlinie) aus dem Hauptmenü wählen. Weitere 
Informationen siehe Abschnitt Kombiniertes Frequenzgangdiagramm auf Seite 39.

COMBINING
Die Flanken zwischen den Frequenzbändern werden gemittelt, 
sodass eine insgesamt glatte Entzerrungskurve entsteht.

NON-COMBINING
Die Ergebnisse der einzelnen Frequenzbandsteller werden 
voneinander isoliert, wodurch die Verstärkungsregelung unab-
hängiger wird.

Umgehung aktiv Durch Klicken auf diese Schaltfläche wird ein Signal unverändert 
belassen. Wenn die Umgehung aktiv ist, wird die Schaltfläche rot 
angezeigt. Die Voreinstellung ist inaktiv.Umgehung inaktiv
© 2003 Shure Incorporated DFR22-Software-Bedienungsanleitung 80



Grafischer Equalizer
Snapshot (Momentaufnahme)
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-Kennlinie,
indem auf die Schaltfläche [TAKE] (Aufnehmen) geklickt wird. Durch Klicken auf die Schaltfläche
[SHOW] (Anzeigen) wird die Aufnahme dann im Hintergrund für Vergleichszwecke angezeigt.
Die Schaltfläche [SHOW] wird grün markiert, wenn die Momentaufnahme angezeigt wird. Aus-
führliche Beschreibung der Momentaufnahme-Funktion siehe Abschnitt Momentaufnahmen auf
Seite 36.

Importieren von ASCII-Dateien
Diese Funktion ermöglicht das Importieren von Frequenzdaten aus SIA Smaart und Gold
Line TEF in das Frequenzgangdiagramm. Die grafischen Daten im Diagramm können bei
der Gestaltung der Frequenzgang-Kennlinie des Prozessors als Referenz verwendet wer-
den. Anweisungen zur Verwendung der ASCII-Importfunktion siehe Seite 37.

Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Kopieren und Einfügen
Mit dem Menü [Edit] (Bearbeiten) können Frequenzband-Einstellungen zwischen grafischen Equalizer des
gleichen Typs kopiert und eingefügt werden.

Prozessor verknüpft

Prozessor nicht verknüpft

Hinweis: Es ist nicht möglich, Einstellungen zwischen den Prozessoren GEQ10 und 
GEQ30 zu kopieren.
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Parametrischer Equalizer
Parametrischer Equalizer

Parametrische Equalizer gestatten es, die Anordnung, den Typ und die Bandbreite von mehreren Filtern an beliebigen 
Positionen im Frequenzspektrum zwischen 25 Hz und 20 kHz vorzugeben. Der System-Prozessor bietet die folgenden 
Typen von parametrischen Equalizern:

Funktion
Dieser Prozessor dient für präzise Entzerrung des Raum-Frequenzgangs ohne unnötige Beeinträchtigung der
benachbarten Frequenzen. Einen parametrischen Equalizer danach wählen, wie viele Frequenzbänder eingest-
ellt werden müssen und ob der Prozessor Filter mit steilflankiger oder Kuhschwanz-Charakteristik enthalten soll.
Wenn nur so wenig Filter eingesetzt werden, wie wirklich gebraucht werden, lässt sich DSP-Kapazität einsparen.

Blockname Beschreibung
PEQ3

Diese Prozessoren verfügen nur über Spitzenwert-/Bandsperrfilter.PEQ5
PEQ7

PEQ10

PEQ3+CS
Diese Prozessoren verfügen über Spitzenwert-/Bandsperrfilter sowie einen Nied-
erfrequenz-Filter mit steilflankiger oder Kuhschwanz-Charakteristik oder einen 
Hochfrequenz-Filter mit steilflankiger oder Kuhschwanz-Charakteristik.

PEQ5+CS
PEQ7+CS

PEQ10+CS

Hinweis: Die Zahl im Blocknamen gibt die maximale Anzahl der für diesen Prozessor verfügbaren 
Spitzenwert-/Bandsperrfilter an.

1

2

3 4

6

ABBILDUNG 7-19: Fenster PEQ10 + CS

5
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Parametrischer Equalizer
Merkmale des Parameterfensters
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente der parametrischen Equalizer, wobei
der PE10+CS (siehe Abb. 7-19 auf der vorigen Seite) als Beispiel dient. Die Merkmale der anderen parame-
trischen Equalizer unterscheiden sich hiervon nur in der Anzahl der Bänder und der Verfügbarkeit von Filtern
mit steilflankiger/Kuhschwanz-Charakteristik.

1) Frequenzgangdiagramm
Diese Kennlinie ist eine grafische Darstellung der kombinierten Ergebnisse der Filterpunkte und Zieh-
punkte im Frequenzgang-Plotter.

2) Frequenzgang-Plotter
Dies ist der Bereich des Parameterfensters, in dem parametrische Filter angeordnet und eingestellt wer-
den. Die Spitzenwert-/Bandsperrfilter werden grafisch als Punkte und die Filter mit steilflankiger/Kuh-
schwanz-Charakteristik als quadratische Ziehpunkte dargestellt. Beim ersten Öffnen des
Prozessorfensters enthält der Frequenzgang-Plotter keine Filterpunkte, und die Filter mit steilflankiger/
Kuhschwanz-Charakteristik, falls verfügbar, erscheinen in ihren Voreinstellpositionen. Durch Klicken auf
einen Filterpunkt oder Ziehpunkt wird seine Frequenzgang-Kennlinie angezeigt und es können Einstellun-
gen vorgenommen werden. Anweisungen zum Hinzufügen von Filterpunkten siehe Abschnitt Mit Filtern
arbeiten auf Seite 85.

3) Filterpunkte
Spitzenwert-/Bandsperrfilter werden im Frequenzgang-Plotter als Filterpunkte mit einstellbaren Bandbre-
iten-Steuerelementen an beiden Seiten dargestellt. Einmal auf einen Filterpunkt klicken, um ihn zu wählen,
und dann seine Einstellungen mit der Maus, den Tastatur-Tasten oder den Wertefeldern ändern.

4) Gewählter Filter
Wenn ein Filter Teil einer Auswahl ist, wird er grün markiert. Auch die zugehörige derzeitige Kurve wird
entlang des Frequenzgangdiagramms relativ zu Null grün markiert.

5) Ziehpunkt für Filterbreite
Auf diese Ziehpunkte klicken und nach links oder rechts ziehen, um den gewählten Filter zu verengen bzw.
zu verbreitern. Die Position dieser Ziehpunkte entsprechen den Werten im Steuerelement [WIDTH] (Breite).

6) Filter mit steilflankiger/Kuhschwanz-Charakteristik
Die Hoch- und Niederfrequenz-Filter mit steilflankiger/Kuhschwanz-Charakteristik werden als quadratische
Ziehpunkte angezeigt. Jeder Ziehpunkt lässt sich abhängig von seiner vertikalen Position im Frequen-
zgang-Plotter als Filter mit steilflankiger oder Kuhschwanz-Charakteristik einsetzen. Beim ersten Öffnen
des Parameterfensters fungieren die Ziehpunkte als Hoch- und Niederfrequenz-Filter mit Kuhschwanz-
Charakteristik mit einer Voreinstellung von 0 dB bei 20 kHz bzw. 25 Hz. Sie verwandeln sich in Filter mit
steilflankiger Charakteristik, wenn sie zum unteren Rand des Frequenzgang-Plotters gezogen werden.

Frequenz
Hier wird die Frequenz des gewählten Filterpunktes angezeigt. Der Wert kann durch
Klicken auf die Drehpfeil-Schaltflächen, Verwendung von Tasten der Tastatur oder

Eingeben eines Werts geändert werden. Der Frequenzbereich reicht von 25 Hz bis 20 kHz mit einer Vore-
instellung von 1 kHz, wenn ein neuer Filterpunkt hinzugefügt wird.

Hinweis: Die Kurve enthält nicht die summierten Wirkungen der verschiedenen Prozessorblöcke im 
Signalflussdiagramm. Zum Anzeigen einer kombinierten Kurve [View>Combined Response 
Curve] (Ansicht>Kombinierte Frequenzgang-Kennlinie) aus dem Hauptmenü wählen. Weitere 
Informationen siehe Abschnitt Kombiniertes Frequenzgangdiagramm auf Seite 39.
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Width/Slope/Type (Breite/Flanke/Typ)
Dieser Regelbereich ändert sich in Abhängigkeit vom Typ des gewählten Filters, wie unten angeführt. Für
einen Filter mit steilflankiger Charakteristik bietet das Dropdown-Menü zwei Flanken zur Auswahl. Wenn
ein Spitzenwert-/Bandsperrfilter gewählt ist, kann das Dropdown-Menü mit voreingestellten Werten ver-
wendet oder die Breite innerhalb einer tausendstel Oktave eingegeben werden. Dieses Steuerelement
enthält keine Einstellungen für Filter mit Kuhschwanz-Charakteristik.

Gain (Verstärkung)
Hier wird die aktuelle Verstärkungseinstellung des gewählten Filters angegeben. Der
Bereich der verfügbaren Verstärkungswerte liegt zwischen –18 dB und +18 dB in Schrit-

ten von 0,5 dB mit einer Voreinstellung von 0 dB. Beim Arbeiten mit einem Filter mit steilflankiger Charak-
teristik ist dieses Steuerelement deaktiviert, dann wird das Wort “CUT” angezeigt.

New (Neu)
Auf diese Schaltfläche klicken, um dem Frequenzgang-Plotter einen neuen Spitzenwert-/Band-
sperrfilter hinzuzufügen. Beim ersten Öffnen des Fensters gibt die Zahl unter dieser Schaltfläche
die Anzahl der Filterpunkte an, die für den gewählten parametrischen Equalizer verfügbar sind.
Sie verringert sich, wenn dem Frequenzgang-Plotter Filterpunkte hinzugefügt werden. Beim
Erreichen der maximalen Anzahl von Filtern für den Prozessor wird die Schaltfläche deaktiviert.

Clear (Löschen)
Auf diese Schaltfläche klicken, um die Filtereinstellungen zu löschen. Dann wird das Dialogfeld
“Clear” (Löschen) eingeblendet, das die Option bietet, alle oder nur ausgewählte Filterpunkte aus

dem Frequenzgang-Plotter zu löschen. Weitere Informationen siehe Abschnitt Mit Filtern arbeiten auf
Seite 85.

Bypass (Umgehung)

Snapshot (Momentaufnahme)
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-Kennlinie,
indem auf die Schaltfläche [TAKE] (Aufnehmen) geklickt wird. Durch Klicken auf die Schaltfläche
[SHOW] (Anzeigen) wird die Aufnahme dann im Hintergrund für Vergleichszwecke angezeigt. Die
Schaltfläche [SHOW] wird grün markiert, wenn die Momentaufnahme angezeigt wird. Ausführli-
che Beschreibung der Momentaufnahme-Funktion siehe Abschnitt Momentaufnahmen auf
Seite 36.

Importieren von ASCII-Dateien
Diese Funktion ermöglicht das Importieren von Frequenzdaten aus SIA Smaart und Gold Line
TEF in das Frequenzgangdiagramm. Die grafischen Daten im Diagramm können bei der
Gestaltung der Frequenzgang-Kennlinie des Prozessors als Referenz verwendet werden.
Anweisungen zur Verwendung der ASCII-Importfunktion siehe Seite 37.

Filtertyp Darstellung Wertebereich

Spitzenwert-/
Bandsperrfilter

Von 1/70 Okt. bis 4 Okt., Voreinstellung: 2/3 Okt.
Von 100,99 Q bis 0,27 Q, Voreinstellung: 2,14 Q

Steilflankige 
Charakteristik –6 dB/Okt. und –12 dB/Okt., Voreinstellung: –6 dB/Okt.

Kuhschwanz-
Charakteristik Keine

Umgehung aktiv Durch Klicken auf diese Schaltfläche wird ein Signal unverändert 
belassen. Wenn die Umgehung aktiv ist, wird die Schaltfläche rot 
angezeigt. Die Voreinstellung ist inaktiv.Umgehung inaktiv
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Verknüpfungsanzeige
Hier wird der Verknüpfungszustand des Prozessors angezeigt. Jede Einstellung, die bei einem
verknüpften Prozessor geändert wird, wird für alle anderen Prozessoren in derselben Verknüpfungsgruppe
geändert. Eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe Abschnitt
Verknüpfungen auf Seite 24.

Mit Filtern arbeiten
Beim ersten Öffnen des Parameterfensters eines parametrischen Equalizers befinden sich keine Spitzenwert-/
Bandsperrfilter im Frequenzgang-Plotter. Filterpunkte können nach Bedarf hinzugefügt werden, bis die für den
gewählten Prozessorblock verfügbare maximale Anzahl erreicht ist.

So wird ein neuer Filterpunkt hinzugefügt:
1. Auf die Schaltfläche [NEW] (Neu) klicken.
2. Ein Filterpunkt erscheint bei 0 dB mit einem Frequenz-Voreinstellwert von 1 kHz und einer Bandbreite von 

2/3 Oktave.

So werden alle Filterpunkte entfernt:
1. Auf die Schaltfläche [CLEAR] klicken oder [Edit>Clear Filters] (Bear-

beiten>Filter löschen) aus der Menüleiste des Parameterfensters 
wählen.

2. Das Dialogfeld “Clear” wird eingeblendet (siehe Abb. 7-20 rechts).
3. [Clear All Filters] (Alle Filter löschen) wählen und auf [OK] klicken. 

Dadurch werden alle Filterpunkte aus dem Frequenzgang-Plotter 
entfernt und die Filter mit steilflankiger/Kuhschwanz-Charakteristik 
auf die Voreinstellungen zurückgesetzt.

So werden ausgewählte Filterpunkte entfernt:
1. Auf einen Filterpunkt klicken, um ihn zu wählen, oder mit Strg + 

Klicken mehrere Filter wählen.
2. Auf die Schaltfläche Entf klicken oder auf die Schaltfläche [CLEAR] klicken, um das Dialogfeld “Clear” zu 

öffnen und die Option [Clear Selected Filter(s)] wählen.

Filter im Frequenzgang-Plotter einstellen
Filtereinstellungen können durch Ziehen der Filterpunkte und Ziehpunkte mit der Maus geändert werden.

So werden Verstärkung und Frequenz eingestellt:
1. Den Cursor über die Mitte des Filterpunktes oder Ziehpunktes bringen.

2. Der Cursor ändert seine Form zum Symbol für Verschieben:

3. Klicken und den Filter nach links oder rechts ziehen, um die Frequenz einzustellen, oder nach oben 
oder unten, um die Verstärkung einzustellen.

So wird die Filterpunkt-Bandbreite eingestellt:
1. Den Cursor über einen der Bandbreiten-Steuerpunkte des Filters bringen.
2. Der Cursor ändert seine Form zum Symbol für horizontale Größenänderung: 
3. Klicken und den Steuerpunkt nach links oder rechts ziehen, um die Bandbreite einzustellen.

Prozessor verknüpft

Prozessor nicht verknüpft

Hinweis: Es ist nicht möglich, die Ziehpunkte von Filtern mit steilflankiger/Kuhschwanz-Charakteris-
tik zu entfernen, sie können aber mit [CLEAR] oder Entf auf ihre Voreinstellungen zurück-
gesetzt werden.

Hinweis: Der Frequenzgang-Plotter zeigt nur für den gewählten Filter eine Kennlinie an. Die kom-
binierte Kennlinie wird im Frequenzgang-Diagramm angezeigt.

ABBILDUNG 7-20: Dialogfeld “Clear” 
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Feinregelung von Parametern
Die Parameter für den gewählten Filterpunkt können mit den nachstehend beschriebenen Methoden
präzise eingestellt werden.

• Eingabe von Werten in die Parameterfelder
• Betätigung der Drehpfeil-Tasten (oder des Dropdown-Feldes) neben den Parameterfeldern
• Verwendung der Tastatur-Tasten

Tasten der Tastatur
Mit den folgenden Tasten der Tastatur können Feineinstellungen für den jeweils gewählten Filter vor-
genommen werden.

Kopieren, Ausschneiden und Einfügen
Filterpunkte können zwischen Fenstern von parametrischen Equalizern kopiert, ausgeschnitten und
eingefügt werden, wobei folgendes zu berücksichtigen ist:

• Im Parameterfenster, in das eingefügt werden soll, muss eine ausreichende Anzahl von verfügbaren 
Filterpunkten vorhanden sein.

• Die Einstellungen von Filtern mit steilflankiger/Kuhschwanz-Charakteristik können nur zwischen 
PEQ+CS-Prozessoren kopiert und eingefügt werden.

So werden Filter kopiert und eingefügt:
1. Durch Klicken einen Filter wählen oder mit einer der nachstehenden Methoden mehrere Filter wählen:

• Strg + Klicken.
• Die Menüoption [Edit>Select All] (Bearbeiten>Alles wählen) verwenden.

2. Die Menüoption [Edit>Copy] (Bearbeiten>Kopieren) verwenden.
3. Das Parameterfenster des parametrischen Equalizers öffnen, in das die Filtereinstellungen eingefügt 

werden sollen.
4. Die Menüoption [Edit>Paste] (Bearbeiten>Einfügen) verwenden.

Taste Ergebnis

� Verringert die Frequenz um einen Bildschirm-Bildpunkt

� Erhöht die Frequenz um einen Bildschirm-Bildpunkt

� Erhöht die Verstärkung um 0,5 dB

� Verringert die Verstärkung um 0,5 dB

Umschalttaste + � Verringert die Frequenz um 1/3 Oktave

Umschalttaste + � Erhöht die Frequenz um 1/3 Oktave

Strg + � Verringert die Bandbreite eines Filterpunktes in kleinen Schritten

Strg + � Vergrößert die Bandbreite eines Filterpunktes in kleinen Schritten

Umschalttaste + �
oder Bild-Auf-Taste Erhöht die Verstärkung um 3 dB

Umschalttaste + �
oder Bild-Ab-Taste Verringert die Verstärkung um 3 dB

Leertaste oder Klicken
mit der rechten

Maustaste
Stellt die Verstärkung auf 0 dB ein

Hinweis: Durch Ändern der Frequenz um einen Bildschirm-Bildpunkt ändert sich der Wert um 
etwa 1/100 einer Oktave oder 1 %.

Hinweis: Der Befehl “Cut” (Ausschneiden) ist nicht für die Ziehpunkte von Filtern mit 
steilflankiger/Kuhschwanz-Charakteristik verfügbar.

Hinweis: Wenn Filter Bestandteil einer Mehrfach-Auswahl sind, werden sie rosa markiert und 
ihre Parametereinstellungen gesperrt. Um die Wahl einer Mehrfach-Auswahl rückgän-
gig zu machen, auf ein beliebiges Steuerelement im Parameterfenster oder auf einen 
Filter außerhalb des Auswahlbereichs klicken.
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ABSCHNITT 8 Steuerpins
Die Pin-Anschlüsse an der Rückseite des DFR22 Audioprozessors ermöglichen es dem Installationspersonal, ver-
schiedene externe Hardware wie Schalter und Potentiometer zur Lautstärkeregelung, zur Kanalstummschaltung und
zur Auswahl von Voreinstellungen anzuschließen. Sie können auch zum Anschluss von Crestron- oder AMX-Logik-
steuerungskarten verwendet werden. Diese Art einfacher Steuerung bietet den Endbenutzern die Möglichkeit, bestim-
mte Funktionen ohne den Einsatz eines Computers zu steuern.

Übersicht über die Steuerpins

Die externe Gerätesteuerung erfolgt auf drei verschiedenen Ebenen: externe Anschlüsse, Pin-Konfiguration und Proz-
essor-Zuordnung. In der Abbildung unten ist das Gerät für die folgende externe Steuerung konfiguriert:

• Eins-zu-Eins-Schaltung zwischen zwei Voreinstellungen
• Einstellung der Gesamtausgangsverstärkung der Anlage mit einem Potentiometer
• Stummschaltung eines Eingangskanals mit einem Rastschalter.

Stufe 1: Externe Anschlüsse

Bei der Erstinstallation des Geräts ist zu entscheiden, welche Art externer Steuerung die Beschallungsanlage
erfordert, dann ist die entsprechende Hardware entsprechend zu verdrahten. Anweisungen und Verdrahtung-
spläne siehe Installation Guide (Installationsanleitung).

Stufe 2: Pin-Konfiguration

In der DFR22 Software im Fenster “Control Pins” (Steuerpins) den Abschnitt “Pin Configuration” (Pin-Konfigu-
ration) zum Auswählen der Hardware verwenden, die am Gerät angeschlossen ist. Diese Konfiguration wird
als globale Einstellung im Gerät gespeichert und kann auch als Computerdatei gespeichert werden.
Anweisungen siehe Abschnitt “Pin Configuration” (Pin-Konfiguration) auf Seite 92.

Stufe 3: Prozessor-Zuordnung

Nachdem das Gerät zum Erkennen der externen Steuerung konfiguriert wurde, den Steuerverbindungen Ein-
und Ausgangskanäle zuordnen. Dazu im Fenster “Control Pins” den Abschnitt “Processor Mapping” (Proz-
essor-Zuordnung) verwenden. In jeder Voreinstellung wird eine eigene Prozessor-Zuordnungstabelle gespe-
ichert. Weitere Informationen siehe Abschnitt ”Processor Mapping” (Prozessor-Zuordnung) auf Seite 96.

ABBILDUNG 8-1: Drei Ebenen der externen Gerätesteuerung
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Lehrgang über Steuerpins

Dieser Lehrgang enthält schrittweise Anweisungen zur Konfiguration des DFR22 zur externen Steuerung. Der Zugriff 
erfolgt auch über die Schaltfläche [Tutorial] (Lehrgang) rechts oben im Fenster “Control Pins”, so dass bei der Aus-
führung der entsprechenden Schritte die Anweisungen befolgt werden können. Ausführliche Erläuterungen der Funk-
tionen und Merkmale des Fensters “Control Pins” siehe Abschnitt Fenster “Control Pins” auf Seite 92.

A. In den Design-Modus schalten und das Fenster “Control Pins” öffnen.
Auf die Schaltfläche [Design Mode] (Design-Modus) in der Steuerleiste des Hauptfensters klicken und
[Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) aus dem Hauptmenü wählen.

B. Sollen die Steuerpins für die Auswahl von Voreinstellungen konfiguriert werden?
• Wenn NEIN, mit Schritt D fortfahren.
• Wenn JA, Anzahl der zu wählenden Voreinstellungen im Feld [# Presets] (Anzahl der Voreinstellungen) 

eingeben.

C. Welche Art Steuerelement soll für die Voreinstellung-Umschaltung verwendet werden?
Die Auswahl im Dropdown-Menü im Feld [Encoding Type] (Codierungstyp) angeben.

• Priority (Priorität): eine Voreinstellung pro Steuerpin (Verwendung von nicht einrastenden Schaltern oder 
von Rastschaltern). Mit dieser Option wird zwischen maximal vier Voreinstellungen umgeschaltet.

• Binary (Binär): schaltet bestimmte Voreinstellungen durch eine Kombination offener und geschlossener 
Pins ein (Verwendung von Rastschaltern).

• DRS-10/Custom (DRS-10/Benutzerspezifisch): Drehschalter mit 10 Positionen, mit dem Voreinstellun-
gen abhängig vom Widerstandswert geändert werden. Der DRS-10 ist ein optionales Zubehör von Shure; 
es kann aber auch eine benutzerspezifische Schaltung verwendet werden. Tabelle der Widerstandswerte 
mit entsprechenden Voreinstellungen siehe Seite 94. Mit dieser Option wird zwischen maximal zehn Vore-
instellungen umgeschaltet; sie erfordert einen Steuerpin.

Mit den Verbindungsblöcken im Fenster “Control Pins” wird die Anzahl der zum Umschalten der Voreinstellun-
gen erforderlichen Pins gemäß den Einstellungen zugewiesen, die in den Feldern [# Presets] und [Encoding
Type] angegeben wurden. Diese Pins werden als Voreinstellung-Steuerblock links im Fenster angezeigt.

WICHTIGER HINWEIS ZUR VOREINSTELLUNG-UMSCHALTUNG:
Nachdem die Voreinstellung-Steuerung für die Steuerpins aktiviert wurde,
können Voreinstellungen nicht mehr vom Computer oder von der Vorein-
stellung-Auswahl an der Frontplatte des DFR22 geändert werden. Die
Anzeige auf der Frontplatte zeigt aber immer noch die aktive Voreinstel-
lung an.

Wenn Voreinstellungen vom Computer oder von der Frontplatte des
DFR22 aus umgeschaltet werden sollen, nachdem die Steuerpins aktiviert
wurden, ist dazu der Voreinstellung-Steuerblock im Fenster “Control Pins”
zu deaktivieren.

Hinweis: Wenn die Steuerpins zum Umschalten von Voreinstellun-
gen konfiguriert werden sollen, ist die Voreinstellung-
Auswahl an der Frontplatte des DFR22 deaktiviert.

Max. Anzahl 
Voreinstellun-
gen

Anzahl 
Pins

2 1
4 2
8 3

16 4

ABBILDUNG 8-2: Deaktivieren des 
Voreinstellung-Steuerblocks
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So wird der Voreinstellung-Steuerblock deaktiviert:
1. Auf den Dropdown-Pfeil rechts neben dem Voreinstellung-Steuerblock klicken und die Maustaste 

gedrückt halten, dann die Option [Disable] (Deaktivieren) wählen.
2. Neben dieser Option wird ein Häkchen gesetzt, wenn der Block deaktiviert wurde. Im Live-Modus wird 

die Änderung durchgeführt, sobald [Disable] gewählt wird. Im Design-Modus muss die Pin-Konfigura-
tion durch Wählen von [Configuration>Store to Device] (Konfiguration>Im Gerät speichern) im Menü 
des Fenster “Control Pins” erneut gespeichert werden.

3. Wenn das Auswählen von Voreinstellungen vom PC aus abgeschlossen ist, erneut [Disable] wählen, 
um die Steuerung der Voreinstellung-Auswahl wieder auf die Steuerpins umzustellen.

D. Soll der Verstärkerpegel mit den Steuerpins gesteuert werden?
• Wenn NEIN, mit Schritt E fortfahren.
• Wenn JA, ein Potentiometer für einen der Verbindungsblöcke wählen 

oder einen nicht einrastenden Schalter bei jedem der beiden Verbind-
ungsblöcke wählen: einen zur Erhöhung des Verstärkerpegels und einen 
zur Absenkung des Verstärkerpegels.

Rechts neben jedem der Verbindungsblöcke befindet sich ein Dropdown-
Menü. Darauf klicken und Maustaste gedrückt halten, um eine Option aus
der Liste verfügbarer Hardware-Verbindungen auszuwählen. [Moment] (nicht
einrastend) für einen nicht einrastenden Schalter bzw. [Pot] für ein Potenti-
ometer wählen.

E. Soll die Kanalstummschaltung mit den Steuerpins gesteuert werden?
• Wenn NEIN, mit Schritt F fortfahren.
• Wenn JA, entweder [Moment] oder [Switch] (Schalter) aus dem Dropdown-Menü des Verbindungsblocks 

gemäß folgender Parameter wählen:
> Um mit einem nicht einrastenden Schalter zum Stummschalten zu drücken und zum Aufheben der 

Stummschaltung erneut zu drücken, [Moment] wählen.
> Um einen nicht einrastenden Schalter zum Stummschalten gedrückt zu halten und zum Aufheben der 

Stummschaltung den Schalter loszulassen, [Switch] wählen.
> Zum Stummschalten in Position 1 und zum Aufheben der Stummschaltung in Position 2 eines Ras-

tschalters [Switch] wählen.

F. Die Pin-Konfiguration im Gerät speichern.
1. [Configuration>Store to Device] im Menü des Fensters “Control Pins” wählen.
2. Wenn das Dialogfeld “Select Devices” (Geräte wählen) angezeigt wird, zum Auswählen des DFR22 

klicken, dann auf [OK] klicken.

G. Sind alle Voreinstellungen im Gerät gespeichert?
• Wenn JA, mit Schritt H fortfahren.
• Wenn NEIN, Voreinstellungen erstellen und im Gerät speichern. Weitere Informationen siehe Abschnitt 

Erstellen einer Voreinstellung auf Seite 17 und Geräte-Voreinstellungen auf Seite 30.

H. Ist dies noch nicht erfolgt, Steuerhardware gemäß der Pin-Konfiguration, die im Fenster 
“Control Pins” angegeben wurde, an den Steuerpins des DFR22 anschließen.
• Wenn die Steuerpins nur zur Voreinstellung-Umschaltung verwendet werden, ist der Vorgang 

abgeschlossen.
• Wenn die Steuerpins zur Verstärkungseinstellung oder Stummschaltung verwendet werden sollen, mit 

Schritt I fortfahren.

Hinweis: Wenn kein Anschluss an das Gerät besteht, kann eine Pin-Konfiguration auch im Computer 
gespeichert werden, um sie später im Gerät zu speichern. Anweisungen siehe Abschnitt “Pin 
Configuration” (Pin-Konfiguration) auf Seite 92.

ABBILDUNG 8-3: Dropdown-Menü 
des Verbindungsblocks
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I. In den Live-Modus schalten und das Fenster “Control Pins” öffnen.
Auf die Schaltfläche [Live Mode] (Live-Modus) in der Steuerleiste des Hauptfensters klicken und 
[Devices>Control Pin Configuration] aus dem Hauptmenü wählen.

J. Sollen Potentiometer verwendet werden?
• Wenn NEIN, mit Schritt L fortfahren.
• WennJA, jedes der Potentiometer kalibrieren. Auf die Schaltfläche [Calibrate] 

(Kalibrieren) unter dem Potentiometer-Steuerblock klicken, um den Kalibrierung-
sassistenten zu starten. Jedes Potentiometer muss separat kalibriert werden.

 K. Den Verstärkungsbereich jedes der Potentiometer einstellen.
1. Auf die Schaltfläche [Gain Range] (Verstärkungsbereich) klicken.
2. Das Dialogfeld “Range Edit” (Bereich bearbeiten) wird eingeblendet.
3. Den Minimal- und den Maximalwert angeben.
4. Auf [OK] klicken.

L. Die Ein- und Ausgangskanäle den Steuerungsanschlüssen zuordnen.
Die Ein- und Ausgangskanäle werden unter den einzelnen Verbindungsblöcken für die Steuerpins aufgeführt.
Durch Klicken die Kontrollkästchen für die einzelnen Kanäle markieren, die gesteuert werden sollen.

M. Werden nicht einrastende Schalter zur Pegeleinstellung verwendet?
• Wenn NEIN, mit Schritt N fortfahren.
• Wenn JA, den Erhöhungsschritt sowie den Maximal- und den Minimalwert der Pegeleinstellung angeben.

1. Auf die Schaltfläche [Gain Up Limit] (Obere Verstärkungsgrenze) bzw. [Gain Down Limit] (Untere Ver-
stärkungsgrenze) klicken.

2. Das Dialogfeld “Set Gain Maximum” (Maximale Verstärkung einstellen) bzw. “Set Gain Minimum” (Min-
imale Verstärkung einstellen) wird geöffnet.

3. Den Erhöhungsschritt und die Einstellungen für die Verstärkungsgrenze angeben.
4. Auf [OK] klicken.

Weitere Informationen siehe Abschnitt Nicht einrastende Schalter auf Seite 97.

N. Schritt K bis M für jede im DFR22 gespeicherte Voreinstellung wiederholen.

Hinweis: Wenn das Potentiometer nicht kalibriert wird, gilt die Voreinstellung der 
Kalibrierung für ein logarithmisches 100-kOhm-Potentiometer.

ABBILDUNG 8-4: 
Schaltfläche “Calibrate” 

(Kalibrieren)
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Fenster “Control Pins”

Das Fenster “Control Pins” bildet eine Schnittstelle für die globale Konfiguration von Steuerpins auf der Geräteebene und 
für die Zuordnung von Ein- und Ausgangsverstärkungs-Prozessoren zu Steuervorrichtungen für die einzelnen Voreinstel-
lungen. Mit der Menüoption [Devices>Control Pins Configuration] vom Hauptfenster aus auf dieses Fenster zugreifen.

1. Steuerelemente für die Voreinstellung-Umschaltung: Mit diesen Steuerelementen wird angegeben, wie 
viele Voreinstellungen geschaltet werden sollen und welche Art von Hardwaresteuerung zum Schalten ver-
wendet werden soll. Zuerst die Anzahl der Voreinstellungen eingeben und dann den Codierungstyp angeben.

2. Voreinstellung-Steuerblock: Hier werden die Steuerpins grafisch dargestellt, die für die Voreinstellung-
Umschaltung zugeordnet wurden. Die zugehörigen Funktionen und die Darstellung hängt von der Einstel-
lung ab, die bei den Steuerelementen für die Voreinstellung-Umschaltung angegeben wurde. 

3. Verbindungsblock: Bei jedem Block wird angezeigt, welche Art der Steuerhardware für den entsprech-
enden Pin angegeben wurde.

4. Dropdown-Menü des Verbindungsblocks: Mit diesem Menü kann die Art des Steuerelements für den 
Verbindungsblock angegeben werden.

5. Pin-Konfiguration: Die Einstellungen in diesem Abschnitt des Fensters beziehen sich auf den DFR22 auf 
Geräteebene. Weitere Informationen siehe unten unter “Pin Configuration”. 

6. Processor Mapping (Prozessor-Zuordnung): Die Einstellungen in diesem Abschnitt des Fensters bezie-
hen sich jeweils auf einzelne Voreinstellungen. Weitere Informationen siehe Abschnitt ”Processor Map-
ping” (Prozessor-Zuordnung) auf Seite 96.

“Pin Configuration” (Pin-Konfiguration)

Dieser Abschnitt des Fensters “Control Pins” dient zum Konfigurieren des DFR22 für eine einwandfreie Erkennung von 
Steuerpin-Verbindungen mit externen Geräten. Beim ersten Öffnen des Fensters sind alle Verbindungen deaktiviert 
und es gibt keine Unterscheidung zwischen den Funktionen der Pins. Nach der Festlegung, wie viele Pins gegebenen-
falls für die Voreinstellung-Steuerung verwendet werden sollen, werden diese Pins in der Anzeige der Voreinstellung-
Steuerung zugeteilt, und etwaige verbleibende Pins können zur Steuerung der Verstärkung und Stummschaltung von 
Ein- und Ausgangskanälen zugeordnet werden.

Hinweis: Einrichten und Änderung der Pin-Konfiguration sind nur im Design-Modus möglich.

1

2

3 4

5

6

ABBILDUNG 8-5: Fenster “Control Pins”
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“Pin Configuration” (Pin-Konfiguration)
Diese Einstellungen werden auf der Geräteebene gespeichert. Sie werden nicht zusammen mit Voreinstellungen oder 
Szene-Dateien gespeichert und ändern sich beim Umschalten zwischen Voreinstellungen im Gerät nicht. Diese Konfig-
uration kann im Computer gespeichert werden, wenn der DFR22 nicht angeschlossen ist, oder für die Datensicherung.

Einstellungen für Voreinstellung-Codierung
Wenn die Steuerpins zum Umschalten von Voreinstellungen verwendet werden sollen, müssen bei diesen Steuer-
elementen Werte angegeben werden, bevor andere Parameter im Fenster “Control Pins” festgelegt werden.

# Presets
Mit diesem Steuerelement wird die Anzahl der Voreinstellungen angegeben, die mit
Steuerpins gesteuert werden sollen. Der Wertebereich reicht von 1 bis 16 mit der Vorein-
stellung 1. In diesem Feld einen Wert eingeben, bevor unter [Encoding Type] ein Codi-
erungstyp gewählt wird.

Encoding Type
Mit diesem Steuerelement wird angegeben, wie die Voreinstellungen mit den Steuer-
pins gewählt werden. Die verfügbaren Einstellungen hängen von der Anzahl der Vore-
instellungen ab, die im Feld [# Presets] angegeben wurden (siehe Beschreibung
unten). Die Voreinstellung ist “keiner”.

Prioritäts- oder Eins-zu-Eins-Codierung

Mit dieser Einstellung wird jeder Pinbelegung eine eindeutige Voreinstellung-
Nummer zugeordnet. Sie gestattet das Umschalten zwischen maximal vier Vore-
instellungen. Für diesen Codierungstyp nicht einrastende Schalter oder Ras-
tschalter verwenden.

Im Voreinstellung-Steuerblock wird ein Textfeld für jeden Steuerpin angezeigt. Die
anfänglichen Voreinstellungen entsprechen den Voreinstellung-Nummern 1 bis 4.
Es können abweichende Voreinstellung-Nummern angegeben werden, indem auf
die einzelnen Textfelder geklickt und eine Nummer von 1 bis 16 eingegeben wird.
Wenn ein Benutzer beim Auswählen versehentlich eine Schalterkombination
drückt, schaltet das Gerät zur Voreinstellung in der Position [Highest Priority]
(Höchste Priorität).

Binäre Codierung

Bei dieser Einstellung werden Voreinstellungen unter Verwendung einer binären
Einstellung an den Steuereingängen gewählt (siehe Darstellung unterhalb des Vor-
einstellung-Steuerblocks). Sie gestattet das Umschalten zwischen maximal 16 Vor-
einstellungen. Für diesen Codierungstyp Rastschalter verwenden. Der Binärcode
entspricht dem logischen Zustand an den Steuerpineingängen.

• Logisch 0 = Pin spannungsführend
• Logisch 1 = Pin massegeschlossen

Hinweis: Nachdem die Voreinstellung-Umschaltung mit den Steuerpins eingestellt wurde, ist die Vore-
instellung-Auswahl an der Frontplatte des DFR22 deaktiviert, und vom Computer aus können 
Voreinstellungen nicht mehr geändert werden. Im Live-Modus können die Steuerpins durch 
Klicken auf den Voreinstellung-Steuerblock oder durch Auswahl der Option [Disable] (Deak-
tivieren) im Dropdown-Menü rechts vom Voreinstellung-Steuerblock deaktiviert werden. Der 
Block wird abgeblendet dargestellt, wenn er deaktiviert wurde. Um die externe Voreinstellung-
Steuerung erneut zu aktivieren, im Live-Modus erneut “Disable” wählen oder auf den Vorein-
stellung-Steuerblock klicken.

ABBILDUNG 8-6: 
Voreinstellung-

Steuerblock für Prioritäts-
Codierung

ABBILDUNG 8-7: 
Voreinstellung-

Steuerblock für binäre 
Codierung
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“Pin Configuration” (Pin-Konfiguration)
Es gibt ein Textfeld für jede binäre Einstellung an den Steuerpins. Die
Voreinstellungen beginnen mit Voreinstellung 1 für die binäre Einstel-
lung 0 und steigern sich bis Voreinstellung 16 für die binäre Einstel-
lung 1111. Die Voreinstellung, die durch jede der logischen
Kombinationen gewählt wird, kann durch Klicken auf die einzelnen
Textfelder und Eingeben einer anderen Voreinstellung-Nummer von 1
bis 16 geändert werden. Voreinstellungen dieser Werte siehe Anhang
A: Tabellen für binäre Codierung.

DRS10 oder benutzerdefinierte Schalter-Codierung

Mit dieser Einstellung werden Voreinstellungen unter Verwendung
eines entsprechenden Widerstandswerts am Steuerpineingang gewählt. Bei
diesem Codierungstyp können bis zu zehn Voreinstellungen gewählt wer-
den. Der DRS10 ist ein optionales Zubehör von Shure; es kann aber auch
eine benutzerspezifische Schaltung verwendet werden.

Verbindungsblöcke
Die Anzahl der Verbindungsblöcke, die im Fenster erscheinen,
hängt davon ab, wie viele Pins nach der Einstellung der Vorein-
stellung-Steuerung noch verfügbar sind. Hardware-Steuerele-
mente einem Pin zuordnen, indem aus dem Dropdown-Menü an
der rechten Seite des Blocks eine Auswahl getroffen wird. Die
Hardware-Steuerelemente können abwechselnd aktiviert und
deaktiviert werden, indem mit der linken Maustaste auf den Block
geklickt oder [Disable] (Deaktivieren) aus dem Dropdown-Menü
gewählt wird.

Rastschalter [Switch]
Rastschalterwahl zum Stummschalten von Ein- und Ausgangskanälen verwenden. Diese Ein-
stellung ist im Allgemeinen für eine externe Steuereinheit vorgesehen, die zwischen zwei Posi-
tionen wechselt. Sie kann auch mit einem nicht einrastenden Schalter verwendet werden. In

diesem Fall wird der Kanal bei Drücken des Schalters stumm geschaltet, bei Loslassen des Schalters wird
die Stummschaltung aufgehoben.

Nicht einrastender Schalter [Moment]
Einstellung für nicht einrastenden Schalter zum Stummschalten von Ein- und Ausgangskanälen
verwenden. Diese Einstellung ist für einen externen, nicht einrastenden Schalter vorgesehen,
bei dem die Stummschaltung bei jedem Drücken des Schalters abwechselnd ein- und ausge-

schaltet wird. Sie kann auch zur Erhöhung oder Absenkung der Verstärkung verwendet werden. Wenn sie
zur Änderung des Verstärkungspegels verwendet wird, muss bei jeder Voreinstellung die minimale Ver-
stärkung, die maximale Verstärkung und der Erhöhungsschritt eingestellt werden. Weitere Informationen
siehe Abschnitt Nicht einrastende Schalter auf Seite 97.

VOREINSTEL-
LUNG NR.

WIDERSTAND-
SWERT

VOREINSTEL-
LUNG NR.

WIDERSTAND-
SWERT

1 97 k� – ��� 6 7,8 – 9,3 k�
2 44 – 60 k� 7 5,2 – 6,3 k�
3 26 – 32 k� 8 3,3 – 4,1 k�
4 17 – 20 k� 9 1,9 – 2,5 k�
5 11,3 – 13,6 k� 10 0,63 – 1,1 k�

Hinweis: Im Design-Modus muss zum Aktivieren bzw. Deaktivieren der Hardware-Verbindungen die Pin-
Konfiguration auch im Gerät gespeichert werden.

Binäre Voreinstellung-
Codierung

Max. Anzahl 
Voreinstellungen

Anzahl 
Pins

2 1
4 2
8 3

16 4

ABBILDUNG 8-8: Voreinstellung-
Steuerblock für DRS10/

Benutzerdefinierte Codierung

Aktivierte
Verbindung

Deaktivierte 
Verbindung

ABBILDUNG 8-9: Verbindungsblöcke
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“Pin Configuration” (Pin-Konfiguration)
Potentiometer [Pot]
Die Einstellung des Potentiometers zum Regeln der Eingangsverstärkung bzw. der Aus-
gangsverstärkung verwenden. Auf die Schaltfläche [Calibrate] klicken, um den Steuereingang
des angeschlossenen Potentiometers zu kalibrieren. Wenn das Potentiometer nicht kalibriert
wird, gilt die Voreinstellung der Kalibrierung für ein logarithmisches 100-kOhm-Potentiometer
mit +/–20 % Toleranz.

Erstellen einer neuen Steuerpin-Konfiguration für das Gerät
1. In den Design-Modus schalten.
2. Den Befehl [Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) aus dem Haupt-

menü wählen.
3. Das Fenster “Control Pins” wird eingeblendet.
4. Die Voreinstellung-Steuerung konfigurieren.

a) Die Anzahl der Voreinstellungen in das Wertefeld [# Presets] eingeben.
b) Einen Codierungstyp aus dem Pulldown-Menü [Encoding Type] wählen.
c) Der Voreinstellung-Steuerpinblock erscheint.
d) Wenn Prioritätscodierung oder binäre Codierung verwendet wird, die entsprechenden Voreinstel-

lung-Nummern unter dem Voreinstellung-Steuerblock eingeben.
5. Verbliebene Pins für externe Steuereinheiten konfigurieren, indem eine Wahl aus dem Dropdown-

Menü an der rechten Seite jedes Verbindungsblocks vorgenommen wird.
6. Die Menüoption [Configuration>Store to Device] (Konfiguration>Im Gerät speichern) wählen.
7. Wenn das Dialogfeld “Select Devices” (Geräte wählen) angezeigt wird, das Gerät wählen und 

auf [OK] klicken.
8. Die Pin-Konfiguration wird im Gerät gespeichert.

Eine Steuerpin-Konfiguration im PC speichern
1. Die obigen Schritte 1 bis 5 ausführen.
2. Die Menüoption [Configuration>Store to PC] (Konfiguration>Im PC speichern) wählen.
3. Das Dialogfeld “Save Config As” (Konfiguration speichern unter) wird eingeblendet.
4. Zum gewünschten Verzeichnis gehen, einen Dateinamen eingeben und auf [OK] klicken.
5. Die Konfiguration wird im Computer als Datei mit der Dateinamenerweiterung “.d22pin” gespeichert.

Bearbeiten einer Steuerpin-Konfiguration im Gerät
1. In den Design-Modus schalten.
2. Den Befehl [Devices>Control Pin Configuration] aus dem Hauptmenü wählen.
3. Das Fenster “Control Pins” wird eingeblendet.
4. Die Menüoption [Configuration>Recall From Device] (Konfiguration>aus Gerät abrufen) wählen.
5. Wenn das Dialogfeld “Select Devices” angezeigt wird, das Gerät wählen und auf [OK] klicken.
6. Das Fenster “Control Pins” wird mit der aktuellen Pin-Konfiguration angezeigt.
7. Die gewünschten Änderungen vornehmen.
8. Die Menüoption [Configuration>Store to Device] wählen.
9. Wenn das Dialogfeld “Select Devices” angezeigt wird, ein Gerät wählen und auf [OK] klicken.
10. Die Pin-Konfiguration wird im Gerät gespeichert.
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”Processor Mapping” (Prozessor-Zuordnung)
”Processor Mapping” (Prozessor-Zuordnung)

Dieser Abschnitt des Fensters “Control Pins” dient zum Angeben, welche Ein- und Ausgangskanäle die externe 
Hardware steuert. Die Ein- und Ausgangskanäle werden in einer Spalte unter den einzelnen Verbindungsblöcken 
aufgeführt, denen eine Steuereinheit zugeordnet wurde. Damit die externe Steuerhardware die Verstärkung und 
Stummschaltung von Kanälen steuern kann, muss jede Voreinstellung im Gerät den Steuerverbindungen zugeord-
net werden.

Die Prozessor-Zuordnung kann im Live- oder Design-Modus erstellt werden. Im Live-Modus ist die Titelleiste dieses 
Fensterabschnitts blau und im Design-Modus schwarz. Im Live-Modus werden Änderungen, die an der Prozessor-Zuo-
rdnung vorgenommen werden, direkt gespeichert und auf die aktive Voreinstellung angewendet.

Zuordnen von Hardware-Steuerelementen zu Ein- und Ausgangskanälen
Es können einer Steuereinheit beliebige Kombinationen von Ein- und Ausgangskanälen zugeordnet werden.
Bei nicht einrastenden Schaltern können jedem Kanal drei mögliche Funktionen zugeordnet werden: Erhöhung
der Verstärkung, Absenkung der Verstärkung und Stummschaltung. Jedem Ein- oder Ausgangskanal kann
jeweils nur eine dieser drei Funktionen zugeordnet werden. Derselbe Kanal kann z. B. nicht der Erhöhung der
Verstärkung und der Stummschaltung zugeordnet werden.

So wird ein Eingangs- oder Ausgangskanal einer Steuereinheit zugeordnet:

• Auf ein Kontrollkästchen klicken, um den entsprechenden Ein- oder Ausgangskanal einer Steuerein-
heit zuzuordnen.

• Zum Deaktivieren des Kontrollkästchens erneut auf dieses klicken.

Einstellungen der Verstärkung
Außer der Zuordnung der Ein- und Ausgangskanäle für die Pegelregelung muss auch der zulässige Bereich
angegeben werden, in dem der Endbenutzer den Pegel einstellen kann. Da dies ein Teil der Prozessor-Zuord-
nung ist, werden diese Einstellungen einzeln mit jeder Voreinstellung gespeichert.

Potentiometer
Unter jedem Potentiometer-Steuerblock befindet sich eine Schaltfläche
[Set Gain Range] (Verstärkungsbereich einstellen). Wenn für eine
Steuereinheit kein Verstärkungsbereich eingestellt wird, wird eine Vorein-
stellung von �� dB bis +10 dB verwendet.

So wird der Verstärkungsbereich eines Potentiometers eingestellt:
1. Auf die Schaltfläche [Set Gain Range] klicken.
2. Das Dialogfeld “Range Edit” (Bereich bearbeiten) wird eingeblendet.
3. Den Minimal- und Maximalwert für die zulässige Verstärkungsregelung 

eingeben. Der Mindestpegel beträgt �� dB, der Maximalpegel beträgt 
+10 dB.

4. Auf [OK] klicken.

Hinweis: Vor der Erstellung einer Prozessor-Zuordnungstabelle muss eine Steuerpin-Konfiguration 
erstellt und im Gerät gespeichert werden.

Prozessor-Kontrollkästchen für Zuord-
nung gewählt

Kontrollkästchen nicht gewählt

ABBILDUNG 8-10: Prozessor-
Zuordnung für Potentiometer
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”Processor Mapping” (Prozessor-Zuordnung)
Nicht einrastende Schalter
Unter jedem Steuerblock für nicht einrastende Schalter befinden
sich die Schaltflächen [Set Gain Max] (Max. Verstärkung ein-
stellen) und [Set Gain Min] (Min. Verstärkung einstellen). Diese
Schaltflächen dienen außer zur Einstellung der maximalen bzw.
minimalen Verstärkung eines nicht einrastenden Schalters, der für
die Pegelregelung zugeordnet wurde, auch der Einstellung des
Schritts in dB, um den das Steuerelement die Verstärkung anhebt
oder absenkt. Wenn eine Pegelregelung betätigt wird, wird die Ver-
stärkung unmittelbar um den angegebenen Wert angehoben bzw.
abgesenkt. Wenn eine Pegelregelung betätigt und gehalten wird,
wird die Verstärkung unmittelbar um den angegebenen Wert ange-
hoben bzw. abgesenkt. Nach einer Verzögerung von 1000 ms wird
die Verstärkung dann alle 120 ms, während der die Pegelregelung
gehalten wird, weiter angehoben bzw. abgesenkt.

Wenn keine maximale Verstärkung und kein Erhöhungsschritt für
ein Steuerelement zur Erhöhung der Verstärkung angegeben wird,
wird die Voreinstellung von +10 dB Maximum in Schritten von 2 dB
verwendet. Wenn keine minimale Verstärkung und kein
Erhöhungsschritt für ein Steuerelement zur Absenkung der Verstärkung angegeben wird, wird die Vorein-
stellung von �� dB Minimum in Schritten von 2 dB verwendet.

So werden die Verstärkungsgrenzen für einen nicht einrastenden Schalter festgelegt:
1. Durch Klicken einen Eingangs- oder Ausgangskanal für ein Steuerelement zur Erhöhung der Ver-

stärkung wählen.
2. Auf die Schaltfläche [Gain Up Limit] klicken.
3. Das Dialogfeld “Set Gain Maximum” wird geöffnet.
4. Die obere Verstärkungsgrenze (maximal +10 dB) eingeben.
5. Den Erhöhungsschritt eingeben, um den sich die Verstärkung erhöht, wenn der Schalter betätigt wird 

(maximal 10 dB).
6. Auf [OK] klicken.
7. Durch Klicken einen Eingangs- oder Ausgangskanal für ein Steuerelement zur Absenkung der Ver-

stärkung wählen.
8. Auf die Schaltfläche [Gain Down Limit] klicken.
9. Das Dialogfeld “Set Gain Minimum” wird geöffnet.
10. Die untere Verstärkungsgrenze (minimal -� dB) eingeben.
11. Den Erhöhungsschritt eingeben, um den sich die Verstärkung verringert, wenn der Schalter betätigt 

wird (maximal 10 dB).
12. Auf [OK] klicken.

Eine Prozessor-Zuordnungstabelle erstellen
Durch Zuordnen externer Hardware zu den zu steuernden Ein- und -Ausgängen wird eine Prozessor-Zuord-
nungstabelle erstellt. Es kann dazu eine der folgenden Methoden verwendet werden:

• Im Live-Modus einzeln eine Prozessor-Zuordnungstabelle für jede Voreinstellung im Gerät 
erstellen.

• Im Design-Modus eine Voreinstellung-Datei aus dem PC öffnen oder aus dem Gerät abrufen und 
mit ihr zusammen eine Prozessor-Zuordnungstabelle speichern.

So wird eine Prozessor-Zuordnungstabelle im Live-Modus erstellt:
1. In den Live-Modus schalten und zu der zu bearbeitenden Voreinstellung schalten.
2. Den Befehl [Devices>Control Pin Configuration] aus dem Hauptmenü wählen.
3. Das Fenster “Control Pins” wird eingeblendet, wobei die Ein- und Ausgangskanäle unter den Verbindungs-

blöcken aufgelistet sind.

ABBILDUNG 8-11: Prozessor-Zuordnung 
für nicht einrastende Schalter
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”Processor Mapping” (Prozessor-Zuordnung)
4. Für jeden Verbindungsblock auf die Prozessor-Zuordnungstabellen-Kontrollkästchen neben den Kanälen 
klicken, die von der Hardware-Verbindung gesteuert werden.

5. Den Verstärkungsbereich für alle Potentiometer sowie die Grenzwerte und die Erhöhungsschritte für alle 
nicht einrastenden Schalter festlegen, die für die Pegelregelung verwendet werden.

6. Die Zuordnung wird automatisch mit der Voreinstellung im Gerät gespeichert, wenn eine Änderung im 
Live-Modus durchgeführt wird. 

7. Zum Erstellen einer weiteren Prozessor-Zuordnungstabelle eine andere Voreinstellung wählen (es ist nicht 
erforderlich, das Fenster “Control Pins” zu schließen).

So wird eine Prozessor-Zuordnungstabelle im Design-Modus erstellt:
1. In den Design-Modus schalten.
2. Auf die Schaltfläche [Open] (Öffnen) in der Steuerleiste des Hauptfensters klicken.
3. Das Dialogfeld “Open Preset” (Voreinstellung öffnen) wird eingeblendet.
4. Die gewünschte Voreinstellung-Datei wählen und auf [OK] klicken.
5. Die gewählte Voreinstellung wird im Signalflussdiagramm angezeigt.
6. Den Befehl [Devices>Control Pin Configuration] aus dem Hauptfenster wählen.
7. Das Fenster “Control Pins” wird eingeblendet.
8. Eine Pin-Konfiguration mit einer der folgenden Methoden laden:

• Die Menüoption [Configuration>Open from PC] (Konfiguration>Vom PC öffnen) wählen und eine Datei 
mit der Erweiterung “.d22pin” öffnen, die auf dem PC gespeichert wurde.

• Wenn der DFR22 angeschlossen ist, die Menüoption [Configuration>Recall from Device] (Konfigura-
tion>Aus Gerät abrufen) wählen.

• Wenn keine Pin-Konfiguration erstellt wurde, siehe Abschnitt “Pin Configuration” (Pin-
Konfiguration) auf Seite 92.

9. Für jeden zugewiesenen Verbindungsblock auf die Prozessor-Zuordnungstabellen-Kontrollkästchen neben 
den Kanälen klicken, die von der Hardware-Verbindung gesteuert werden.

10. Zurück zum Hauptfenster gehen (es ist nicht erforderlich, das Fenster “Control Pins” zu schließen).
11. Die Voreinstellung-Datei im PC speichern (Anweisungen siehe Abschnitt Voreinstellung-Dateien 

überarbeiten auf Seite 29).

Hinweis: Für jede Voreinstellung im Gerät, die mit Hardware-Steuereinheiten gesteuert werden soll, 
muss eine Prozessor-Zuordnungstabelle erstellt werden.
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ABSCHNITT 9 Sicherheit
Sicherheit ist ein optionales Merkmal, mit dem die installierende Person oder ein Sicherheits-Administrator den Zugriff des
Endbenutzers auf die Einstellungen des DFR22 von der Frontplatte aus oder über einen Computer einschränken kann.

Sperrung der Bedienelemente auf der Frontplatte
Der Zugriff auf die Bedienelemente der Frontplatte kann gesperrt werden, so 
dass der Endbenutzer keine Änderungen an DFR-Prozessoreinstellungen 
vornehmen oder Voreinstellungen ändern kann. Um alle Bedienelemente der 
Frontplatte zu sperren, kann auch der fünfte DIP-Schalter auf der Rückseite 
des DFR22 in die untere Stellung geschaltet werden. Der DIP-Schalter kann 
mit Hilfe der Software außer Kraft gesetzt werden. Somit können bestimmte 
Bedienelemente selektiv gesperrt werden, während der Zugriff auf andere 
Bedienelemente freigegeben ist.

So wird der Zugriff zu den Bedienelementen der Frontplatte selektiv 
gesperrt:
1. [Security>Front Panel Lockout] (Sicherheit>Sperrung der Bedi-

enelemente auf der Frontplatte) aus dem Hauptmenü wählen.
2. Das Dialogfeld “Front Panel Lockout” wird eingeblendet (siehe 

Abb. 9-1).
3. Auf das Kontrollkästchen [Override and Disable Dip Switch] (DIP-Schalter außer Kraft setzen und deak-

tivieren) klicken.
4. Auf das Kontrollkästchen gegenüber jedem der Bedienelemente der Frontplatte klicken, für das der 

Benutzerzugang gesperrt werden soll.

Es ist auch möglich, die Sperrungseinstellungen mit einem Kennwortschutz zu versehen, so dass nur der Sicherheits-
Administrator über den Computer Änderungen an der Sperrung der Bedienelemente auf der Frontplatte vornehmen 
kann. Weitere Informationen sind dem folgenden Abschnitt über den Zugriff auf den Computer zu entnehmen.

Sperren des Zugriffs auf den Computer

Der Administrator ist die Person, die das Gerätekennwort und die Zugangsstufe, mit dem das Gerät nach der Installa-
tion arbeitet, einstellt. Es bestehen drei verschiedene Zugangsstufen für das Gerät.

Stufe 1
Wenn das Gerät auf die Stufe 1 eingestellt ist, hat der Benutzer uneingeschränkten Zugang zu den Funk-
tionen des Audioprozessors mit Ausnahme von zwei Funktionen, die immer durch das Administrator-Ken-
nwort geschützt sind:

1. Einstellen der Sicherheitsstufe für das Gerät
2. Ändern des Administrator-Kennworts

Stufe 2
Bei Einstellung des Geräts auf die Stufe 2 hat der Benutzer eingeschränkten Zugang, der durch den
Sicherheits-Administrator definiert wird. Der nachstehende Zugang zum DFR22 kann für die Stufe 2 zuge-
lassen werden:

• Ändern von Voreinstellungen über einen PC
• Ändern der Matrixmischer-Signalführung
• Ändern der Einstellungen für die Sperrung der Bedienelemente auf der Frontplatte.

Hinweis: Zum Konfigurieren von Sicherheitseinstellungen muss das Gerät angeschlossen sein, außer für 
Sicherheitseinstellungen einzelner Prozessoren.

ABBILDUNG 9-1: Dialogfeld “Front Panel 
Lockout” (Sperrung der Bedienelemente auf 

der Frontplatte) 
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Sperren des Zugriffs auf den Computer
• Zugang zum Ändern von Prozessor-Einstellungen für alle Blöcke, die nicht durch den Administrator 
gesperrt wurden (weitere Informationen siehe Abschnitt Sicherheit einzelner Prozessoren auf 
Seite 102).

Stufe 3
Diese Stufe gestattet schreibgeschützten Zugang zu den Einstellungen des DFR22 für die jeweils aktive
Voreinstellung.

Gerätesicherheit einrichten
Die Einrichtung der Sicherheit ist der letzte Schritt bei der Einrichtung des Geräts. Für die Einstellung der Gerä-
tesicherheit sind zwei Hauptschritte auszuführen:

1. Ein Kennwort einrichten
2. Benutzer-Zugangsstufe einstellen

Ein Kennwort einrichten
Bevor die Benutzer-Zugangsstufe im Gerät eingestellt werden
kann, muss das Kennwort eingerichtet werden, mit dem der Zugang
als Sicherheits-Administrator geschützt wird.

So wird ein Kennwort eingerichtet:
1. [Security> Set Password] (Sicherheit> Kennwort einrichten) aus 

dem Hauptmenü wählen.
2. Das Dialogfeld “Create Password” (Kennwort einrichten) wird 

geöffnet (siehe Abb. 9-2).
3. Ein Kennwort in das Feld [Administrator Password] (Administra-

tor-Kennwort) eingeben.
4. Durch Betätigung der Taste Tab zum Feld [Confirm Password] 

(Kennwort bestätigen) gehen und das Kennwort erneut einge-
ben.

5. Die Felder [Administrator Name] (Administratorname) und [Phone or Contact info] (Telefon oder Kon-
takt-Informationen) ausfüllen..

Benutzer-Zugangsstufe einstellen
Nach dem Einrichten eines Kennworts wird das Gerät automatisch
auf die Benutzer-Zugangsstufe 1 eingestellt. Wenn der Zugang zum
Gerät weiter eingeschränkt werden muss, das Gerät auf die gewün-
schte Zugangsstufe einstellen.

So wird die Benutzer-Zugangsstufe eingestellt:
1. [Security>Level] (Sicherheit>Stufe) aus dem Hauptmenü 

wählen.
2. Das Dialogfeld “Input Password” (Kennwort eingeben) wird 

eingeblendet (siehe Abb. 9-3).
3. Das Kennwort eingeben und auf [OK] klicken.

Hinweis: Die Sicherheit betrifft nur den Zugang über die Software-Oberfläche und die Front-
platte. Sie schränkt die Steuerung durch externe Geräte über die Steuerpins nicht ein.

Hinweis: Alle Einträge im Dialogfeld “Create Password” sind auf eine Länge von fünfzehn 
Zeichen beschränkt.

ABBILDUNG 9-2: Dialogfeld “Create 
Password” (Kennwort einrichten)

ABBILDUNG 9-3: Dialogfeld “Input 
Password” (Kennwort eingeben)
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Sperren des Zugriffs auf den Computer
4. Das Dialogfeld “Set Security Level” (Sicherheitsstufe einstellen) 
wird geöffnet (siehe Abb. 9-4).

5. Auf das Optionsfeld links neben der gewünschten Stufe klicken.
6. Gegebenenfalls benutzerdefinierte Optionen für die Stufe 2 

vorgeben.
7. Auf [OK] klicken.

Gerätesicherheit ändern
Falls Änderungen an der Gerätekonfiguration oder den Sicherheitsein-
stellungen notwendig werden, nachdem der Zugang eingeschränkt
wurde, muss zuerst die Gerätesicherheit zurück auf die Stufe 1 zurück-
gestellt werden.

Zugangsstufe ändern
Die obigen Anweisungen zum Einstellen der Zugangsstufe ausführen.

Das Kennwort ändern
So wird ein vorhandenes Kennwort geändert:
1. [Security> Set Password] aus dem Hauptmenü wählen.
2. Das Dialogfeld “Set Password” wird geöffnet (siehe Abb. 9-5). Der 

Cursor befindet sich im Feld [Old Password] (Altes Kennwort).
3. Das aktuelle Kennwort eingeben.
4. Durch Betätigung der Taste Tab zum Feld [Administrator Pass-

word] (Administrator-Kennwort) gehen und das neue Kennwort 
eingeben.

5. Durch Betätigung der Taste Tab zum Feld [Confirm Password] 
(Kennwort bestätigen) gehen und das neue Kennwort erneut 
eingeben.

6. Gegebenenfalls die Felder [Administrator Name] (Administrator-
name) und [Phone or Contact info] (Telefon oder Kontakt-Informationen) ändern.

7. Auf [OK] klicken.

Sicherheit aufheben
Die Gerätesicherheit kann vollständig zurück auf die Voreinstellung gesetzt werden, sodass andere ein
Administrator-Kennwort einstellen und Benutzer-Zugangsstufen definieren können.

So wird der Kennwortschutz entfernt:
1. [Security> Set Password] (Sicherheit> Kennwort einrichten) aus dem Hauptmenü wählen.
2. Das Dialogfeld “Set Password” wird geöffnet (siehe Abb. 9-5 oben).
3. Der Cursor befindet sich im Feld [Old Password] (Altes Kennwort).
4. Gegebenenfalls den Administratornamen und die Kontaktinformationen löschen.
5. Die Felder [Administrator Password] (Administrator-Kennwort) und [Confirm Password] (Kennwort 

bestätigen) leer lassen.
6. Auf [OK] klicken.
7. Damit sind alle Zugangseinschränkungen aufgehoben.

Hinweis: Für diese Funktionen wird das Kennwort des Sicherheits-Administrators benötigt.

Hinweis: Alle Einträge im Dialogfeld “Set Password” sind auf eine Länge von fünfzehn 
Zeichen beschränkt.

Hinweis: Die Sicherheitsattribute einzelner Prozessorblöcke bleiben bestehen, sind aber unwirk-
sam, bis das Gerät auf die Zugangsstufe 2 eingestellt wird.

ABBILDUNG 9-4: Dialogfeld “Set Security 
Level” (Sicherheitsstufe einstellen)

ABBILDUNG 9-5: Dialogfeld “Set 
Password” (Kennwort einrichten)
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Sperren des Zugriffs auf den Computer
Sicherheit einzelner Prozessoren
Durch Sicherheit einzelner Prozessoren wird der Zugang zu bestimmten Prozessorblöcken in einer Voreinstel-
lung gesperrt. Es ist möglich, den Zugang zu einem einzelnen Block, zu mehreren Blöcken oder zu allen
Blöcken in einer Voreinstellung zu sperren. Diese Funktion kann beispielsweise verwendet werden, wenn der
Endbenutzer in der Lage sein soll, Verstärkungseinstellungen zu ändern, aber nicht PEQ-Einstellungen. Ein
gesperrter Prozessor kann immer noch geöffnet werden, um Pegelanzeigen zu überwachen oder Einstellun-
gen einzusehen.

Während die Benutzer-Zugangsstufe gerätespezifisch ist, ist die Prozessorblock-Sicherheit voreinstellungs-
pezifisch. Außerdem ist die Sicherheit einzelner Prozessoren ein separates Attribut eines jeden Blocks. Wenn
beispielsweise ein gesperrter Block kopiert wird, wird dieses Sicherheitsattribut mit dem Block kopiert. Dieses
Attribut bleibt beim Arbeiten im Design-Modus und Live-Modus bestehen.

So werden Prozessorblöcke gesperrt:
1. Das Gerät in den Live-Modus schalten.
2. Sicherstellen, dass das Gerät auf die Sicherheitsstufe 1 eingestellt ist.
3. Durch Klicken einen Prozessorblock markieren oder mit Strg + Klicken mehrere Blöcke wählen.
4. [Security>Level 2>Lock Selected] (Sicherheit>Stufe 2>Gewählten Prozessor sperren) aus dem Haupt-

menü wählen.
5. Neben dieser Menüoption wird ein Häkchen eingetragen, um darauf hinzuweisen, dass der gewählte Proz-

essor gesperrt ist.
6. Das Gerät auf die Benutzer-Zugangsstufe 2 einstellen (siehe Erklärung im Abschnitt Benutzer-

Zugangsstufe einstellen auf Seite 100).

Hinweis: Die Sicherheit einzelner Prozessoren wirkt sich nur auf den Zugang zum Computer aus, nicht 
auf Prozessor-Einstellungen von der Frontplatte oder den Steuerpins.
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ABSCHNITT 10 Berichte drucken
Die Software des DFR22 kann Berichte zur Dokumentation aller im Gerät gespeicherten Voreinstellungen und Einstel-
lungen drucken. Diese Berichte sind für die folgenden Zwecke vorgesehen.

1. Dokumentation der Gerätekonfiguration für den Kunden und Endbenutzer
2. Erstellung einer Sicherheitskopie auf Papier, sodass die Gerätekonfiguration erforderlichenfalls rekonstru-

iert werden kann

So werden DFR22-Berichte gedruckt:
1. Den Befehl [File>Print] (Datei>Drucken) aus dem Hauptmenü 

wählen.
2. Das Dialogfeld “Choose Report” (Bericht wählen) wird eingeblen-

det (siehe Abb. 10-1).
3. Auf den Bericht klicken, der gedruckt werden soll.
4. Ein Dialogfeld wird für den gewählten Bericht eingeblendet.
5. Die Informationen, die in den Bericht aufgenommen werden sol-

len, nach den Anweisungen im folgenden Abschnitt festlegen.
6. Auf [OK] klicken.
7. Das Windows-Dialogfeld Drucken wird eingeblendet.

Geräteinformationen

Der Bericht “Device Information” (Geräteinformationen) listet alle Informationen auf Geräteebene mit Ausnahme des 
Sicherheits-Kennworts auf. Wenn das Dialogfeld “Device Information” eingeblendet wird, aus der Pulldown-Liste 
[Device] (Gerät) das Gerät wählen, für das ein Bericht gedruckt werden soll. Die Informationen für das gewählte Gerät 
eingeben und auf [OK] klicken. Die hier eingegebenen Informationen werden nur im anschließenden Bericht gedruckt, 
aber nicht für zukünftige Verwendung gespeichert. Ein Muster dieses Berichts siehe Seite 104.

Hinweis: Die Berichte werden direkt zu einem Drucker und nicht in eine Datei ausgegeben, sodass 
zur Verwendung dieser Funktion ein Drucker angeschlossen sein muss.

ABBILDUNG 10-1: Dialogfeld “Choose 
Report” (Bericht wählen)

ABBILDUNG 10-2: Dialogfeld “Device” (Gerät)
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Voreinstellung-Informationen und Informationen über die aktuelle Voreinstellung
Voreinstellung-Informationen und Informationen über die 
aktuelle Voreinstellung

Der Bericht “Preset Information” (Voreinstellung-Informationen) listet die Einzelheiten über eine bestimmte, im Gerät 
gespeicherte Voreinstellung auf. Wenn das Dialogfeld “Individual Presets from Device” (Einzelne Voreinstellungen vom 
Gerät) eingeblendet wird, aus der Pulldown-Liste [Device] (Gerät) das Gerät wählen, für das ein Bericht gedruckt wer-
den soll. Dann die Voreinstellung wählen, für die ein Bericht gedruckt werden soll, und auf [OK] klicken. Ein Muster 
dieses Berichts siehe Seite 105 und 106.

Der Bericht “Current Preset Information” (Informationen über die aktuelle Voreinstellung) ist identisch. Er enthält die 
Einzelheiten der Voreinstellung, die gerade angezeigt wird.

Prozessor-Informationen

Der Bericht “Processor Information” (Prozessor-Informationen) listet die 
Einstellungen von einem oder mehreren Prozessorblöcken auf. Im Dialog-
feld “Individual Processor Blocks” (Einzelne Prozessorblöcke) wird eine 
Liste aller festen und verschiebbaren Prozessoren aus der angezeigten 
Voreinstellung angezeigt. Auf einen Prozessor klicken, um ihn zu wählen, 
oder mehrere Prozessoren mit Umschalttaste + Klicken wählen und dann 
auf [OK] klicken. Ein Muster dieses Berichts siehe Seite 107.

ABBILDUNG 10-3: Dialogfeld “Individual Presets from 
Device” (Einzelne Voreinstellungen vom Gerät)

ABBILDUNG 10-4: Dialogfeld “Currently 
Displayed Preset” (Derzeit angezeigte 

Voreinstellung)

ABBILDUNG 10-5: Dialogfeld “Individual 
Processor Blocks” (Einzelne Prozessorblöcke)
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Muster der Berichte
Muster der Berichte

DEVICE INFORMATION

Location: 4325 W. Division, Chicago

Client: Sacred Heart School

Designer: Bob Reiling

Installer: RC Communications

System Description:

Main Gymnasium Audio Processor

Installation Information:

ShureLink Device ID: 15

Device Name: Gymnasium

Hardware Information:

Control Input Configuration:
Pin-1: Encoding Type: Priority, Mapped to preset: 1
Pin-2: Encoding Type: Priority, Mapped to preset: 2
Pin-3: Switch
Pin-4: Potentiometer

Preset Information:
Total Presets: 4

Preset 1 Concert
Preset 2 Assembly
Preset 3 Game
Preset 4 Dance

1 of 1 February 1, 2003, 11:11AM
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Muster der Berichte
PRESET INFORMATION:

Preset ID: 2

Preset Name: Assembly

Description: Preliminary tuning.

Control Input Pin Mapping:
Pin-1: Reserved for Preset Control - See Device Information
Pin-2: Reserved for Preset Control - See Device Information
Pin-3: Mutes: Input 1 2
Pin-4: Gains: Input 1 2, Gain Range: -inf to 0 dB

1 of 2 February 1, 2003, 11:12AM
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Muster der Berichte
Drag and Drop Processors:

Input-1, Slot-1, Processor: DFR16
Input-1, Slot-2, Processor: PEQ 10CS
Input-1, Slot-3, Processor: GEQ30
Input-1, Slot-4, Processor: LIM
Input-1, Slot-5, Processor: N/A

Input-2, Slot-1, Processor: DFR16
Input-2, Slot-2, Processor: PEQ 10CS
Input-2, Slot-3, Processor: GEQ30
Input-2, Slot-4, Processor: LIM
Input-2, Slot-5, Processor: N/A

Output-1, Slot-1, Processor: DLY 2s
Output-1, Slot-2, Processor: N/A
Output-1, Slot-3, Processor: N/A
Output-1, Slot-4, Processor: N/A
Output-1, Slot-5, Processor: N/A
Output-1, Slot-6, Processor: N/A

Output-2, Slot-1, Processor: DLY 2s
Output-2, Slot-2, Processor: N/A
Output-2, Slot-3, Processor: N/A
Output-2, Slot-4, Processor: N/A
Output-2, Slot-5, Processor: N/A
Output-2, Slot-6, Processor: N/A

2 of 2 February 1, 2003, 11:13AM
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Muster der Berichte
PROCESSOR INFORMATION:

Input Gain Block
Security: Unlocked
Input-1: Name: Music, Operating Level: +4 dBu, Polarity: +, Gain: –4.5dB, Mute: Off, Link Group N/A
Input-2: Name: Speech, Operating Level: +4 dBu, Polarity: +, Gain: 0.0dB, Mute: Off, Link Group N/A

1 of 2 February 1, 2003, 11:12AM

Input-1, Slot-1, Processor: DFR16
Name: DFR 16, Link Group: N/A, Security: Unlocked
Bypass: Off
Autoclear: Disabled
Front Panel Assignment: ROW A
Fixed Filters: 3, New Filters: High
Filter: 1, Freq: 65Hz, Depth: –3.0dB, Type: HighQ
Filter: 2, Freq: 171Hz, Depth: –3.0dB, Type: HighQ
Filter: 3, Freq: 2.5kHz, Depth: –3.0dB, Type: HighQ

Input-1, Slot-2, Processor: PEQ10CS
Name: PEQ with CS, Link Group: N/A, Security: Unlocked
Bypass: Off
Filter: L, Type: Shelf, Freq: 0.1kHz, Gain: -18.5dB
Filter: H, Type: Shelf, Freq: 10kHz, Gain: -18.5dB
Filter: 3, Freq: 4.3kHz, Gain: –9.0dB, Width(oct): 2/3, Width(Q): 2.14
Filter: 4, Freq: 0.7kHz, Gain: –4.5dB, Width(oct): 1.249, Width(Q): 1.12
Filter: 5, Freq: 0.2kHz, Gain: –9.0dB, Width(oct): .350, Width(Q): 4.11
Filter: 6, Freq: 0.1kHz, Gain: –6.0dB, Width(oct): 1, Width(Q): 1.41
Filter: 7, Freq: 6.8kHz, Gain: –6.0dB, Width(oct): 1/6, Width(Q): 8.65

Input-1, Slot-3, Processor: GEQ30
Name: Graphic EQ, Link Group: N/A, Security: Unlocked
Bypass: Off, Filters Type: Combining
Filter: 31.5 Hz, Gain: 1.5dB Filter: 800 Hz, Gain: –1.5dB Filter: 8kHz, Gain: 3.0 dB
Filter: 250 Hz, Gain: 0.5dB Filter: 3.15kHz, Gain: –0.5dB Filter: 16 kHz, Gain: 0.5dB

Input-1, Slot-4, Processor: LIM
Name: Limiter, Link Group: N/A, Security: Unlocked
Bypass: Off
Threshold: 9.5 dB, Attack: 2ms, Ratio: 100.0, Decay: 50ms
Input Gain: 0.00, Output Gain: 0.00
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ABSCHNITT 11 Anhang A: Tabellen für binäre Codierung
Die folgenden Tabellen enthalten die Binärcodes für die Voreinstellungen des DFR22. Diese Codierung auf die
Steuerungs-Eingangspins anwenden, um das Gerät auf die entsprechende Voreinstellung umzuschalten.

Hinweis: 0 = Pin spannungsführend, 1 = Pin geerdet

TABELLE 1. Binäre Codierung über ein Pin

VOREINSTELLUNG Nr. PIN 1
1 0

2 1

TABELLE 2. Binäre Codierung über zwei Pins

VOREINSTELLUNG Nr. PIN 1 PIN 2
1 0 0

2 0 1

3 1 0

4 1 1

TABELLE 3. Binäre Codierung über drei Pins

VOREINSTELLUNG Nr. PIN 1 PIN 2 PIN 3
1 0 0 0

2 0 0 1

3 0 1 0

4 0 1 1

5 1 0 0

6 1 0 1

7 1 1 0

8 1 1 1

TABELLE 4. Binäre Codierung über vier Pins

VOREINSTELLUNG Nr. PIN 1 PIN 2 PIN 3 PIN 4
1 0 0 0 0

2 0 0 0 1

3 0 0 1 0

4 0 0 1 1

5 0 1 0 0

6 0 1 0 1

7 0 1 1 0

8 0 1 1 1

9 1 0 0 0

10 1 0 0 1

11 1 0 1 0

12 1 0 1 1

13 1 1 0 0

14 1 1 0 1

15 1 1 1 0

16 1 1 1 1
© 2003 Shure Incorporated DFR22-Software-Bedienungsanleitung 109



ABSCHNITT 12 Anhang B: DSP-Auslastung pro Prozessor
Die folgende Tabelle führt den Prozentsatz der DSP-Ressourcen auf, den die einzelnen Prozessoren belegen. Die
Gesamtmenge der benötigten DSP-Ressourcen wird durch die Kombination der verwendeten Prozessoren bestimmt.

Kategorie Blockname Beschreibung % DSP
Grafische 
Equalizer

GEQ10 Grafischer Equalizer mit 10 Bändern 4,5

GEQ30 Grafischer Equalizer mit 30 Bändern 9,8

Parametrische 
Equalizer

PEQ 3 Parametrischer Equalizer mit 3 Bändern 2,6

PEQ 5 Parametrischer Equalizer mit 5 Bändern 3,2

PEQ 7 Parametrischer Equalizer mit 7 Bändern 3,7

PEQ 10 Parametrischer Equalizer mit 10 Bändern 4,5

PEQ 3 + CS Parametrischer Equalizer mit 3 Bändern mit Filtern 
mit steilflankiger/Kuhschwanz-Charakteristik 3,2

PEQ 5 + CS Parametrischer Equalizer mit 5 Bändern mit Filtern 
mit steilflankiger/Kuhschwanz-Charakteristik 3,7

PEQ 7 + CS Parametrischer Equalizer mit 7 Bändern mit Filtern 
mit steilflankiger/Kuhschwanz-Charakteristik 4,2

PEQ 10 + CS Parametrischer Equalizer mit 10 Bändern mit Filtern 
mit steilflankiger/Kuhschwanz-Charakteristik 5,0

CUT/SHELF
Hoch- und Niederfrequenz-Filter mit steilflankiger 
Charakteristik/Hoch- und Niederfrequenz-Filter mit 
Kuhschwanz-Charakteristik

3,4

Rückkopplung-
sreduzierer

DFR 5 Digitale Rückkopplungsreduzier-Stufe mit 5 Bändern 14,3

DFR 10 Digitale Rückkopplungsreduzier-Stufe mit 10 Bändern 15,9

DFR 16 Digitale Rückkopplungsreduzier-Stufe mit 16 Bändern 17,8

ST DFR 5 Digitale Stereo-Rückkopplungsreduzier-Stufe mit 5 
Bändern 28,6

ST DFR 10 Digitale Stereo-Rückkopplungsreduzier-Stufe mit 10 
Bändern 31,7

ST DFR 16 Digitale Stereo-Rückkopplungsreduzier-Stufe mit 16 
Bändern 35,5

Verzögerungen DLY 5ms Maximale Verzögerung von 5 ms 4,7

DLY 150ms Maximale Verzögerung von 150 ms 4,7

DLY 500ms Maximale Verzögerung von 500 ms 4,7

DLY 2s Maximale Verzögerung von 2 Sekunden 4,7

Dynamik COMP Kompressor 2,6

Sft COMP Kompressor � Soft-Knee-Option 2,9

ST COMP Stereo-Kompressor 5,2

Sft ST COMP Stereo-Kompressor � Soft-Knee-Option 7,0

LIM Limiter 2,6

Sft LIM Limiter � Soft-Knee-Option 2,9

ST LIM Stereo-Limiter 5,2

Sft ST LIM Stereo-Limiter � Soft-Knee-Option 7,0

AGC Automatische Verstärkungsregelung 7,7

GATE Gate 3,1

DOWN EXP Abwärts-Expander 3,1

PEAKLIM Spitzenwert-Limiter 3,7

DUCK Ducker 3,9

Frequenzweichen XOVER 2 2-Wege-Frequenzweiche 3,2

SUB Subwoofer 4,5

Verteiler SPLIT 2 2-Wege-Verteiler 0,0
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ABSCHNITT 13 Anhang C: Dateinamenerweiterungen
Die folgende Tabelle enthält die Erweiterungen der verschiedenen Dateitypen, die von der DFR22 Software erzeugt
werden.

Dateinamener
weiterung Herkunft

.agc Automatische Verstärkungsregelung

.backup Gesamte Geräte-Datensicherung

.cdk Ein- und Ausgangsverstärkung

.comp Kompressor

.cutshf Hoch- und Niederfrequenz-Filter mit steilflankiger Charakteristik/
Hoch- und Niederfrequenz-Filter mit Kuhschwanz-Charakteristik

.d22 Voreinstellungsdatei

.d22pin Steuerpin-Konfiguration

.dfr10 Digitale Rückkopplungsreduzier-Stufe mit 10 Bändern

.dfr16 Digitale Rückkopplungsreduzier-Stufe mit 16 Bändern

.dfr5 Digitale Rückkopplungsreduzier-Stufe mit 5 Bändern

.dly150ms Maximale Verzögerung von 150 ms

.dly2s Maximale Verzögerung von 2 Sekunden

.dly500ms Maximale Verzögerung von 500 ms

.dly5ms Maximale Verzögerung von 5 ms

.duck Ducker

.exp Abwärts-Expander

.gate Gate

.geq10 Grafischer Equalizer mit 10 Bändern

.geq30 Grafischer Equalizer mit 30 Bändern

.lim Limiter

.mix Matrixmischer

.peaklim Peak-Stop-Limiter

.peq10 Parametrischer Equalizer mit 10 Bändern

.peq10cs Parametrischer Equalizer mit 10 Bändern mit Filtern mit steil-
flankiger/Kuhschwanz-Charakteristik

.peq3 Parametrischer Equalizer mit 3 Bändern

.peq3cs Parametrischer Equalizer mit 3 Bändern mit Filtern mit steil-
flankiger/Kuhschwanz-Charakteristik

.peq5 Parametrischer Equalizer mit 5 Bändern

.peq5cs Parametrischer Equalizer mit 5 Bändern mit Filtern mit steil-
flankiger/Kuhschwanz-Charakteristik

.peq7 Parametrischer Equalizer mit 7 Bändern

.peq7cs Parametrischer Equalizer mit 7 Bändern mit Filtern mit steil-
flankiger/Kuhschwanz-Charakteristik

.softcomp Kompressor mit Soft-Knee-Option

.softlim Limiter mit Soft-Knee-Option

.softstcomp Stereo-Kompressor mit Soft-Knee-Option

.softstlim Stereo-Limiter mit Soft-Knee-Option

.stcomp Stereo-Kompressor

.stdfr10 Digitale Stereo-Rückkopplungsreduzier-Stufe mit 10 Bändern

.stdfr16 Digitale Stereo-Rückkopplungsreduzier-Stufe mit 16 Bändern

.stdfr5 Digitale Stereo-Rückkopplungsreduzier-Stufe mit 5 Bändern

.stlim Stereo-Limiter

.sub Subwoofer

.xover2 2-Wege-Frequenzweiche
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ABSCHNITT 14 Anhang D: Störungssuche
Kommunikationsstörung zwischen dem Computer und dem DFR22:
Die folgenden Meldungen werden bei Kommunikationsstörungen der DFR22 Software mit dem Gerät
angezeigt.

“COM(port) is already in use or does not exist...” (COM-Anschluss wird bereits verwendet 
oder existiert nicht)
Diese Meldung wird unter den folgenden Umständen angezeigt:

• Der vorgegebene COM-Anschluss wird bereits von einer anderen Anwendung verwendet.

Wenn der vorgegebene COM-Anschluss bereits von einer anderen Anwendung verwendet wird, lässt
sich das Problem durch Beenden der anderen Anwendung beheben. Beispiele von Anwendungen, die
den COM-Anschluss geöffnet halten, sind der HotSync Manager und ähnliche Dienstprogramme zur
Synchronisierung des Computers mit Geräten wie Palm Pilot™. Das Schließen solcher Programme ist
unter Umständen nicht einfach möglich, da sie häufig als Hintergrundanwendungen ausgeführt wer-
den. Informationen sind aus dem Benutzerhandbuch der jeweiligen Anwendung ersichtlich. Desktop-
Computer verfügen gewöhnlich über mehr als nur einen physischen seriellen Anschluss. In diesem
Fall kann das Problem behoben werden, indem ein anderer COM-Anschluss gewählt und das serielle
Kabel für den P4800 dort angeschlossen wird.

• Der serielle Anschluss des Computers ist deaktiviert.

Die BIOS-Einrichtroutine ausführen und den seriellen Anschluss aktivieren. Dabei die Einstellungen
des seriellen Anschlusses (IRQ- und E/A-Adresse) notieren und sicherstellen, dass unter Windows
diese Einstellungen einem COM-Anschluss zugewiesen sind. Danach diesen COM-Anschluss in der
DFR22 Software wählen.

“Network not ready...” (Netzwerk nicht bereit)
Diese Meldung weist darauf hin, dass die DFR22 Software den COM-Anschluss erfolgreich öffnen konnte,
aber kein daran angeschlossenes Gerät vorfand. Vor der Kommunikation mit dem DFR22 sicherstellen,
dass er eingeschaltet ist und seinen Startablauf beendet hat. Wenn der Computer mehr als einen COM-
Anschluss aufweist, sicherstellen, dass das Netzwerkkabel an den gleichen COM-Anschluss angeschlos-
sen ist, der im Dialogfeld “Select COM Port” (COM-Anschluss wählen) eingestellt wurde.

Sicherstellen, dass ein serielles Kabel mit korrekter Verdrahtung verwendet wird und dass es richtig am
Computer und am DFR22 angeschlossen ist. Weitere Informationen siehe Installation Guide (Installation-
sanleitung).

“No devices detected.” (Keine Geräte gefunden)
Die DFR22 Software hat ein anderes Gerät als ein DFR22 am gewählten COM-Anschluss vorgefunden.
Möglicherweise ist ein Modem oder ein anderes serielles Gerät wie beispielsweise ein DFR11EQ
vorhanden. Dieses Problem lässt sich beheben, indem der COM-Anschluss gewählt wird, an dem der
DFR22 angeschlossen ist.

Die Voreinstellung-Anzeige des DFR22 zeigt den Buchstaben “E” gefolgt von 
einer Zahl:

• Im Gerätespeicher ist eine fehlerhafte Voreinstellung vorhanden; diese muss gelöscht werden. Wenn 
das Problem nach Ausführung der nachstehenden Anweisungen fortbesteht, mit der Applications 
Group von Shure Kontakt aufnehmen.

So werden fehlerhafte Voreinstellungen gelöscht:
1. Die DFR22 Software öffnen und im Design-Modus [File>Delete Preset] (Datei>Voreinstellung 

löschen) wählen.
2. Voreinstellungen löschen, die als “**corrupted**” (fehlerhaft) angezeigt werden. Wenn die aktive 

Voreinstellung die Störung verursacht, auf [Cancel] (Abbrechen) klicken.
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3. [File>New>Blank] (Datei>Neu>Leer) wählen, um eine leere Voreinstellung zu erzeugen, dann 
[File>Store Preset] (Datei>Voreinstellung speichern) wählen und die beschädigte aktive Vorein-
stellung durch die leere Voreinstellung überschreiben.

• Die Aktualisierung der Firmware wurde unterbrochen. Zur Korrektur die nachstehenden Anweisungen 
ausführen. Wenn das Problem fortbesteht, mit der Applications Group von Shure Kontakt aufnehmen.

So wird die Firmware-Aktualisierung abgeschlossen:
1. Die Spannungsversorgung des Geräts aus- und wieder einschalten.
2. Aus dem Menü [File] (Datei) die Option [Firmware Upgrade] (Firmware-Aktualisierung) auswählen.
3. Wenn die Software zur Aktualisierung des Codes auffordert, auf [Continue] (Weiter) klicken.

• Als letztes Mittel eine Hardware-Rücksetzung durchführen. Dadurch werden alle Voreinstellungen und 
Einstellungen aus dem Gerät gelöscht, und das Gerät wird in den voreingestellten Anfangszustand 
zurückversetzt.

So wird eine Hardware-Rücksetzung durchgeführt:
1. Das Gerät ausschalten.
2. Während des Einschaltens des DFR22 die Knöpfe “Press to Lock/Hold to Clear” (Zum Sperren 

drücken/Zum Löschen gedrückt halten) und “Bypass” (Umgehung) in Reihe A gedrückt halten.
3. Die Voreinstellung-Anzeige zählt rückwärts, während die Rücksetzung erfolgt.

Umschalten von Geräte-Voreinstellungen vom Computer ist nicht möglich:
• Die Sicherheitsstufe des Geräts überprüfen. Damit Voreinstellungen vom Computer umgeschaltet wer-

den können, muss das Gerät auf Sicherheitsstufe 1 oder auf die benutzerdefinierte Stufe 2 eingestellt 
sein. Weitere Informationen siehe Abschnitt Sicherheit auf Seite 99.

• Wenn die Voreinstellung-Umschaltung über die Steuerungs-Eingangspins aktiviert ist, reagiert das 
Gerät nicht auf Voreinstellung-Umschaltung über den Computer. Zum Beheben des Problems die 
Steuerpins für Voreinstellung-Umschaltung im Fenster “Control Pin” (Steuerpin) deaktivieren. Weitere 
Informationen siehe Abschnitt “Pin Configuration” (Pin-Konfiguration) auf Seite 92.

Umschalten von Voreinstellungen von der Frontplatte des Geräts ist nicht möglich:
• Der fünfte DIP-Schalter auf der Rückseite des Geräts befindet sich in der unteren Stellung. Schalter in 

die obere Stellung schalten, um die Bedienelemente auf der Frontplatte zu entsperren.
• Die Sperrung von Bedienelementen auf der Frontplatte wurde für die Voreinstellung-Auswahl in der 

DFR22 Software aktiviert. Die Option [Security>Front Panel Lockout] (Sicherheit>Sperrung der Bedi-
enelemente auf der Frontplatte) im Hauptmenü wählen, und im Dialogfeld “Front Panel Lockout” (Sper-
rung der Bedienelemente auf der Frontplatte) das Kontrollkästchen [Preset selector] (Voreinstellung-
Auswahl) deaktivieren.

• Wenn die Voreinstellung-Umschaltung über die Steuerungs-Eingangspins aktiviert ist, reagiert das 
Gerät nicht auf die Voreinstellung-Umschaltung über die Frontplatte. Zum Beheben des Problems die 
Steuerpins für Voreinstellung-Umschaltung im Fenster “Control Pin” (Steuerpin) deaktivieren. Weitere 
Informationen siehe Abschnitt Sicherheit auf Seite 99.
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